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安全信息
将电源线连接到正确接地的电源插座上，所连接的电源插座与产品的距离不可太远，并且要符合使用方便的原
则。

请不要在水边或潮湿的地方放置或使用此产品。

请只使用随此产品提供的电源和电源线或厂商的认可替代品。

当心—可能的伤害：为了降低火灾风险，当您将此产品连接到公共交换电话网络中时，请只使用随同此产
品一起提供的电信(RJ-11)电缆或者 UL 认证的 26 美国线规(AWG)或更大的替代品。

本产品使用特定制造商的元件，并按照严格的世界安全标准来设计、测试及验证。有些零件的安全功能特征可
能不一定很明显。对于更换其他厂家零件所造成的不良后果，制造商概不负责。

当心—可能的伤害：请不要切割、扭曲、捆绑、挤压电源线，或者在电源线上放置重物。请不要使电源线
磨损或受压。请不要将电源线塞在物体之间，例如家具和墙壁之间。如果发生了这些事情，可能会产生火
灾或电击危险。请定期检查电源线，及时发现这种问题的迹象。在检查电源线之前，请先从电源插座上断
开。

有关操作说明书中未提及的其他服务或维修，请向专业的服务人员咨询。

当心—可能的伤害：双面打印部件后面的区域带有突出的棱角（纸张通道的一部分）。为了避免受伤，当
您为了清除卡纸而接触此区域时，请特别小心。

当心—电击危险：当清洁打印机的外部时，为避免受电击的危险，请在操作之前先从墙壁插座中拔掉电源
线并从打印机上断开所有电缆。

当心—电击危险：在雷雨天气时，请不要使用传真功能。也不要在雷雨天气时设置本产品，或者使用传真
功能、电源线或电话线进行带电操作或线缆连接。

请保留这些安全指导。

安全信息
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关于您的打印机

感谢您选择此打印机！
我们经过努力的工作，确保此打印机可以满足您的需求。

如要立刻开始使用您的新打印机，请使用随同打印机一起提供的安装资料，然后快速浏览用户手册了解如何完
成基本任务。如要实现您的打印机的最佳性能，请仔细阅读用户手册，并确认您在我们的网站上检查了最新的
升级。

我们致力于通过我们的打印机提供性能和价值，并且我们希望确保您满意。如果您在使用过程中遇到任何问
题，我们知识渊博的技术支持代表将会很高兴地帮助您迅速恢复正常使用。如果您发现哪些事情我们可以做得
更好，请告诉我们。毕竟我们所做的这一切都是为了您，您的建议可以帮助我们做得更好。

使您的打印机对环境的影响最小
我们致力于保护环境，并且不断地改善我们的打印机以减少它们对环境的影响。通过选择某些打印机设置或任
务，您可以更进一步地减少您的打印机对环境的影响。

节约能源
• 启用经济模式。此功能将屏幕亮度设置为低，并设置打印机在空闲 10 分钟之后进入节约能源模式。

• 选择较低的节约能源时限。打印机空闲一段时间之后，节约能源功能将会让打印机进入最小能耗待机模
式，这段时间称为节约能源时限。

• 共享您的打印机。无线／网络打印机允许您在多台计算机之间共享一台打印机，这样可以节约能源和其他
资源。

节约纸张
• 启用经济模式。在某些打印机型号上，此功能设置打印机自动将复印、传真作业以及 Windows 和 Mac OS

X version 10.6 或更高版本（英文版）下的打印作业在纸张的双面进行打印（双面打印）。

• 在纸张的一面上打印多页图像。“合并打印”功能允许您在一张纸上打印多页。您最多可以在一张纸的一
面上打印 4 页图像。

• 在纸张的双面进行打印。双面打印允许您手动或自动在纸张的双面进行打印（取决于您的打印机型号）。

• 在打印之前预览打印作业。您可以在工具栏中、“打印”或“打印预览”对话框中或打印机的显示屏上使
用预览功能（取决于您的打印机型号）。

• 扫描并保存。为了避免打印多份，您可以扫描文档或照片，然后将它们保存在计算机应用程序或闪存驱动
器中进行演示。

• 使用可回收的纸张。

节约墨水
• 使用“高速”或“草稿”模式。使用这些模式打印文档可以比正常情况使用较少的墨水，推荐用于打印文
本为主的文档。

• 使用高容量打印墨盒。高容量打印墨盒中的墨水允许您使用较少的打印墨盒打印较多的页数。

• 清洗打印头。在更换和回收您的打印墨盒之前，请尝试使用“清洗打印头”和“深度清洗打印头”功能。
这些功能可以清洗打印头喷头并提高您的打印结果的质量。

关于您的打印机
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回收
• 通过 Lexmark 打印墨盒收集计划返还打印墨盒进行再使用或再循环。如要返还打印墨盒，请访问网站

www.lexmark.com/recycle。按照指导索取已付邮资的返还袋。

• 回收产品包装。

• 回收您的旧打印机，而不要丢弃。

• 从作废的打印作业中回收纸张。

• 使用可回收的纸张。

如要浏览 Lexmark 环保报告，请访问网站 www.lexmark.com/environment。

查找有关打印机的信息

出版物

您正在找什么？ 可以从这里得到

初始安装指导：

• 连接打印机

• 安装打印机软件

安装文档

安装文档随同打印机一起提供，也可以从 Lexmark 网站
http://support.lexmark.com 上获得。

有关使用打印机的更多设置和指导：

• 选择和储存纸张和特殊介质

• 装入纸张

• 完成打印、复印、扫描和传真任务，
取决于您的打印机型号

• 配置打印机设置

• 浏览并打印文档和照片

• 安装和使用打印机软件

• 在网络中安装并配置打印机，取决于
您的打印机型号

• 照料和维护打印机

• 发现和解决问题

用户手册

用户手册可以从安装软件光盘中获得。

如要获取更新，请访问我们的网站 http://support.lexmark.com。

创建和定制打印机解决方案，取决于您
的打印机型号

SmartSolutions 用户手册和帮助

访问网站 http://smartsolutions.lexmark.com。单击“用户手册”链接
浏览基本的 SmartSolutions 信息，或者单击?浏览上下文相关信息。

关于您的打印机
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您正在找什么？ 可以从这里得到

有关使用打印机软件的帮助 Windows 或 Mac 帮助

打开打印机软件应用程序，然后单击“帮助”。

单击  可以浏览上下文相关信息。

注意：

• 帮助文件随同打印机软件一起自动安装。

• 打印机软件位于打印机程序文件夹中或者计算机桌面上，取决于您
的操作系统。

最新的补充信息、升级和在线技术支
持：

• 问题解答提示

• 常见问答

• 文档

• 驱动程序下载

• 在线聊天技术支持

• 电子邮件技术支持

Lexmark 技术支持网站 http://support.lexmark.com

注意：选择您所在的国家或地区，然后选择您的产品以浏览适当的技术
支持网站。

请记录以下的信息（位于购买发票上和打印机前盖的里面），并且当您
联系技术支持时准备好这些信息，以便我们能够更快地为您服务：

• 机器型号

• 序列号

• 购买日期

• 购买地点

电话技术支持 在美国，请拨打我们的电话：

1-800-332-4120
周一–周五（早上 8:00–晚上 11:00 东部时间），周六和周日（早上
11:00–晚上 8:00 东部时间）

您所在国家或地区的技术支持电话号码和服务时间可以在技术支持网站
http://support.lexmark.com 上获得，或者请参阅随同您的打印机一起
提供的质量保证手册。

保修信息 • 美国 — 请参阅随同此打印机一起提供的有限质量保证声明，或者访
问我们的网站 http://support.lexmark.com。

• 其他国家或地区 — 请参阅随同您的打印机一起提供的质量保证声明。

关于您的打印机
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了解打印机的部件

使用 您可以

1 扫描仪顶盖 打开顶盖可以露出扫描仪玻璃。

2 扫描仪玻璃 扫描、复印或传真照片和文档。

3 扫描仪夹子 将照片、卡片或其他小介质保持在固定位置。

4 放置角落 将照片和文档正确地放置在扫描仪玻璃上。

5 带有触摸屏的打印机操作面板 操作打印机。

6 纸张支架 • 装入纸张。

• 清除卡纸。

7 进纸导轨调节杆 调节进纸导轨。

8 PictBridge 和 USB 接口 将 PictBridge 兼容数码相机或闪存驱动器连接在打印机上。

9 存储卡插槽 插入存储卡。

10 前盖 操作打印墨盒。

11 出纸托盘 盛放打印机送出的打印页。

关于您的打印机
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使用 您可以

1 用户支持标签 标识打印机的型号、用户支持热线、打印墨盒信息和 MAC 地址。

2 前盖 操作打印墨盒。

3 打印头窗口盖 • 操作打印头。

• 清除卡纸。

4 清洁布存储袋 存储触摸屏清洁布。

5 打印墨盒窗口 安装、更换或取出打印墨盒。

6 纸张支架 • 装入纸张。

• 清除卡纸。

7 LINE（线路）插口 通过标准墙壁电话线插座(RJ-11)、DSL 过滤器、VoIP 适配器或任何其他允许您使用
电话线路的适配器将打印机连接在电话线路上，以便发送和接收传真。

8 EXT（电话分机）插口 将其他设备（电话机或电话答录机）连接在打印机和电话线上。如果您的打印机没有
使用专用传真线路，并且您所在的国家／地区支持这种连接方法，请使用此插口。

9 电源插口 将打印机连接在电源上，或者从电源上断开。

10 传真盖板 保护传真区域。

11 双面打印部件 • 在纸张的双面进行打印。

• 清除卡纸。

12 双面锁定按钮 取下双面打印部件。

关于您的打印机
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使用 您可以

13 USB 接口 使用 USB 电缆将打印机连接在计算机上。

警告—可能的损坏：除了插入或断开 USB 电缆或安装电缆的时候，请不要触摸 USB
接口。

使用 您可以

1 电源插口 将打印机连接在电源上，或者从电源上断开。

注意：电源输入为交流 100-240 V，0.7 A(50/60 Hz)。电源输出为直流 30 V，1.07 A。

2 电源适配器盖板 保护电源适配器。

关于您的打印机
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订购和更换耗材

订购打印墨盒
Lexmark S800 Series 型号

项目 返还计划打印墨盒 1 常规打印墨盒 2

黑色打印墨盒 100 100A

高容量黑色打印墨盒 100XL 100XLA

黄色打印墨盒 100 100A

高容量黄色打印墨盒 100XL 100XLA

青色打印墨盒 100 100A

高容量青色打印墨盒 100XL 100XLA

洋红色打印墨盒 100 100A

高容量洋红色打印墨盒 100XL 100XLA

1 只允许单次使用。使用后请将此打印墨盒返还给 Lexmark 进行再制造、再填充或再循环。
2 只能从 Lexmark 网站 www.lexmark.com 上获得。

注意：

• 如要获取更多的墨水，请订购高容量打印墨盒。

• 根据您所在的国家或地区，您收到的打印墨盒可能是单独的或者带有包装。

• 根据您的需要，您可以订购标准打印墨盒和高容量打印墨盒的组合。

• 在打印墨盒包装上查看容量，或者访问网站 www.lexmark.com/pageyields。

• 要获得最佳效果，请只使用 Lexmark 打印墨盒。

使用原装 Lexmark 打印墨盒
Lexmark 打印机、打印墨盒和照片纸互相配合，可以实现卓越的打印质量，并且我们的墨水专为您的打印机
设计，有助于延长您的产品的寿命。我们推荐您只使用原装 Lexmark 打印墨盒。

Lexmark 质量保证不负责修复由非 Lexmark 墨水或打印墨盒所引起的损坏。

订购和更换耗材
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更换打印墨盒
在您开始操作之前，请确保您有新的打印墨盒。在您取出旧的打印墨盒之后，必须立刻安装新的打印墨盒，否
则打印头喷头中剩余的墨水可能会干燥。

1 打开打印机电源。

2 打开打印机。

注意：打印头将会移动到打印墨盒安装位置。

3 按释放按钮，然后取出旧的打印墨盒。

4 从包装内取出打印墨盒，然后从打印墨盒上取下保护盖。

如果您的墨盒带有套盖，那么请取下套盖。

订购和更换耗材
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如果您的墨盒带有旋转盖，那么请旋转并取下旋转盖。

5 安装每一个打印墨盒。请使用双手安装黑色打印墨盒。

注意：取下保护盖后请立刻安装新的打印墨盒，以避免墨水暴露在空气中。

6 关闭打印机。

订购纸张和其他耗材
如要订购打印机耗材，或者查找您附近的经销商，请访问我们的国际互联网站 www.lexmark.com。

项目 产品编号

USB 电缆 1021294

如要获取更多的信息，请访问网站 www.lexmark.com。

纸张 纸张尺寸

Lexmark 照片纸 • Letter

• A4

• 4 x 6 英寸

• L

注意：

• 在不同的国家／地区可能会有所不同。

• 要获得最佳效果，当您打印照片或其他高质量的图像时，请使用 Lexmark 照片纸。

• 如要获取更多的信息，请访问网站 www.lexmark.com。

订购和更换耗材
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回收 Lexmark 产品
如要返还 Lexmark 产品进行回收：

1 访问我们的国际互联网站 www.lexmark.com/recycle。

2 查找您希望回收的产品类型，然后从列表中选择您的国家或地区。

3 按照计算机屏幕上的指导进行操作。

注意：如果是未列在 Lexmark 收集计划中的打印机耗材和硬件，您可以通过当地的回收中心进行回收。请联
系您当地的回收中心以确定他们接受的回收物品。

订购和更换耗材
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使用打印机操作面板按钮和菜单

使用打印机操作面板
注意：当图标在当前界面中可以选择时，它们将会显示出来。如果图标没有显示，则功能无法使用。

使用 您可以

1 返回 • 返回到上一个界面。

• 从当前菜单退出到上一级菜单。

2 触摸显示屏

注意：在省电模式下，显示屏将会关闭。

• 浏览打印机菜单。

• 改变设置。

• 查看打印机信息和动画。

3 主页 返回到主界面。

4 帮助 查看帮助文字信息。

5 取消 取消当前的作业或任务。

6 开始 开始作业，取决于所选的模式。

使用打印机操作面板按钮和菜单
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使用 您可以

7 电源 • 打开或关闭打印机的电源。

• 进入省电模式。

注意：当打印机打开时，按  按钮将会进入省电模式。按住
 按钮 3 秒钟将会关闭打印机。

了解主界面
当打印机的电源打开，并且经过短时间的预热之后，显示屏上将会显示主界面。使用主界面中的选项可以开始
复印或传真等作业，或者改变打印机设置。

显示项目 说明

1 复印 进入“复印”菜单并进行复印。

2 扫描 进入“扫描”菜单并扫描文档。

3 传真 进入“传真”菜单并发送传真。

使用打印机操作面板按钮和菜单
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显示项目 说明

4 存储设备 浏览、选择、打印照片和文档，或者通过电子邮件发送照片和文档。

注意：只有当存储卡或闪存驱动器连接在打印机上，并且您返回到主界面时，此图标才会
出现。

PictBridge 浏览、选择或打印照片。

注意：只有当 PictBridge 兼容数码相机连接在打印机上，并且您返回到主界面时，此图标
才会出现。

5 SmartSolutions 打开“SmartSolutions”菜单。

6 墨水量图标 • 查看安装的打印墨盒的当前墨水量。

• 使用打印墨盒维护和信息功能。

7 设置图标 进入“设置”菜单并改变打印机设置。

8 双面图标

单面图标

在纸张的双面或单面进行打印。

注意：根据您所选择的设置，这些图标将会相应地显示。

9 经济模式图标 启用经济模式可以选择以下的选项：

• 在纸张的双面进行打印（双面打印）。

• 打印机在空闲 10 分钟之后进入节约能源模式。

• 将显示屏的亮度设置为低。

10 Wi-Fi 指示灯 检查无线状态并读取无线网络设置。

使用打印机操作面板按钮和菜单
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使用触摸屏浏览菜单

使用 您可以

1 左箭头 向左滚动。

2 右箭头 向右滚动。

3 接受 保存您的设置。

4 上箭头。向上滚动。

5 滚动条 向上或向下滚动菜单列表。

6 下箭头 向下滚动。

如要使用触摸屏浏览菜单：

• 使用您的手指触摸屏幕。如果您使用其他工具或设备，触摸屏将不会工作。

• 如要确认设置或者选择菜单或菜单项，请触摸它。

• 拖动滚动条或触摸箭头，直到您希望的菜单或设置出现在显示屏上。

• 使用您的手指向上或向下轻轻滑过显示屏，然后从显示屏上抬起您的手指。如要转到下一个或上一个界
面，请向旁边滑动。这和选择左右箭头具有相同的效果。

• 如有必要，请在选择设置或改变设置之后触摸“确定”或“接受”。

使用打印机操作面板按钮和菜单
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例如，如要找到“纸张类型”并选择默认纸张类型设置：

1 触摸 。

注意：本手册中的所有指导都从主界面开始。

2 依次触摸  > 纸张设置 > 纸张类型。

3 向上或向下滚动（使用滚动条或箭头，或者在屏幕上向上或向下滑动）浏览纸张类型列表。

4 触摸选择纸张类型设置，然后触摸“接受”保存设置。

改变节约能源时限
打印机将会在空闲一段时间之后进入节约能源模式，这段时间称为节约能源时限。和默认打印机设置相比，节
约能源功能可以通过降低打印机的能源消耗（一些打印机型号可以达到 28%）使能源效率达到最优化。如要
最多地节约能源，请选择最小的节约能源时限。

1 从主界面中依次选择：

 > 设备设置 > 节约能源

2 选择节约能源时限，然后触摸“接受”。

使用经济模式节约纸张和能源
经济模式功能可以有效地降低纸张使用量、减少纸张浪费、使能源效率最优化和节省资金。

1 在主界面中触摸 。

2 触摸经济模式设置或您希望启用的设置，然后触摸“接受”。

• 10 分钟之后进入节约能源模式

• 屏幕变暗

• 双面打印

注意：如果您选择了“双面打印”，此设置也对复印和传真作业有效。此设置只能在 Windows 和 Mac
OS X version 10.6 或更高版本（英文版）中使用。

恢复出厂默认设置
恢复出厂默认设置将会删除您所选择的所有打印机设置。

1 从主界面中依次选择：

 > 使用出厂默认设置 > 是

2 当提示您设置您的打印机的初始设置时，请使用触摸屏进行选择。

当恢复出厂默认设置之后，打印机将会自动重新启动。

使用打印机操作面板按钮和菜单
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使用打印机软件

最小系统需求
打印机软件最多需要 500MB 空余硬盘空间。

支持的操作系统
• Microsoft Windows 7

• Microsoft Windows Vista (SP2)

• Microsoft Windows XP（SP3）

• Macintosh Intel OS X version 10.6.0 或更高版本（英文版）

• Macintosh Intel OS X version 10.5.0 或更高版本（英文版）

• Macintosh Intel OS X version 10.4.4 或更高版本（英文版）

• Macintosh PowerPC OS X version 10.5.0 或更高版本（英文版）

• Macintosh PowerPC OS X version 10.4.0 或更高版本（英文版）

• Linux Ubuntu 10.04、9.10 和 9.04*

• Linux OpenSUSE 11.3 和 11.2*

• Linux Fedora 12 和 11*

* 适用于此操作系统的打印机驱动程序只能从网站 http://support.lexmark.com 上获得。

使用 Windows 打印机软件

在打印机安装过程中安装的软件

当您使用安装软件光盘安装打印机时，所有必需的软件都已经安装。您可能也选择了安装一些其他的程序。下
面的表格提供了各种软件程序的概述，以及它们可以帮助您做什么。

如果您在初始安装过程中没有安装这些程序，请重新插入安装软件光盘，运行安装程序，然后在“已安装的软
件”界面中选择“安装其他的软件”。

使用打印机软件
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打印机软件

使用 您可以

LexmarkTM 打印机主页

（简称为打印机主页）

• 运行应用程序。

• 打开 Fax Solutions（传真解决方案）软件。

• 扫描或通过电子邮件发送照片或文档。

• 编辑扫描的文档。

• 将文档扫描成 PDF 格式。

• 调整打印机设置。

• 订购耗材。

• 维护打印墨盒。

• 打印测试页。

• 注册打印机。

• 联系技术支持。

Lexmark EzPrint

（简称为 EzPrint）

管理、编辑、传送和打印照片和文档。

Lexmark Toolbar（工具栏）

（简称为 Toolbar）
• 打印黑白或纯文本的网页以节省墨水。

• 定时自动打印网页。

• 使用 Picnik 在线编辑照片。

• 在 Windows 中打印、扫描或转换本地文件。

Lexmark Tools for Office（Office 工具）

（简称为 Tools for Office）

读取您在 Microsoft Office 2007 中喜欢的设置。

Lexmark Fax Solutions（传真解决方案）

（简称为 Fax Solutions）
• 发送传真。

• 接收传真（3 合 1 打印机）。

• 添加、编辑或删除内置电话簿中的联系人。

• 打开 Lexmark 打印机设置应用程序（4 合 1 打印机）。
使用打印机设置应用程序可以设置快速拨号和群组拨号
号码、设置铃声和应答选项、以及打印传真历史记录和
状态报告。

Abbyy Sprint OCR 扫描文档并生成您可以在文字处理程序中编辑的文本。

Lexmark Wireless Setup Utility（无线设置应用程序）

（简称为 Wireless Setup Utility）
• 在无线网络中安装无线打印机。

• 改变打印机的无线设置。

注意：如果打印机有无线功能，此程序将会随同打印机软件
一起自动安装。

Lexmark Service Center（服务中心）

（简称为 Service Center）
• 解决打印机的问题。

• 使用打印机维护功能。

• 联系技术支持。

注意：

• 此程序随同打印机软件一起自动安装。

• 根据您的打印机型号，可能会提示您从网上安装此程
序。

使用打印机软件
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使用 您可以

打印首选项 当您打开一个文档，然后单击“文件 > 打印 > 属性”时，
打印首选项对话框将会出现。您可以在对话框中为打印作业
选择选项，例如：

• 选择要打印的份数。

• 进行双面打印。

• 选择纸张类型。

• 添加水印。

• 增强图像。

• 保存设置。

注意：打印首选项随同打印机软件一起自动安装。

注意：根据您购买的打印机的功能，您的打印机可能不提供某些程序，或者不支持程序的某些功能。

使用 Macintosh 打印机软件

在打印机安装过程中安装的软件

Mac OS 固有软件

使用 您可以

“Print”对话框 调整打印机设置并安排打印作业。

打印机软件

在安装过程中随打印机软件一同安装的应用程序。

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击要使用的应用程序。

使用 您可以

Scan Center • 扫描照片和文档。

• 定制扫猫作业设置。

Printer Settings • 自定义传真作业设置。

• 创建和编辑联系人列表。

Network Card Reader • 查看插入到网络打印机的存储设备中的内容。

• 通过网络从存储设备向计算机传输照片和 PDF 文档。

Wireless Setup Assistant 在无线网络中安装打印机。

注意：如果打印机有无线功能，此程序将会随同打印机软件一起自动安装。

Uninstaller 从计算机中删除打印机软件。

注意：打印机可能未带有这些应用程序，取决于您购买的打印机的功能。

使用打印机软件
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Web Links
Web Links 是链接到预定义 Web 页面的链接。Web Links 保存在打印机文件夹中。

1 从 Finder 中依次选择：

Applications >选择您的打印机文件夹 > Web Links

2 双击要访问的 Web 链接。

使用 您可以

Customer Support 联系技术支持。

Lexmark Software Updates 下载并安装最新的打印机软件。

Lexmark Online 访问 Lexmark 网站。

Order Supplies Online 订购墨水或耗材。

Printer Registration 注册您的打印机。

Visit Lexmark SmartSolutions • 访问 SmartSolutions 网站。

• 选择您的自定义解决方案。

注意：打印机可能未带有这些 Web 链接，取决于您购买的打印机的功能。

查找并安装可选的软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “支持”选项卡 > 在线支持

4 在网站上选择您的打印机，然后下载驱动程序。

5 安装其他或可选的软件。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links > Lexmark Software Updates

2 在网站上选择您的打印机，然后下载驱动程序。

3 安装其他或可选的软件。

使用打印机软件
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升级打印机软件

检查软件升级

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “支持”选项卡 > 检查软件升级

4 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹 > Web Links > Lexmark Software Updates

2 在网站上选择您的打印机，然后下载驱动程序。

启用自动软件升级（仅限于 Windows）
1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“高级”选项卡 > 更多的选项 > 允许从互联网上自动升级我的软件 > 确定

重新安装打印机软件
当您使用安装软件光盘安装打印机时，所有必需的软件都已经安装。如果您在安装过程中遇到了问题、您的打
印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没有出现在打印机选项中，请尝试反安装并
重新安装打印机。

反安装打印机软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 单击反安装选项。

4 按照计算机屏幕上的指导反安装软件。

5 反安装完毕后，请重新启动您的计算机。

使用打印机软件
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Macintosh（英文版）用户

1 关闭所有打开的软件应用程序。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Uninstaller。

4 按照计算机屏幕上的指导进行操作。

5 如果您使用的是 Mac OS X version 10.4，请重新启动您的计算机。否则，请继续进行下一步。

6 插入安装软件光盘，或者从打印机网站上下载最新的安装程序。

7 运行打印机安装软件，然后按照计算机屏幕上的指导进行操作。

安装打印机软件

注意：如果您以前在这台计算机上安装了打印机软件，但是需要重新安装软件，请先反安装当前的软件。

Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后“欢迎”界面仍然没有出现，请手动运行光盘：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 D:\setup.exe，其中 D是您的 CD 或 DVD 驱动器的盘符。

3 按照“欢迎”界面中的指导进行操作。

Macintosh（英文版）用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍然没有出现，请单击计算机桌面上的光盘图标。

3 双击 Install。

4 按照安装对话框中的指导进行操作。

使用互联网

1 访问 Lexmark 的国际互联网站 www.lexmark.com。

2 依次选择：

Downloads > Driver Finder > 选择您的打印机 > 选择您的操作系统

3 下载驱动程序并安装打印机软件。

注意：升级的打印机软件可以从网站 http://support.lexmark.com 上获得。

使用打印机软件
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装入纸张和文档原件

装入纸张
1 来回弯曲纸张，使它们松散开。

请不要折叠或弄皱纸张。在一个平坦表面上将整摞纸张的边缘对齐。

2 在纸张支架的正中间位置装入纸张。

3 调节进纸导轨，使之紧靠纸张的边缘。

注意：请不要用力将纸张塞入打印机内。纸张应该平整地放置在纸张支架的表面上，并且纸张的边缘应该
紧靠两边的进纸导轨。

4 在打印机操作面板上选择或确认您的纸张设置。

装入纸张和文档原件
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纸张和特殊介质指导

最多可以装入： 请确认：

100 张普通纸 • 进纸导轨紧靠纸张的边缘。

• 如要装入印有页眉的信纸，请确认要打印的一面朝上，然后将信
纸的顶端装入打印机内。

25 张重磅亚光纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

20 张横幅纸 • 在装入横幅纸之前，请从纸张支架内取出所有的纸张。

• 您使用的是喷墨打印机专用的横幅纸。

• 将整摞横幅纸放置在打印机的上面或后面，然后将第一页的页首
装入打印机内。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“A4 横幅”或“Letter 横幅”纸张尺寸。

装入纸张和文档原件
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最多可以装入： 请确认：

10 个信封 • 要打印的一面朝上。

• 进纸导轨紧靠信封的边缘。

• 您选择了“横向”设置打印信封。

注意：如果您在日本境内邮寄，您可以选择纵向打印，贴邮票的
位置位于右下角；或者选择横向打印，贴邮票的位置位于左下
角。如果您要向其他国家邮寄，请选择横向打印，贴邮票的位置
位于左上角。

• 您选择了正确的信封尺寸。如果列表中没有完全符合的信封尺
寸，请选择稍大一点的尺寸，然后设置适当的左边距和右边距，
以确保您要打印的内容能够打印在信封的正确位置上。

25 张标签纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

25 张贺卡专用纸、索引卡、明信片或照片卡 • 要打印的一面朝上。

• 进纸导轨紧靠卡片纸的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

25 张照片／光面纸 • 要打印的一面朝上。

• 进纸导轨紧靠纸张的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

注意：“高速”模式可以选择，但是不推荐用于比较贵的纸张，例
如重磅亚光纸、标签纸、照片卡和光面纸。

装入纸张和文档原件
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最多可以装入： 请确认：

10 张热转印纸 • 请按照包装上的指导装入热转印纸。

• 要打印的一面朝上。

• 进纸导轨紧靠热转印纸的边缘。

• 您选择了“自动”、“正常”或“照片”打印质量。

50 张透明胶片 • 粗糙的一面朝上。

• 进纸导轨紧靠透明胶片的边缘。

将文档原件放置在扫描仪玻璃上
1 打开扫描仪顶盖，然后将文档原件正面朝下放置在扫描仪玻璃上。

2 关闭扫描仪顶盖。

“即时预览”界面将会出现。

装入纸张和文档原件
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将小介质放置在扫描仪玻璃上
1 打开扫描仪顶盖。

2 将小介质正面朝下放置在扫描仪玻璃上。

3 将更多的照片、卡片或其他小介质滑动到扫描仪夹子中（可以在扫描仪玻璃上方找到）。关闭扫描仪顶盖。

“即时预览”界面将会出现。

将厚介质放置在扫描仪玻璃上
1 打开扫描仪顶盖。

2 将厚介质正面朝下放置在扫描仪玻璃上。关闭扫描仪顶盖。

装入纸张和文档原件
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3 触摸“预览”。

“即时预览”界面将会出现。

警告—可能的损坏：放置厚度超过 10 毫米的介质可能会损坏扫描仪顶盖。

保存纸张默认设置
您可以为您打印的文档和照片设置默认的纸张设置。

1 从主界面中依次选择：

 > 纸张设置

2 选择默认设置：

• 如果您希望设置默认纸张尺寸，请依次选择：

纸张尺寸 > 选择默认纸张尺寸 > 接受

• 如果您希望设置默认纸张类型，请依次选择：

纸张类型 > 选择默认纸张类型 > 接受

装入纸张和文档原件
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打印

打印提示
• 根据您的打印作业使用适当的纸张。

• 选择较高的打印质量以获得较好的打印结果。

• 请确认打印墨盒中有足够的墨水。

• 当打印照片或特殊介质时，请随时移开打印机送出的打印页。

• 当打印照片时请选择无边界设置。

打印基本文档

打印文档

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 选择打印质量、打印份数、纸张类型和如何打印页面。

4 单击“确定”关闭打印机软件的所有对话框。

5 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项菜单中选择打印质量、打印份数、纸张类型和如何打印页面。

7 单击 Print。

打印
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逐份打印

当您将一份文档打印多份时，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

注意：

• 只有当您打印多份文档时，逐份打印选项才可用。

• 当您打印照片时，为了避免出现污迹，请随时移开打印机送出的照片，等墨水完全干燥后再进行叠放。

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “份数”区域

4 输入您希望打印的份数，然后选中“逐份打印”。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 在 Copies 区域中输入您希望打印的份数，然后选中 Collated。

7 单击 Print。

改变页面的打印顺序

默认情况下，打印机首先打印最后一页。

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “份数”区域

打印
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4 选择页面顺序：

• 如要先打印第一页，请取消选中“先打印最后一页”。

• 如要先打印最后一页，请选中“先打印最后一页”。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Paper Handling。

7 从 Page Order 弹出菜单中选择页面顺序：

• 如要先打印第一页，请选择 Normal。

• 如要先打印最后一页，请选择 Automatic 或 Reverse。

8 单击 Print。

将多页文档打印到一张纸上

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“高级”选项卡 > “布局”下拉列表 > 选择“每张纸上打印多页”

4 选择您希望在每一张纸上合并打印的文档页数。

5 根据您的需要调整其他设置。

6 单击“确定”关闭打印机软件的所有对话框。

7 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

打印
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6 从打印选项弹出菜单中选择 Layout。

7 从 Pages per Sheet 弹出菜单中选择在每一张纸上合并打印的文档页数。

8 根据您的需要调整其他设置。

9 单击 Print。

从存储卡或闪存驱动器中打印文档

如要使用“文件打印”功能：

• 打印机必须通过 USB 电缆或者通过网络连接在计算机上。

• 打印机和计算机的电源都必须打开。

• 存储卡或闪存驱动器中必须包含打印机支持的文档文件。请参阅第45 页“支持的存储卡和文件类型”获
取更多的信息。

• 计算机上必须安装了可以支持存储设备中的文件类型的应用程序。

1 插入存储卡或闪存驱动器。

显示屏上将会出现“存储设备”界面。

2 触摸“打印文档”。

3 选择并打印文档：

如果打印机使用 USB 连接

a 选择您希望打印的文档的文件名。

b 按  按钮开始打印文档。

如果打印机使用无线连接（仅限于某些型号）

a 选择您希望打印的文档的文件名。

b 按  按钮，然后等待打印机连接到网络计算机或者搜索网络中可用的计算机。

c 当出现提示时，请选择网络计算机的名称，然后触摸“接受”开始打印文档。

注意：

• 如果计算机要求识别码，打印机可能会提示您输入识别码。

• 如要为计算机指定计算机名和识别码，请参阅适用于您的操作系统的打印机软件帮助。

打印
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在纸张的双面进行打印

自动在纸张的双面进行打印

自动双面打印部件（仅限于某些打印机型号）只支持 Letter 和 A4 尺寸的纸张。如果您购买的型号不带有自动
双面打印部件，或者如果您需要使用其他尺寸的纸张进行双面打印，请参阅有关手动在纸张的双面进行打印的
指导。

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“高级”选项卡 > “双面打印”区域 > 选择“开”

注意：如要使用在打印机内定义的设置，请选择“使用打印机设置”。

4 选择“侧边装订”或“顶边装订”选项。“侧边装订”是最常用的设置。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

如要恢复单面打印，请依次选择：

“高级”选项卡 > “双面打印”区域 > 选择“关”

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Quality & Media。

7 从 Paper Type 弹出菜单中选择 Plain Paper。

8 从打印选项弹出菜单中选择 Layout。

9 从 Two-Sided 弹出菜单中选择 Long-Edge binding 或 Short-Edge binding。

• 如果选择了 Long-Edge binding，页面将会沿着长边装订（纵向打印沿着左边，横向打印沿着顶边）。

纵向 横向

打印
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• 如果选择了 Short-Edge binding，页面将会沿着短边装订（横向打印沿着左边，纵向打印沿着顶边）。

纵向 横向

10 单击 Print。

设置双面打印干燥时间

使用操作面板

1 从主界面中依次选择：

 > 设备设置 > 双面干燥时间

2 选择干燥时间设置，然后触摸“接受”。

注意：根据您为打印作业所选择的打印质量，干燥时间会有所不同。触摸“延长”可以延长您的打印的干燥时
间。

使用打印机软件

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

4 右键单击打印机图标，然后依次选择：

打印首选项 > “高级”选项卡  > 选择干燥时间设置

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择“延长”。

5 单击“确定”。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 依次选择：

Open Print Queue > Printer Setup > Driver 选项卡

或者

Printer Setup > Installable Options

打印
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3 从 Two-Sided Printing Dry Time 弹出菜单中选择干燥时间设置。

注意：在高湿度条件下，或者如果正常干燥时间不足以让墨水完全干燥，请选择 Extended。

4 单击 OK 或 Apply Changes。

手动在纸张的双面进行打印

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“高级”选项卡 > “双面打印”区域 > 选择“手动”

注意：“打印指导页可以帮助您重新装纸”自动被选中。

4 单击“确定”。打印机首先打印文档的奇数页，然后打印一张指导页。

5 按照指导页中的指导翻转并重新装入打印页。打印机在纸张的背面打印文档的偶数页，完成打印作业。

如要恢复单面打印，请依次选择：

“高级”选项卡 > “双面打印”区域 > 选择“关”

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 在 Page Setup 对话框中设置打印机、纸张尺寸和打印方向。

3 单击 OK。

4 从菜单栏中单击 File > Print。

5 从 Printer 弹出菜单中选择您的打印机。

6 从打印选项弹出菜单中选择 Paper Handling。

7 从 Print 或 Pages to Print 弹出菜单中选择打印奇数页。

打印
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8 单击 Print。

9 翻转并重新装入纸张。

10 重复步骤 4-6。

11 从 Print 或 Pages to Print 弹出菜单中选择打印偶数页。

12 单击 Print。

打印特殊文档

打印信封

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “纸张类型”下拉列表 > 选择“普通纸”

4 依次选择：

“纸张尺寸”下拉列表 > 选择您的信封尺寸

如果没有完全符合的信封尺寸，请选择自定义尺寸。

5 选择打印方向。

6 单击“确定”关闭打印机软件的所有对话框。

7 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。
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3 从 Paper Size 弹出菜单中选择您的信封尺寸。

如果没有完全符合的信封尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 单击 Print。

注意：

• 多数信封使用横向打印。

• 请确认您在应用程序中选择了相同的打印方向。

打印标签

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “纸张类型”下拉列表 > 选择您的纸张类型

4 依次选择：

“纸张尺寸”下拉列表 > 选择您的纸张尺寸

如果没有完全符合的纸张尺寸，请选择自定义尺寸。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择您的纸张尺寸。

如果没有完全符合的纸张尺寸，请选择自定义尺寸。

4 选择打印方向，然后单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 从打印选项弹出菜单中选择 Quality & Media。

8 从 Paper Type 弹出菜单中选择 Card Stock。

9 从 Print Quality 弹出菜单中选择除 Quick Print 以外的其他打印质量。

10 单击 Print。
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有关装入标签纸的提示

• 请确认标签纸的顶部首先装入打印机内。

• 请确认标签纸上的粘性部分距离纸张的边缘至少 1 毫米。

• 请确认进纸导轨紧靠标签纸的边缘。

• 请使用完整的标签纸。如果标签纸不完整（缺少部分标签），其他的标签可能会在打印过程中脱落，从而
导致卡纸。

打印自定义尺寸的纸张

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “纸张尺寸”下拉列表 > 选择“自定义尺寸”

4 根据需要调整设置并创建自定义尺寸，然后单击“确定”。

5 单击“确定”关闭打印机软件的所有对话框。

6 单击“确定”或“打印”。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择 Manage Custom Sizes。

4 根据需要调整设置并创建自定义尺寸，然后单击 OK。

5 单击 OK。

6 从菜单栏中单击 File > Print。

7 从 Printer 弹出菜单中选择您的打印机。

8 单击 Print。
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操作照片

在打印机上使用存储卡或闪存驱动器

将存储卡插入存储卡插槽中或者将闪存驱动器插入 USB 接口中

插入存储卡 插入闪存驱动器

注意：

• 插入存储卡时请确认带有标签的一面朝上。

• 如果存储卡上带有箭头标记，请确认箭头指向打印
机。

• 如果需要，请将存储卡插入随同存储卡一起提供的适
配器中，然后将适配器插入插槽中。

• 请确认打印机支持您插入的存储卡。请参阅第45
页“支持的存储卡和文件类型”获取更多的信息。

注意：

• 闪存驱动器和 PictBridge 数码相机电缆使用同一个接
口。

• 如果您的闪存驱动器无法直接插入接口中，则需要使
用一个适配器。

警告—可能的损坏：当正在打印、读取或写入存储设备时，请不要触摸任何电
缆、任何网络适配器、任何接口、存储设备或图中所示的打印机区域，否则可能
会发生数据丢失。

显示屏上将会出现“存储设备”界面。

注意：

• 如果打印机没有识别出存储设备，请取出并重新插入存储设备。

• 如果存储卡插槽中插入了存储卡，并且您同时将闪存驱动器或设置为大容量存储器模式的数码相机插入
USB 接口中，显示屏上将会出现一条信息，提示您选择您希望使用哪一个存储设备。
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支持的存储卡和文件类型

存储卡： 文件类型：

• Secure Digital (SD)

• Secure Digital High Capacity (SDHC)

• Micro Secure Digital (Micro SD)（需要适配器）

• Mini Secure Digital (Mini SD)（需要适配器）

• MultiMedia Card (MMC)

• Reduced Size MultiMedia Card (RS-MMC)（需要适
配器）

• MultiMedia Card mobile (MMCmobile)（需要适配
器）

• Memory Stick

• Memory Stick PRO

• Memory Stick Duo（需要适配器）

• Memory Stick PRO Duo（需要适配器）

• xD-Picture Card

• xD-Picture Card (Type H)

• xD-Picture Card (Type M)

文档：

• .doc (Microsoft Word)

• .xls (Microsoft Excel)

• .ppt (Microsoft PowerPoint)

• .pdf (Adobe Portable Document Format)

• .rtf (Rich Text Format)

• .docx (Microsoft Word Open Document Format)

• .xlsx (Microsoft Excel Open Document Format)

• .pptx (Microsoft PowerPoint Open Document
Format)

• .wpd (WordPerfect)

图像：

• JPEG

• TIFF

使用打印机操作面板打印照片

1 装入照片纸。

2 插入存储卡、闪存驱动器或设置为大容量存储器模式的数码相机。

显示屏上将会出现“Memory Device（存储设备）”界面。

3 触摸“View Photos（浏览照片）”。

“Select Photos（选择照片）”界面将会出现。

4 触摸您希望打印的照片。

提示：

• 如果您希望清除所选的照片，请再次触摸照片。

• 如果您希望查看更多的照片，请触摸左箭头或右箭头，然后触摸并选择照片。

5 当您选择完您希望打印的照片之后，请触摸“Layout（版面）”。

6 如果您希望改变打印设置，请触摸“Change Settings（改变设置）”。

如有必要，请在选择完每一项之后触摸“Accept（接受）”。

7 按  按钮。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。
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使用打印机操作面板编辑照片

1 装入照片纸。

2 插入存储卡或闪存驱动器。

显示屏上将会出现“Memory Device（存储设备）”界面。

3 触摸“View Photos（浏览照片）”。

“Select Photos（选择照片）”界面将会出现。

4 触摸您希望编辑的照片。

5 触摸  查看所选的照片。

提示：

• 如果您希望清除所选的照片，请触摸 。

• 如果您希望查看上一张或下一张照片，请触摸左箭头或右箭头，然后触摸  选择照片。

6 触摸 。选择完每一项之后请触摸“Accept（接受）”。

使用此菜单项： 您可以：

Crop（剪裁） 剪裁照片。

Brightness（深浅） 调整照片的深浅。

Red Eye（红眼） 去除由照相机闪光灯所引起的红眼。

Auto Fix（自动调整） 自动增强照片效果。

Color Effects（彩色效果）选择使用黑白方式、棕褐色调、仿古棕色或仿古灰色打印照片。

7 当您编辑完照片之后，请触摸“Done（完成）”。

8 如果您希望编辑其他的照片，请触摸  返回到“Select Photos（选择照片）”界面。

9 重复步骤 4-8，直到所有照片都编辑完毕，然后触摸“Layout（版面）”。

10 如果您希望改变打印设置，请触摸“Change Settings（改变设置）”。

如有必要，请在选择完每一项之后触摸“Accept（接受）”。

11 按  按钮。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

使用打印机软件打印存储设备中的照片

1 装入照片纸。

2 插入存储卡或闪存驱动器。

3 传送或打印照片：

打印

46



如果打印机使用 USB 连接

• Windows 用户

当您插入存储设备时，EzPrint 将会自动打开。请按照计算机屏幕上的指导将照片传送到计算机上或者
打印照片。

• Macintosh（英文版）用户

如果您设置了当存储设备连接在计算机上时打开一个应用程序，此应用程序将会自动打开。请按照计算
机屏幕上的指导将照片传送到计算机上或者打印照片。

如果打印机使用无线连接（仅限于某些型号）

a 从“存储设备”界面中依次选择：

更多选项 > 连接到计算机 > 选择您的网络打印机

b 传送或打印照片：

• Windows 用户

当连接建立后，EzPrint 将会自动打开。请按照计算机屏幕上的指导将照片传送到计算机上或者打印
照片。

• Macintosh（英文版）用户

选择 Yes 浏览存储设备中的照片。Network Card Reader 将会在计算机上打开。请按照计算机屏幕
上的指导将照片传送到计算机上或者打印照片。

从 PictBridge 兼容数码相机中打印照片

大部分数码相机都支持 PictBridge 技术，可以允许您直接从您的数码相机中打印照片，无需连接计算机。

1 将 USB 电缆的一端连接在数码相机上。

注意：请只使用随同数码相机一起提供的 USB 电缆。

2 将 USB 电缆的另一端插入打印机侧面的 PictBridge 接口中。

注意：

• 请确认数码相机被设置为正确的 USB 模式。如果不正确，数码相机可能会被检测为一个闪存驱动器，
或者打印机操作面板显示屏上可能会出现错误信息。请参阅数码相机说明文档获取更多的信息。

• 打印机每次只能读取一种存储设备。
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警告—可能的损坏：当正在打印、读取或写入存储设备时，请不要触摸任何
电缆、任何网络适配器、任何接口、存储设备或图中所示的打印机区域，否
则可能会发生数据丢失。

3 如果 PictBridge 连接成功，打印机显示屏上将会出现信息“数码相机已连接。请使用数码相机选择并打印
照片。”。

4 如果您希望改变默认的打印设置：

a 触摸“更多选项”进入“PictBridge”菜单。

b 选择您希望打印的照片的纸张尺寸、纸张类型、照片尺寸、质量和版面。选择完每一项之后请触
摸“接受”。

注意：打印机将会使用默认的打印设置，除非您在数码相机上改变了打印设置。

5 请参阅数码相机说明文档开始打印。

注意：当打印机正在打印其他作业时，如果您连接了数码相机，请等待作业完成，然后再从数码相机中进行打
印。

使用样张页打印存储设备中的照片

1 装入 A4 或 Letter 尺寸的普通纸。

2 插入存储卡或闪存驱动器。

显示屏上将会出现“存储设备”界面。

3 依次选择：

更多选项 > 样张页 > 打印样张页

4 选择您希望打印的照片。

您可以选择以下选项打印样张页：

• 为最近的 20 张照片（如果存储设备中的照片多于 20 张）。

• 为存储设备中所有的照片。

• 按照日期范围（如果存储设备中的照片是在不同的日期拍摄的）。如果您选择了此选项，请选择日期，
然后触摸“接受”。

样张页将会打印出来。

5 按照样张页上的指导选择要打印的照片、每张照片的份数、去除红眼、彩色效果、版面、打印选项和纸张
尺寸。

注意：当您进行选择时，请确认完全填满圆圈。
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6 装入照片纸。

注意：请确认纸张尺寸与您在样张页中选择的纸张尺寸一致。

7 将样张页正面朝下放置在扫描仪玻璃上。

8 触摸“扫描样张页 > 继续”。

打印机开始扫描样张页，然后开始打印照片。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

使用您的移动设备打印照片

根据您的打印机型号，您可以轻松地从您的 iPhone 或 iPod touch 打印照片。

在发送打印作业之前，请确认：

• 在您的移动设备上安装了 LexPrint。如要获取更多的信息，请参阅 LexPrint 用户手册。

• 打印机、计算机和 iPhone 或 iPod touch 位于同一个网络中。

• 打印机所连接的计算机上安装了 LexPrint Listener。您可以从我们的网站 www.lexmark.com/lexprint 上
下载应用程序。

• 在 LexPrint 的“设置”菜单界面中，“打印机”列表中的打印机被选中。

• 如果您的打印机连接在 Macintosh 计算机上，您的打印机处于共享和准备就绪状态。

• 打印队列中没有其他的打印作业。

1 在 LexPrint 主界面中轻轻触摸 ，然后选择照片相册。

2 轻轻触摸您希望打印的照片，将它添加到“照片预览”界面中。

如果您希望定制打印设置，请参阅 LexPrint 用户手册。

3 如要打印照片，请轻轻触摸 。

显示屏上将会出现信息“移动设备已连接”。

注意：处理打印作业可能要花费一点时间。

管理打印作业

将您的打印机设置为默认打印机

当您发送打印作业时，您的打印机应该在“打印”对话框中自动被选中。如果您必须手动选择您的打印机，说
明您的打印机不是默认打印机。

如要设置默认打印机：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。
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3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后单击“设为默认打印机”。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax

2 从 Default Printer 弹出菜单中选择打印机，或者选择打印机，然后单击 Make Default。

隐藏打印状态窗口或改变外观

您每次向打印机发送作业时，打印状态窗口将会出现。此窗口可能会伴随着语音通知。

1 打开文档，从应用程序中单击“文件  > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 单击“高级”选项卡，然后单击“更多的选项”。

4 在“外观模式”区域中选择适当的选项。

注意：您可以选择在屏幕的底部显示打印状态窗口，或者在任务栏中最小化显示此窗口。您也可以完全隐
藏此窗口。

5 单击“确定”。

改变打印模式

如要节省墨水，您可以为所有打印作业将默认打印模式改变为“高速”。此模式可以使用较少的墨水，推荐用
于打印文本文档。如果您要打印照片或其他高质量的文档，并且需要改变为不同的打印模式，您可以在发送打
印作业之前在“打印”对话框中选择不同的模式。

改变默认打印模式

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后依次选择：

打印首选项 > 高速 > 确定

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择您的打印机。

3 从打印选项弹出菜单中选择 Quality & Media。
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4 从 Print Quality 弹出菜单中选择 Quick Print。

5 从 Presets 弹出菜单中选择 Save as，然后为您的设置配置输入一个名称。

每次发送打印作业时，您都必须从 Presets 弹出菜单中选择此配置名称。

6 单击 OK。

为单个打印作业改变打印模式

Windows 用户

1 打开文档，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 选择“自动”、“高速”、“正常”或“最佳”。

注意：使用“高速”模式打印可以使用较少的墨水，推荐用于打印文本文档。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择您的打印机。

3 从打印选项弹出菜单中选择 Quality & Media。

4 从 Print Quality 弹出菜单中选择 Automatic、Quick Print、Normal 或 Best。

注意：使用 Quick Print 模式打印可以使用较少的墨水，推荐用于打印文本文档。

暂停打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 暂停打印作业：

• 如果您希望暂停特定的打印作业，请右键单击文档名，然后单击“暂停”。

• 如果您希望暂停队列中所有的打印作业，请单击“打印机”菜单，然后选中“暂停打印”。
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Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 暂停打印作业：

• 如果您希望暂停特定的打印作业，请选择文档名，然后单击 Hold。

• 如果您希望暂停队列中所有的打印作业，请单击 Pause Printer 或 Stop Jobs。

继续打印作业

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。

4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 继续打印作业：

• 如果您希望继续特定的打印作业，请右键单击文档名，然后单击“继续”或“重新启动”。

• 如果您希望继续队列中所有的打印作业，请单击“打印机”菜单，然后取消选中“暂停打印”。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 单击 Open Print Queue 或 Set Up Printers。

打印队列对话框将会出现。

3 继续打印作业：

• 如果您希望继续特定的打印作业，请选择文档名称，然后单击 Resume。

• 如果您希望继续队列中所有的打印作业，请单击 Resume Printer 或 Start Jobs。

取消打印作业

如要取消从打印机操作面板开始的打印作业，请按  按钮。如要取消从计算机开始的打印作业，请根据您的
操作系统选择操作：

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

打印机文件夹将会出现。
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4 右键单击打印机图标，然后从弹出菜单中单击“打开”或“查看现在正在打印什么”。

5 取消打印作业：

• 如果您希望取消特定的打印作业，请右键单击文档名，然后单击“取消”。

• 如果您希望取消队列中所有的打印作业，请单击“打印机 > 取消所有文档”。

Macintosh（英文版）用户

1 单击 dock 上的打印机图标。

打印队列对话框将会出现。

2 选择您希望取消的作业，然后单击 Delete。
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复印

扫描仪玻璃

将文档原件或照片正面朝下放置在扫描仪玻璃上。当您在扫描仪玻璃上放置小介质时，请使用扫描仪夹子。

复印提示
• 当使用扫描仪玻璃时，请关闭扫描仪顶盖，以避免扫描结果中出现黑边。

• 在扫描仪玻璃的右下方查找放置角落。它可以作为正确放置文档的指导。

• 如要进行即时预览扫描，请将文档原件或照片放置在扫描仪玻璃上，然后关闭扫描仪顶盖。

• 如要最好地使用打印机的扫描功能，请使用位于扫描仪玻璃上方的扫描仪夹子将照片、卡片或其他小介质
保持在固定位置。

进行复印
1 装入文档原件。

“即时预览”主界面将会出现。

注意：在打印机操作面板上，您可以按  按钮使用默认设置复印一份文档原件。

2 依次选择：

复印 > 更多选项 > 份数

3 输入您希望复印的份数，然后触摸“接受”。
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4 触摸“彩色”或“黑白”设置彩色或黑白复印。

5 按  按钮。

复印照片
1 装入照片纸。

2 将照片正面朝下放置在扫描仪玻璃上。

“即时预览”主界面将会出现。

3 依次选择：

SmartSolutions > 照片重印

4 选择照片打印尺寸，然后触摸“接受”。

5 触摸“继续”开始打印。

注意：要获得最佳效果，请将打印页单独放置至少 24 小时，等墨水完全干燥后再进行叠放、展示或储存。

复印 ID 卡
1 将 ID 卡正面朝下放置在扫描仪玻璃的右下角。

“即时预览”主界面将会出现。

2 依次选择：

SmartSolutions > ID 卡复印

3 当提示您复印 ID 卡的背面时，请触摸“是”。

4 将 ID 卡背面朝下放置在扫描仪玻璃的右下角。

5 触摸“继续”开始打印。

复印双面文档
1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 双面复印

3 选择双面复印选项，然后触摸“接受”。

• 双面到单面 — 将双面文档进行单面复印。

• 双面到双面 — 进行双面复印（和文档原件一样）。

4 按  按钮。

5 按照显示屏上的指导进行操作。
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放大或缩小图像
1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 调整大小

3 选择调整大小设置，然后触摸“接受”。

注意：

• 如果您选择了“适合页面”，打印机将会适当地调整文档或照片的大小，使之适合单页纸。

• 如果您选择了“自定义%”，请指定自定义调整大小设置，范围为 25%-400%。

• 如果您选择了“无边界”，打印机将会根据需要调整文档或照片的大小，在所选择的纸张尺寸上进行
无边界打印。

• 如果您选择了“海报”，请选择您希望打印的海报的尺寸。此选项可以允许您将一个图像打印成多页。

4 按  按钮。

调整复印质量
1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 质量

3 设置复印质量，然后触摸“接受”。

4 按  按钮。

使复印结果较浅或者较深
1 装入文档原件。

“即时预览”主界面将会出现。

2 触摸“复印”。

3 使用滑动条改变深浅等级。

4 按  按钮。
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使用打印机操作面板进行逐份复印
当您将一份文档打印多份时，您可以选择分别打印每一份（逐份）或者按照页数一组一组地打印（不逐份）。

逐份 不逐份

1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 份数

3 输入您希望复印的份数，然后触摸“接受”。

4 滚动到“逐份打印”，然后触摸 。

5 按  按钮。

在一页纸上复制图像
您可以将同样一个图像在一页纸上打印多个。此功能可以帮助您制作标签、贴纸、广告和宣传单。

1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 每张纸上复制多个

3 选择在一张纸上复制图像的次数，然后触摸“接受”。

4 按  按钮。

将多页文档复印到一张纸上
通过将每一页文档打印成较小的图像，“每张纸上打印多页”功能可以允许您将多页文档复印到一张纸上。例
如，如果您使用此功能在一张纸上打印 4 页文档，则您可以将一份 20 页的文档减少为 5 页。

1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 每张纸上打印多页

3 选择您希望在一张纸上复印的页数，然后触摸“接受”。您最多可以在一张纸上打印 4 页图像。

注意：如果您要按照横向格式复印 4 页文档，请先扫描第 3 页和第 4 页，然后再扫描第 1 页和第 2 页。

4 按  按钮。
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进行双面复印

自动进行双面复印

自动双面打印部件（仅限于某些打印机型号）只支持 Letter 和 A4 尺寸的纸张。如果您购买的型号不带有自动
双面打印部件，或者如果您需要使用其他尺寸的纸张进行双面复印，请参阅有关手动进行双面复印的指导。

注意：您不可以在信封、卡片纸或照片纸上进行双面复印。

1 装入文档原件。

“即时预览”主界面将会出现。

2 依次选择：

复印 > 更多选项 > 双面复印

3 选择双面复印选项，然后触摸“接受”。

• 单面到双面 — 将单面文档进行双面复印。

• 双面到双面 — 进行双面复印（和文档原件一样）。

4 按  按钮将文档的第一页保存在打印机内存中。

5 按照显示屏上的指导进行操作。

手动进行双面复印

1 装入文档原件。

“即时预览”主界面将会出现。

2 触摸“复印”。

3 按  在纸张的一面进行打印。

4 装入文档的下一页：

• 如果您要复印单面的文档，请装入下一页。

• 如果您要复印双面的文档，请翻转文档原件，然后重新装入。
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5 从出纸托盘中取出纸张，然后重新装入纸张打印文档的另外一面。

6 按  按钮。

取消复印作业
如要取消复印作业，请按  按钮。

扫描将会停止，并且打印机返回到之前的菜单。
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扫描

扫描仪玻璃

将文档原件或照片正面朝下放置在扫描仪玻璃上。当您在扫描仪玻璃上放置小介质时，请使用扫描仪夹子。

扫描提示
• 当使用扫描仪玻璃时，请关闭扫描仪顶盖，以避免扫描的图像中出现黑边。

• 在扫描仪玻璃的右下方查找放置角落。它可以作为正确放置文档的指导。

• 要获得即时预览扫描，请将文档或照片放置在扫描仪玻璃上，然后关闭扫描仪顶盖。

• 如果您希望扫描多页并将它们保存为一个文件，请选择“多页 PDF”文件类型。

• 如要最好地使用打印机的扫描功能，请使用位于扫描仪玻璃上方的扫描仪夹子将照片、卡片或其他小介质
保持在固定位置。

• 要启动打印机的网络扫描功能，请确保在“Scan Center”的“General”选项卡中选中“Enable network
scan to computer”。仅 Mac OS X version 10.6 提供该选项。

扫描到本地或网络计算机
1 装入文档原件。

“即时预览”界面将会出现。

2 依次选择：

扫描 > 扫描到：目的地 > 扫描至计算机
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3 触摸“USB 连接的计算机”或网络计算机的名称。

本地或网络计算机是用于接收扫描结果的目的地。

注意：

• 如果打印机只连接在本地计算机上，打印机将会自动将本地计算机设置为接收扫描结果的默认目的地。

• 对于 Macintosh（英文版）用户，如果您希望从网络计算机进行扫描，您必须首先将打印机添加到 Edit
Device List 对话框中。如要获取更多的信息，请单击 Library > Printers > Lexmark > Utilities，打开
Edit Device List，然后单击 。

• 如果计算机要求识别码，打印机可能会提示您输入识别码。

• 如要为计算机指定计算机名和识别码，请参阅适用于您的操作系统的打印机软件帮助。

4 选择您希望创建的输出文件类型，然后触摸“接受”。

5 触摸“更多选项”选择色彩、分辨率质量和图像原件尺寸。如有必要，请在选择完每一项之后触
摸“接受”。

6 按  按钮。

扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经保存了。

扫描至闪存驱动器或存储卡
在您开始操作之前，请确认您的闪存驱动器或存储卡没有设置写入保护。

1 装入文档原件。

“即时预览”界面将会出现。

2 依次选择：

扫描 > 扫描到：目的地

3 插入存储卡或闪存驱动器。

注意：

• 打印机每次只能读取一种存储设备。

• 如果存储卡插槽中插入了存储卡，并且您同时将闪存驱动器插入 USB 接口中，显示屏上将会出现一条
信息，提示您选择您希望使用哪一个存储设备。

4 选择您希望创建的输出文件类型。

注意：如果您希望扫描多页并将它们保存为一个文件，请选择多页 PDF 文件类型。

5 触摸“更多选项”选择色彩、分辨率质量和图像原件尺寸。如有必要，请在选择完每一项之后触
摸“接受”。

6 按  按钮。

扫描完毕后，打印机操作面板显示屏上将会出现信息，您扫描的文件已经保存了。
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扫描照片并发送到编辑应用程序中

Windows 用户

1 装入照片。

“即时预览”界面将会出现。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 照片

• 如果您希望扫描单张照片，或者将多张照片扫描成一个图像，请选择“单张照片”。

• 如果您希望一次扫描多张照片，并且分别保存为单独的图像，请选择“分成单独的照片”。

注意：在这种情况下，请确保照片之间有至少 1/4 英寸的距离。

扫描开始，并且扫描进度对话框将会出现。

5 保存照片，然后在照片编辑应用程序中打开照片并进行编辑。

Macintosh（英文版）用户

1 装入照片。

“即时预览”界面将会出现。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Scan Center。

如要从网络打印机进行扫描，您必须首先将打印机添加到 Edit Device List 对话框中。

a 从 Device 弹出菜单中选择 Browse Devices。

b 在 Edit Device List 对话框中添加您的打印机。如要获取更多的信息，请单击 。

c 单击 OK。

4 从 Scan Center 的 What is being scanned?区域中选择 Photo。

5 从 How will the scanned image be used?弹出菜单中选择 To be printed 或 To be viewed on monitor/Web
page。

6 从 Send scanned image to 弹出菜单中为扫描的图像选择目的地文件夹或应用程序。

7 如果您要扫描多张照片，请选择 Prompt for multiple pages。

8 单击 Preview/Edit。

Scan 对话框将会出现。

9 根据您的需要调整图像和扫描设置。

10 单击 Scan。
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扫描文档并发送到编辑应用程序中
光学字符识别(OCR)应用程序可以允许您编辑扫描的文本文档。如要使用此功能，您必须在本地或网络计算机
上安装 OCR 应用程序，并且当您设置扫描作业时必须从应用程序列表中选择它。

当您为扫描作业选择设置时：

• 请选择扫描到安装了 OCR 应用程序的本地或网络计算机。

• 请选择使用最高的分辨率进行扫描。

Windows 用户

1 装入文档原件。

“即时预览”界面将会出现。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 文档

扫描开始，并且扫描进度对话框将会出现。

5 扫描完毕后，在文字处理应用程序中保存文档。

6 在所选的应用程序中打开文档并进行编辑。

Macintosh（英文版）用户

1 装入文档原件。

“即时预览”界面将会出现。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Scan Center。

如要从网络打印机进行扫描，您必须首先将打印机添加到 Edit Device List 对话框中。

a 从 Device 弹出菜单中选择 Browse Devices。

b 在 Edit Device List 对话框中添加您的打印机。如要获取更多的信息，请单击 。

c 单击 OK。

4 从 Scan Center 的 What is being scanned?区域中选择除 Photo 以外的其他文档类型。

5 从 How will the scanned image be used?弹出菜单中选择 To be edited (OCR)。

6 从 Send scanned image to 弹出菜单中选择用于进行编辑的文字处理应用程序。

7 单击 Scan。

8 在文字处理应用程序中打开扫描的文档并进行编辑。
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使用打印机软件直接扫描至电子邮件

Windows 用户

1 装入文档原件。

“即时预览”界面将会出现。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > 电子邮件

5 选择“照片”、“文档”或“PDF”。

注意：只有当您的计算机上安装了 OCR 应用程序时，您才可以选择“文档”。

6 扫描开始，并且扫描进度对话框将会出现。

7 扫描完毕后将会创建一封新的电子邮件，并且自动附加扫描的文档。

8 在您的电子邮件中输入正文。

注意：如果您的电子邮件应用程序没有自动打开，您可以将文档扫描至计算机，然后作为附件通过电子邮件发
送出去。

Macintosh（英文版）用户

1 装入文档原件。

“即时预览”界面将会出现。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Scan Center。

如要从网络打印机进行扫描，您必须首先将打印机添加到 Edit Device List 对话框中。

a 从 Device 弹出菜单中选择 Browse Devices。

b 在 Edit Device List 对话框中添加您的打印机。如要获取更多的信息，请单击 。

c 单击 OK。

4 从 Scan Center 的 What is being scanned?区域中选择文档类型。

5 从 How will the scanned image be used?弹出菜单中选择 To be viewed on monitor/Web page。

6 从 Send scanned image to 弹出菜单中选择应用程序。

7 单击 Scan。

8 在应用程序中打开扫描的图像，然后作为附件通过电子邮件发送出去。
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扫描至 PDF

Windows 用户

1 装入文档原件。

“即时预览”界面将会出现。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > PDF

扫描开始，并且扫描进度对话框将会出现。

5 将文档保存为 PDF 文件。

Macintosh（英文版）用户

1 装入文档原件。

“即时预览”界面将会出现。

2 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

3 双击 Scan Center。

如要从网络打印机进行扫描，您必须首先将打印机添加到 Edit Device List 对话框中。

a 从 Device 弹出菜单中选择 Browse Devices。

b 在 Edit Device List 对话框中添加您的打印机。如要获取更多的信息，请单击 。

c 单击 OK。

4 从 Scan Center 的 What is being scanned?区域中选择文档类型。

5 根据您的需要定制设置。

6 单击 Scan。

7 将文档保存为 PDF 文件。

扫描常见问答

我如何提高扫描质量？
• 请确认您的文档原件完好无误。

• 请确认用于接收扫描结果的应用程序是适当的应用程序。例如，如果您要扫描照片并进行编辑，请确认您
选择了照片编辑应用程序接收扫描结果。如果您要扫描文档并编辑其中的文本，请确认您选择了 OCR 应
用程序。

• 使用较高的分辨率。

• 在扫描过程中，请保持扫描仪顶盖关闭。请不要移动文档原件。
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我如何进行黑白扫描？

所有的扫描作业默认都是彩色的。如要进行黑白扫描，请按照以下的步骤进行操作：

1 在主界面中触摸“扫描”。

2 选择扫描目的地。

3 为扫描作业选择设置。

4 在“扫描选项”界面中触摸 。

5 按  按钮。

为什么会要求我输入识别码？

识别码是一种安全措施，用于限制扫描的信息只发送到指定的位置，或者防止其他人看到或使用扫描的内容。
如果您要发送扫描结果的网络计算机需要识别码，打印机可能会提示您输入识别码。

如要了解如何为网络计算机指定识别码，请参阅适用于您的操作系统的打印机软件帮助。

取消扫描作业
按打印机操作面板上的  按钮，或者在计算机屏幕上单击“取消”。
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电子邮件
您可以使用您的打印机向一个或多个收件人发送电子邮件，无需使用计算机。如要完成此任务，您可以扫描文
档或照片，然后作为电子邮件发送出去，或者您也可以将存储设备中保存的文档或照片附加到电子邮件中。

您必须首先配置您的打印机的电子邮件设置，然后才可以使用打印机操作面板发送电子邮件。

设置打印机的电子邮件功能

设置电子邮件功能

1 从主界面中依次选择：

 > 电子邮件设置 > 是

2 输入您的电子邮件地址，然后触摸“确定”。

打印机会将您的电子邮件地址与已知电子邮件供应商的列表进行比较。

3 按照显示屏上的提示进行操作：

• 如果您的电子邮件地址与列表中的一个域名一致，打印机将会自动指定 SMTP 服务器设置。

注意：根据您输入的电子邮件地址，打印机可能会要求您输入您的电子邮件的用户名和密码。

• 如果电子邮件域名是未知的，“高级电子邮件设置向导”将会出现在显示屏上。

输入必需的信息。触摸“确定”或“接受”保存每一项。

安装后改变电子邮件设置

如果您希望改变 SMTP 服务器设置

1 从主界面中依次选择：

 > 电子邮件设置 > SMTP 设置

2 触摸每一项并输入必需的信息。触摸“确定”或“接受”保存每一项。

• 服务器 — 输入 SMTP 服务器的名称或地址。

• 端口 — 输入 SMTP 端口。

• 验证类型 — 为您的电子邮件账号选择验证类型。如果您选择了“无”，打印机将不会要求您输入用户
名和密码。如要获取更多的信息，请与您的电子邮件供应商或您的系统支持人员联系。

注意：根据您在电子邮件设置过程中输入的电子邮件地址，“验证类型”界面可能不会出现在显示屏
上。

• 发件人姓名 — 输入您的姓名。

• 用户名 — 输入您的电子邮件地址。

• 密码 — 输入您的电子邮件账号密码。

• 域 — 输入您的电子邮件帐号域。

注意：只有当“验证类型”被设置为“NTLM”时，此设置才会出现。如要获取更多的信息，请与您
的电子邮件供应商或您的系统支持人员联系。
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3 如要检查 SMTP 服务器设置是否正确，请触摸“测试 SMTP 设置”。

如果您希望改变电子邮件设置

1 从主界面中依次选择：

 > 电子邮件设置

2 触摸每一项并输入必需的信息。如有必要，请触摸“确定”或“接受”保存每一项。

• 回复电子邮件地址 — 输入您的电子邮件地址。

• 给我发送一份副本 — 触摸“是”可以为您从打印机发送的每一封电子邮件向您自己发送一份副本。

• 标题行 — 输入您的默认电子邮件标题。

• 信息 — 输入您的默认电子邮件信息。

创建电子邮件联系人列表

使用打印机操作面板创建电子邮件联系人列表

1 从主界面中依次选择：

 > 通讯簿

2 添加联系人或电子邮件群组：

• 如要添加联系人：

a 依次触摸“添加联系人 > 添加联系名称”。

b 输入联系名称，然后依次触摸“确定 > 添加电子邮件地址”。

c 输入联系人的电子邮件地址，然后依次触摸“确定 > 接受”。

d 如果您希望添加其他的记录，请重复步骤 a-c。您最多可以输入 89 个联系人。

• 如要添加电子邮件群组：

a 依次触摸“添加群组 > 添加群组名称”。

b 输入群组名称，然后触摸“确定”。

c 触摸“添加群组成员”，然后选择您希望手动添加联系人还是导入联系人：

– 通讯簿 — 从通讯簿中导入联系人。

– 历史记录 — 从电子邮件历史记录中导入联系人。

– 新建记录 — 添加新的联系人。

d 每一次您导入联系人或添加联系人之后，请触摸“接受”保存记录。

使用打印机软件创建电子邮件联系人列表

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “传真”选项卡 > 编辑联系人列表 > 从电话簿中选择
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4 从“电话簿”下拉列表中选择电话簿。

您可以选择任何您用于保存电子邮件地址的邮件客户端电话簿。

5 选择您希望添加的联系人，然后单击“添加到列表或改变列表”导入联系人。

6 单击“确定”。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。

3 依次选择：

Contacts 选项卡 > Individuals 选项卡

4 单击  打开通讯簿。

注意：如要添加联系人，您需要从您的 Macintosh 计算机上的通讯簿中导入联系人。如果联系人不在 Mac
通讯簿中，请先将联系人添加到通讯簿中，然后再导入。

5 在通讯簿中单击您希望添加的联系人，然后将它拖动到 Contacts 列表中。

如要获取更多的信息，请单击“帮助”或  浏览有关传真软件的帮助信息。

发送电子邮件

扫描仪玻璃

将文档原件或照片正面朝下放置在扫描仪玻璃上。当您在扫描仪玻璃上放置小介质时，请使用扫描仪夹子。

电子邮件提示
• 当使用扫描仪玻璃时，请关闭扫描仪顶盖，以避免扫描结果中出现黑边。

• 在扫描仪玻璃的右下方查找放置角落。它可以作为正确放置文档的指导。

• 如要进行即时预览扫描，请将文档原件或照片放置在扫描仪玻璃上，然后关闭扫描仪顶盖。

• 如要最好地使用打印机的扫描功能，请使用位于扫描仪玻璃上方的扫描仪夹子将照片、卡片或其他小介质
保持在固定位置。

• 在发送电子邮件之前，请确认您输入了您的电子邮件帐号信息并设置了 SMTP 服务器。
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• 在发送电子邮件之前，请确认打印机连接在无线网络中。

如有必要，请确认网络连接在 Internet 中，以便打印机可以与 SMTP 服务器进行通讯。如果打印机不能连
接到 Internet，请与您的系统支持人员联系。

• 向您的通讯簿中添加联系人。当发送电子邮件时，您可以直接从您的通讯簿中选择联系人，而无须重复输
入他们的电子邮件地址。

扫描文档或照片至电子邮件

1 装入文档原件或照片。

“即时预览”界面将会出现。

注意：您在每一封电子邮件中只能附加一个文件。

2 依次选择：

扫描 > 扫描到：目的地 > 扫描至电子邮件

3 选择您希望创建的输出文件类型。

注意：如果您希望扫描多页并将它们保存为一个文件，请选择多页 PDF 文件类型。

4 触摸选项并输入或选择收件人：

• 输入电子邮件地址 — 手动输入电子邮件地址。

• 通讯簿 — 触摸“按名称排列”或“按组排列”，然后选择联系人。

• 历史记录 — 从历史记录列表中选择姓名或电子邮件地址。

如有必要，选择完每一项之后请触摸“确定”或“接受”。

5 如要输入其他的收件人，请触摸“添加收件人”，然后输入您希望添加的电子邮件地址、名称或组。

添加完每一个收件人之后请触摸“接受”。

注意：您最多可以向 30 个收件人发送电子邮件。

6 选择文件类型、色彩、质量和您希望发送的文档或照片的原件尺寸。如有必要，请触摸“接受”保存每一
项。

7 如果您希望改变默认的电子邮件标题，请依次选择：

标题 > 输入您的标题 > 确定

8 如果您希望改变默认的电子邮件信息，请依次选择：

信息 > 输入您的信息 > 确定

9 按  按钮。
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在电子邮件中附加文档或照片

1 插入存储卡或闪存驱动器。

显示屏上将会出现“存储设备”界面。

注意：

• 打印机每次只能读取一种存储设备。

• 如果存储卡插槽中插入了存储卡，并且您同时将闪存驱动器插入 USB 接口中，显示屏上将会出现一条
信息，提示您选择您希望使用哪一个存储设备。

2 触摸“附加文件到电子邮件”。

3 如果您希望改变默认的电子邮件标题，请依次选择：

标题 > 输入您的标题 > 确定

4 如果您希望改变默认的电子邮件信息，请依次选择：

信息 > 输入您的信息 > 确定

5 选择要附加的文件：

注意：您在每一封电子邮件中只能附加一个文档或一张照片。

• 如果您希望附加文档，请依次选择：

附加文档到电子邮件 > 选择文档的文件名 > 继续

• 如果您希望附加照片，请依次选择：

附加照片到电子邮件 > 选择一张照片 > 继续

6 触摸选项并输入或选择收件人：

• 输入电子邮件地址 — 手动输入电子邮件地址。

• 通讯簿 — 触摸“按名称排列”或“按组排列”，然后选择联系人。

• 历史记录 — 从历史记录列表中选择姓名或电子邮件地址。

如有必要，选择完每一项之后请触摸“确定”或“接受”。

7 如要输入其他的收件人，请触摸“添加收件人”，然后输入您希望添加的电子邮件地址、名称或组。

添加完每一个收件人之后请触摸“接受”。

注意：您最多可以向 30 个收件人发送电子邮件。

8 触摸“发送”。

取消电子邮件
如要取消电子邮件，请按  按钮。
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传真
当心—电击危险：请不要在雷雨天气时使用传真功能。请不要在雷雨天气时安装此产品，或者进行任何电
线／电缆连接（例如电源线，电话线等）。

设置打印机进行传真

方法 1：标准电话线

安装方法 1：打印机连接在专用传真线上

如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

此安装方法的提示：

• 您可以设置打印机自动接收传真（自动应答开）或手动接收传真（自动应答关）。

• 如果您希望自动接收传真（自动应答开），请设置打印机在您希望的任意数目的铃响之后应答来电。
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安装方法 2：打印机和电话答录机共用电话线

连接在同一个墙壁电话线插座上

如要进行连接：

1 使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

2 从打印机后面的  插口上去掉保护塞，然后将电话答录机连接在此插口上。
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连接在不同的墙壁电话线插座上

如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

此安装方法的提示：

• 如果您的电话线上只有一个电话号码，您需要设置打印机自动接收传真（自动应答开）。

• 请设置打印机比电话答录机多 2 声铃响应答来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设
置打印机在 6 声铃响之后应答来电。在这种情况下，电话答录机首先应答来电并接收您的语音来电。如果
来电是传真，打印机可以检测到线路上的传真信号并接管来电。

• 如果您申请了您的电话公司提供的特色铃声服务，请确认您为打印机设置了正确的特色铃声模式。否则，
即使您设置了打印机自动接收传真，打印机也不会接收传真。

传真

74



安装方法 3：打印机和申请了语音邮件功能的电话机共用电话线

如要进行连接：

1 使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

2 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

此安装方法的提示：

• 如果您申请了特色铃声服务，此安装方法的效果最好。在这种情况下，请确认您为打印机设置了正确的特
色铃声模式。否则，即使您设置了打印机自动接收传真，打印机也不会接收传真。

• 如果您的电话线上只有一个电话号码，您需要设置打印机手动接收传真（自动应答关）。

当您接听电话并听到传真信号时，请在电话机上按*9*或手动应答码开始接收传真。

• 您也可以设置打印机自动接收传真（自动应答开），但是当您预期接收传真时，您需要禁用语音邮件服
务。如果您使用语音邮件的频率高于传真，此设置效果最好。
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方法 2：数字用户线路(DSL)

数字用户线路(DSL)将您的常规电话线分成两个通道：语音和互联网。电话和传真信号通过语音通道传输，而
互联网信号通过另一个通道传输。在这种情况下，您可以使用同一条线路实现模拟语音电话（包括传真）和数
字互联网连接。

如要使两个通道之间的干扰最小并确保高质量的连接，您需要为网络中的模拟设备（传真机、打印机、电话答
录机）安装一个 DSL 过滤器。干扰会引起电话噪音和静电、打印机传真失败和质量差、计算机的互联网连接
速度慢等问题。

如要为打印机安装一个过滤器：

1 将 DSL 过滤器的线路插口连接在墙壁插座上。

2 使用一根电话线连接打印机后面的  插口和 DSL 过滤器的电话插口。

3 如要继续使用计算机访问互联网，请将计算机连接在 DSL 过滤器的 DSL HPN 插口上。

4 如要将电话机连接在打印机上，请从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。
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方法 3：VoIP 电话服务

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 VoIP 适配器上标有“电话线 1”或“电话插口”的插口上。

标有“电话线 2”或“传真插口”的插口通常不能使用。如果您希望启用第二个电话插口，您可能需要向
您的 VoIP 供应商支付额外的费用。

3 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

此安装方法的提示：

• 如要确认 VoIP 适配器上的电话插口可以使用，请将一部模拟电话机连接在电话插口上，然后收听拨号
音。如果您可以听到拨号音，说明插口可以使用。

• 如果您的设备需要两个电话插口，但是您不希望支付额外的费用，请不要将打印机连接在第二个电话插口
上。您可以使用电话分线器。将电话分线器插入标有“电话线 1”或“电话插口”的插口中，然后将打印
机和电话机连接在分线器上。

请确认您使用的是电话分线器，而不是线路分线器。如要确认您使用的是正确的分线器，请将一部模拟电
话机连接在分线器上，然后收听拨号音。
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方法 4：通过电缆供应商的数字电话服务

安装方法 1：打印机直接连接在电缆调制解调器上

如果您通常将电话机连接在电缆调制解调器上，请按照此安装方法进行操作。

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在电缆调制解调器上标有“电话线 1”或“电话插口”的插口上。

标有“电话线 2”或“传真插口”的插口通常不能使用。如果您希望启用第二个电话插口，您可能需要向
您的电缆供应商支付额外的费用。

3 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

此安装方法的提示：

• 如要确认电缆调制解调器上的电话插口可以使用，请将一部模拟电话机连接在电话插口上，然后收听拨号
音。如果您可以听到拨号音，说明插口可以使用。

• 如果您的设备需要两个电话插口，但是您不希望支付额外的费用，请不要将打印机连接在第二个电话插口
上。您可以使用电话分线器。将电话分线器插入标有“电话线 1”或“电话插口”的插口中，然后将打印
机和电话机连接在分线器上。

请确认您使用的是电话分线器，而不是线路分线器。如要确认您使用的是正确的分线器，请将一部模拟电
话机连接在分线器上，然后收听拨号音。
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安装方法 2：打印机连接在墙壁电话线插座上；电缆调制解调器安装在房间中的其他地方

如果您的电缆供应商启用了您的房间中的墙壁电话线插座，您不需要将您的设备连接在电缆调制解调器上，请
按照此安装方法进行操作。您的电缆电话服务来自于墙壁电话线插座。

如要进行连接：

1 使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

2 从打印机后面的  插口上去掉保护塞，然后将电话机连接在此插口上。

方法 5：不同国家或地区的特定安装

不同的国家或地区有不同的墙壁电话线插座。被大多数国家或地区所采用的标准墙壁电话线插座是 Registered
Jack-11(RJ-11)。您需要一个 RJ-11 插头，或者一根带有 RJ-11 插头的电话线，以便将设备连接在 RJ-11 墙
壁电话线插座上。

打印机后面的传真插口和随同打印机一起提供的电话线都是 RJ-11 的。如果您所在的国家或地区使用不同类
型的插座，您可能需要使用 RJ-11 适配器。
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将打印机连接在非 RJ-11 墙壁电话线插座上

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 RJ-11 适配器上，然后将适配器插入墙壁电话线插座中。

3 如果您希望将其他设备（电话机或电话答录机）连接在同一个墙壁电话线插座上，并且设备的插头不是
RJ-11 的，请将它直接连接在墙壁电话线插座上。

注意：

• 请不要从打印机后面的  插口上去掉保护塞。

• 在您的国家或地区，打印机包装箱内可能不包含 RJ-11 适配器。
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如果其他设备（电话机或电话答录机）有 RJ-11 插头，您可以从打印机后面的  插口上去掉保护塞，然后将
设备连接在此插口上。

在使用串行连接的国家或地区连接打印机

在一些国家或地区，您需要将所有的设备连接在墙壁电话线插座上。您不能将电话机或电话答录机连接在打印
机的  插口上。这种方法称为串行连接。

澳大利亚 德国 葡萄牙

比利时 爱尔兰 西班牙

丹麦 意大利 瑞典

法国 荷兰 瑞士

芬兰 挪威 英国

警告—可能的损坏：如果您所在的国家或地区包含在列表中，请不要从打印机后面的  插口上去掉保护塞。
如要使电话线上的设备正常工作，此保护塞是必需的。
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如要进行连接：

使用一根电话线连接墙壁电话线插座和打印机后面的  插口。

将打印机连接在墙壁电话线插座上（德国）

德国的墙壁电话线插座有两种插口。N 插口用于传真机、调制解调器和电话答录机。F 插口用于电话机。
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将打印机连接在任意的 N 插口上。

如要进行连接：

1 将电话线的一端连接在打印机后面的  插口上。

2 将电话线的另一端连接在 RJ-11 适配器上，然后将适配器插入 N 插口中。

3 如果您希望将电话机和电话答录机连接在同一个墙壁电话线插座上，请按照图示连接设备。

输入您的使用者信息

您的使用者信息包括您的姓名或公司名称、您的传真号码（也就是您的电话号码，除非您使用的是专用的传真
电话线）和当您发送传真时您的传真机上的日期和时间。此信息出现在您发送的传真的页眉和页脚中。

一些国家或地区需要您提供传真号码和传真名称才可以发送传真，并且一些传真机会阻止匿名传真。请确认您
正确地输入了您的传真号码和传真名称。此信息将会添加到您发送的所有传真中，表明您是发件人。

设置传真页眉

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 传真名称

2 输入您的姓名或公司名称，然后触摸“接受”。

3 触摸“传真号码”。

4 输入您的传真号码或电话号码，然后触摸“接受”。
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设置传真页脚

1 从主界面中依次选择：

 > 传真设置 > 传真打印 > 传真页脚

2 触摸“开”，然后触摸“接受”。

配置传真设置
您可以使用打印机操作面板或传真软件配置传真设置。如果您使用打印机操作面板配置了传真设置，传真软件
将会导入这些设置。所做的改变将会在您下一次运行传真软件时生效。打印机也会保存您在传真软件中选择的
设置，除非您设置打印机阻止从计算机上进行改变。

使用打印机操作面板配置传真设置

1 从主界面中依次选择：

 > 传真设置

2 使用菜单中的选项配置传真设置：

在这里 您可以

报告 • 在屏幕上查看传真历史记录。

• 打印确认页或发送报告。这些报告可以帮助您了解您发送的传真是否成功。

• 打印活动日志。活动日志可以允许您查看您的打印机发送和接收传真的历史记录。

铃声和应答 • 设置打印机自动或手动接收传真。启用或禁用自动应答。

• 调整铃声音量。

• 设置铃响数目。如果您选择了自动接收传真（自动应答开），这是非常重要的。

• 设置特色铃声。如果您为您的电话线申请了特色铃声功能，请在此菜单中为打印机设置正确的
模式。

• 启用传真转发。

• 设置手动应答码。当您手动接收传真时需要输入此应答码。

传真打印 • 设置打印机适合页面打印接收到的传真。

• 打印传真页脚。

• 在纸张的双面进行打印（双面打印）。

拨号和发送 • 设置您的传真名称和传真号码。

• 调整拨号音量。

• 设置拨号方法、重拨时间、尝试重拨次数、拨号前缀和拨号音量。

设置打印机在拨打收件人号码之前或之后扫描文档原件。

如果您设置打印机在拨号之前扫描，当传真失败时您不必重新扫描文档。扫描的文档保存在打
印机内存中。打印机可以读取出来，然后自动重拨号码。

如果您设置打印机在拨号之后扫描，打印机不会自动重拨，即使电话线占线。

• 设置传真发送速度。

• 将发送的传真转换为接收传真机可以识别的模式。否则，这样的传真将会失败。

• 在发送过程中启用错误修正。
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在这里 您可以

阻止传真 阻止不希望接收的传真来电。

使用传真软件配置传真设置

在您打开传真软件并配置传真设置之前，请确认：

• 打印机正确地连接在电话线上。

• 打印机的电源已打开，并且连接在计算机上。

• 打印机没有处于省电模式。如果打印机处于省电模式，请按  按钮启动打印机。

在 Windows 中使用打印机设置向导

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “传真”选项卡 > 设置打印机进行传真

4 按照“打印机设置向导”中的指导进行操作。请确认您选择了正确的电话服务和连接。向导将会根据您的
连接配置最佳的传真设置。

注意：如果您希望配置高级传真设置，请在“打印机主页”的“传真”选项卡中单击“配置高级传真设置”。
打印机设置应用程序将会打开。

在 Macintosh（英文版）中使用 Printer Settings

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。

3 使用软件配置传真设置。

如要获取更多的信息，请单击“帮助”或  浏览有关传真软件的帮助信息。
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创建联系人列表
您可以使用打印机操作面板上的通讯簿或传真软件中的电话簿创建联系人列表。如果您在打印机操作面板上创
建了联系人列表，传真软件将会自动将这些联系人保存为“电话簿”记录。同样，当您在传真软件中添加联系
人时，打印机也会自动将它们保存到打印机通讯簿中。

您最多可以在联系人列表中保存 89 个联系人和 10 个传真群组。

使用打印机操作面板创建联系人列表

1 从主界面中依次选择：

 > 通讯簿

2 如要添加联系人：

a 依次选择：

添加联系人 > 添加联系名称

b 输入联系名称，然后触摸“确定”。

c 触摸“添加传真号码”。

d 输入联系人的传真号码，然后触摸“接受”。

e 再次触摸“接受”。

f 如果您希望添加其他的记录，请重复步骤 a-e。

3 如要添加传真群组：

a 依次选择：

添加组 > 添加群组名称

b 输入群组名称，然后触摸“确定”。

c 触摸“添加群组成员”，然后选择您希望手动添加联系人还是导入联系人：

• 通讯簿 — 从通讯簿中导入联系人。

• 历史记录 — 从传真历史记录中导入联系人。

• 新建记录 — 添加新的联系人。

d 每一次您导入联系人或添加联系人之后，请触摸“接受”保存记录。

使用传真软件创建联系人列表

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “传真”选项卡 > 编辑联系人列表

打印机设置应用程序的“联系人”选项卡将会出现。

4 依次选择：从电话簿中选择 > 选择您的电话簿
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5 选择您希望添加的联系人，然后单击“添加到列表或改变列表”导入联系人。

注意：如要添加联系人，您需要从传真软件支持的您的计算机上的通讯簿中导入联系人。除了软件通讯簿
以外，可能还有您的计算机上安装的本地邮件客户端软件（例如 Microsoft Outlook）的电话簿。

6 单击“确定”。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。

3 单击 Contacts 选项卡。

• 如要添加联系人，请单击 Individuals 选项卡。

• 如要添加传真群组，请单击 Groups 选项卡。

4 单击  打开通讯簿。

注意：如要添加联系人，您需要从您的 Macintosh 计算机上的通讯簿中导入联系人。如果联系人不在 Mac
通讯簿中，请先将联系人添加到通讯簿中，然后再导入。

5 在通讯簿中单击您希望添加的联系人，然后将它拖动到 Contacts 列表中。

如要获取更多的信息，请单击“帮助”或  浏览有关传真软件的帮助信息。

发送传真

扫描仪玻璃

将文档原件或照片正面朝下放置在扫描仪玻璃上。当您在扫描仪玻璃上放置小介质时，请使用扫描仪夹子。

发送传真提示

在您发送传真之前：

• 请确认打印机的电源已打开，并且连接在可用的电话线、DSL 或 VoIP 线上。如果您可以听到拨号音，说
明线路可以使用。

• 当使用扫描仪玻璃时，请关闭扫描仪顶盖，以避免扫描结果中出现黑边。

• 在扫描仪玻璃的右下方查找放置角落。它可以作为正确放置文档的指导。
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• 如要进行即时预览扫描，请将文档原件或照片放置在扫描仪玻璃上，然后关闭扫描仪顶盖。

• 如要最好地使用打印机的扫描功能，请使用位于扫描仪玻璃上方的扫描仪夹子将照片、卡片或其他小介质
保持在固定位置。

使用打印机操作面板发送传真

1 装入文档原件。

“即时预览”主界面将会出现。

2 触摸“传真”。

3 发送传真：

如要将传真发送给单个收件人：

a 输入传真号码，或者触摸“通讯簿”或“历史记录”导入联系人。

b 触摸 。

如要将传真发送给多个收件人（群组传真）：

a 触摸“传真给多个人”，然后触摸“添加号码”。

b 输入传真号码，或者触摸“通讯簿”或“历史记录”导入联系人。重复此步骤，直到所有收件人号码都
输入完毕。

添加每一个收件人之后请触摸“接受”。

c 触摸 。

警告—可能的损坏：当正在发送传真时，请不要触摸电缆或  和  插口。

提示：

• 您最多可以发送群组传真给 30 个收件人。

• 触摸“更多选项”可以设置彩色或黑白传真、调整传真的质量、设置文档的尺寸、添加封面页、定时传真
或查看准备发送的传真。

使用传真软件发送传真

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。
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3 依次选择：

打印机主页 > 选择您的打印机 > “传真”选项卡 > 发送传真

4 单击“发送新的传真”。

“发送传真”向导将会出现。

5 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择您的打印机的传真版本。

注意：如要在 Print 对话框中看到传真选项，您必须使用您的打印机的传真驱动程序。如果打印机的传真
版本不在列表中，请单击 Add a printer，然后选择打印机的传真版本。

3 输入收件人的姓名和号码。

4 单击 Fax。

接收传真

接收传真提示

当您接收传真时：

• 请确认打印机的电源已打开，并且连接在可用的电话线、DSL 或 VoIP 线上。如果您可以听到拨号音，说
明线路可以使用。

• 如果您设置打印机手动接收传真（自动应答关），请确认铃声音量没有设置为“关”。

• 如果您设置打印机自动接收传真（自动应答开），请在打印机内装入纸张。

自动接收传真

1 请确认“自动应答”已启用：

a 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 自动应答

b 如果“自动应答”没有设置为“开”，请触摸开”，然后触摸“接受”。

2 设置打印机应答传真来电之前的铃响数目：

a 触摸“何时应答”。

b 设置铃响数目，然后触摸“接受”保存设置。

当检测到设定数目的铃响之后，打印机开始自动接收传真。

警告—可能的损坏：当正在接收传真时，请不要触摸电缆或  和  插口。
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提示：

• 如果打印机和其他模拟设备（电话机、电话答录机）共用电话线，请设置打印机比电话答录机多 2 声铃响
应答来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在
这种情况下，电话答录机首先应答来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上
的传真信号并接管来电。如果打印机使用的是专用传真线路，您可以设置打印机在任意数目的铃响之后应
答来电。

• 如果您在一条电话线上有多个号码，或者您申请了您的电话公司提供的特色铃声服务，请确认您为打印机
设置了正确的特色铃声模式。否则，即使您设置了打印机自动接收传真，打印机也不会接收传真。

手动接收传真

1 请确认“自动应答”已禁用：

a 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 自动应答

b 如果“自动应答”没有设置为“关”，请触摸关”，然后触摸“接受”。

2 当电话铃响，并且您接听电话听筒时听到了传真信号，请按打印机上的  按钮，或者在连接在打印机上的
电话机上按*9*键。

注意：手动应答传真的默认代码为*9*，但是为了提高安全性，您可以将它改变为只有您知道的数字。您
最多可以输入 7 个字符。有效的字符包括数字 0--9 和以下符号：#和*。

警告—可能的损坏：当正在接收传真时，请不要触摸电缆或  和  插口。

传真常见问答

如果我跳过了初始传真设置，我需要重新运行安装程序并设置打印机进行传真
吗？

您不需要重新运行安装程序。您可以使用随同打印机软件一起安装的传真软件设置和配置打印机进行传真。

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “传真”选项卡 > 设置打印机进行传真

“打印机设置向导”将会出现。

4 按照向导中的指导进行操作。请确认您选择了正确的电话服务和连接。向导将会根据您的连接配置最佳的
传真设置。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Printer Settings。
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3 配置传真设置。

什么是分线器？我应该使用什么类型的分线器？

如果您家中的墙壁电话线插座数量有限，或者您的适配器上的插口数量有限，您可以使用电话分线器。分线器
可以将电话信号分成几部分，允许您在墙壁电话线插座上连接多个设备。分线器上有两个或多个插口，您可以
将设备连接在插口上。请不要使用线路分线器。

如要确认您使用的是正确的分线器，请将一部模拟电话机连接在分线器上，然后收听拨号音。

什么是我的传真号码？

大多数情况下，您的电话号码也就是您的传真号码。如果您申请了电话公司提供的特色铃声模式检测(DRPD)
服务，则您的传真号码是您为打印机指定的号码。请确认您在传真软件或打印机操作面板的“传真设置”菜单
中为此号码输入了正确的特色铃声模式。

如果您有多条电话线，请确认您输入了打印机所连接的线路的号码。

什么是我的拨号前缀？

拨号前缀是一个数字或一系列数字，您必须先按此数字，然后才可以拨打实际的传真号码或电话号码。如果打
印机位于办公室中或者连接在专用分组交换机上，您需要按一个特定的数字，然后才可以拨打外线。如果您要
向外地发送传真，则您需要输入国家代码或地区代码。如果您需要经常向同一个国家或地区发送传真，拨号前
缀功能非常有用。当您在应用程序中设置拨号前缀后，打印机会在您拨打传真号码或电话号码时自动输入前
缀。

您最多可以输入 8 个字符作为您的拨号前缀。有效的字符包括数字 0–9 和以下符号：井号(#)和星号(*)。如果
您使用传真软件输入拨号前缀，您也可以输入以下字符：加号、减号、逗号、点和圆括号。

我什么时候需要启用“自动应答”？

“自动应答”默认被设置为“开”，可以让打印机自动接收传真。

如果打印机与电话答录机连接在同一条电话线上，则您必须启用“自动应答”，以便您可以同时接收您的语音
来电和传真。请确认设置电话答录机在较少数目的铃响（与打印机设置相比）之后应答来电。这样可以让其他
设备首先应答语音来电。如果来电是传真，打印机可以在线路上检测到传真信号并应答来电。

我应该设置多少声铃响？

如果打印机和电话答录机共用电话线路，请设置打印机在较多数目的铃响之后应答来电。例如，如果电话答录
机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在这种情况下，电话答录机首先应答
来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上的传真信号并接管来电。

如果打印机使用的是专用传真线路，您可以设置打印机在您希望的任意数目的铃响之后应答来电。
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我如何为打印机设置特色铃声？

如果您申请了电话公司提供的特色铃声模式检测(DRPD)服务，设置正确的铃声是非常重要的。此功能可以允
许您在一条电话线上拥有多个电话号码。每个电话号码有指定的铃声模式（一声铃响、两声铃响、三声铃响或
两声和三声铃响）。不同的铃声模式可以让您知道拨打的是哪一个电话号码以及您应该使用哪一个设备应答来
电。

将您的电话号码之一指定给打印机作为传真号码，然后设置打印机应答该号码的铃声模式。如果铃声模式设置
不正确，打印机会响铃，但是不会接收传真。

特色铃声也称作 Ident-a-Call、Smart Ring、Teen Ring、RingMaster 和 IdentaRing。

1 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 铃声模式

2 为打印机触摸正确的铃声模式，然后触摸“接受”。

我如何检查拨号音？

拨号音可以帮助您知道电话线是否可以使用以及打印机是否正确地连接在电话线上。如果您发送和接收传真时
遇到了问题，请确认您可以在电话线上和通过打印机听到拨号音。

请确认电话线和墙壁电话线插座都可用

1 将一部模拟电话机连接在墙壁电话线插座上。

2 通过电话听筒收听拨号音。

如果您听到了拨号音，说明电话线和墙壁电话线插座可以使用。

如果您没有听到拨号音，请将模拟电话机连接在另一个墙壁电话线插座上，然后收听拨号音。如果您听到
了拨号音，说明电话线可以使用，但是第一个墙壁电话线插座不能使用。

请确认打印机正确地连接在电话线上

1 当打印机通过后面的  插口连接在电话线上时，将一部模拟电话机连接在打印机的  插口上。

2 收听拨号音。

如果您听到了拨号音，说明电话线可以使用，并且正确地连接在打印机上。

如果您通过墙壁电话线插座和打印机都没有听到拨号音，请参阅第142 页“传真问题解答注意事项”。

我如何调整打印机的扬声器音量？

收听拨号音可以检查电话线是否可以使用，并检查电缆和设备是否正确地连接在您的电话网络中。

调整拨号音量

请确认拨号音量没有设置为“关”，特别是当您使用免提拨号时。

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 拨号音量

2 选择拨号音量设置，然后触摸“接受”。
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调整铃声音量

如果您设置打印机手动接收传真，请确认您设置的铃声音量足够大，以便您能听到。

1 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 铃声音量

2 选择铃声音量设置，然后触摸“接受”。

我如何确保打印机应答传真来电，而电话答录机应答语音来电？

如要确保打印机应答传真来电，请将“自动应答”设置为“开”，然后设置打印机在较多数目的铃响之后应答
来电。例如，如果电话答录机在 4 声铃响之后应答来电，请设置打印机在 6 声铃响之后应答来电。在这种情
况下，电话答录机首先应答来电并接收您的语音来电。如果来电是传真，打印机可以检测到线路上的传真信号
并接管来电。

什么设置最适用于语音邮件服务？

如果您申请了您的电话公司提供的特色铃声服务，语音邮件和传真可以共用同一条电话线。此功能可以允许您
在一条电话线上拥有多个电话号码。每个电话号码有指定的铃声模式（一声铃响、两声铃响、三声铃响或两声
和三声铃响）。不同的铃声模式可以让您知道拨打的是哪一个电话号码以及您应该使用哪一个设备应答来电。

如果您没有特色铃声服务，请设置打印机手动接收传真（禁用“自动应答”）。此设置可以允许您同时接收语
音来电和传真来电，但是，如果您更常用语音邮件的话效果最好。每次您预期接收传真时，您都需要禁用语音
邮件。

我如何改变传真文档的分辨率？

您发送的文档的分辨率或传真质量可能会影响传真的发送。接收传真机可能不支持高分辨率，从而导致传真失
败。您可以通过启用“自动传真转换”解决此问题。请确认文档原件没有模糊不清。

如果您的高分辨率传真没有被接收，请尝试选择较低的质量。

质量 黑白分辨率 彩色分辨率

标准 200 x 100 200 x 200

精细 200 x 200 200 x 200

超精细 300 x 300 200 x 200

极精细 300 x 300（点调和） 200 x 200

1 从主界面中依次选择：

传真 > 更多选项 > 质量

2 选择分辨率，然后触摸“接受”。

我如何在预定的时间发送传真？

1 在主界面中触摸“传真”。

2 输入传真号码，或者触摸“通讯簿”导入联系人。
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3 依次选择：

更多选项 > 定时传真

4 输入您希望发送传真的时间，然后触摸“接受”。

5 触摸  保存定时传真。

打印机将会在预定的时间发送传真。在预定的时间之前，请不要关闭打印机或将打印机从电话线上断开。

我如何使用电话卡发送传真？

1 从主界面中依次选择：

传真 > 更多选项 > 拨号音

您应该可以听到电话线的拨号音。

2 输入电话卡信息，当您连接到电话运营商时，请按照提示进行操作。

3 当听到提示后，请输入收件人的传真号码，然后触摸 。

我如何知道传真是否发送成功？

您可以设置打印机在您每一次发送传真后打印确认页或发送报告。此报告包括发送传真的日期和时间。如果传
真作业不成功，则报告中也包括错误原因。

1 从主界面中依次选择：

 > 传真设置 > 报告 > 确认

2 选择打印报告选项：

• 如果您希望每一次发送传真后都打印报告，请触摸“全部”。

• 如果您希望节省墨水，只在传真作业不成功时打印报告，请触摸“出错时”。

3 触摸“接受”。

我如何查看打印机的传真历史记录？

您可以在触摸屏上查看打印机的传真历史记录。您也可以打印已发送和／或已接收传真的报告。

如要打印传真历史记录报告：

1 从主界面中依次选择：

 > 传真设置 > 报告

2 选择打印报告选项：

• 打印活动报告 — 打印发送和接收传真历史记录。

• 打印发送日志 — 只打印发送传真历史记录。

• 打印接收日志 — 只打印接收传真历史记录。
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如要在屏幕上查看传真历史记录：

1 从主界面中依次选择：

 > 传真设置 > 报告 > 在屏幕上查看历史记录

2 查看传真历史记录。

注意：触摸记录可以重拨号码或者将号码添加到通讯簿中。

我如何在纸张的双面打印传真？

1 从主界面中依次选择：

 > 传真设置 > 传真打印 > 双面传真

2 选择双面打印设置：

• 使用按钮设置 — 如果主界面中的“双面”图标被设置为“开”，传真来电将在纸张的双面进行打印。

• 总是 — 无论“双面”图标的设置是什么，传真来电都会在纸张的双面进行打印。

3 触摸“接受”。

我如何转发传真？

当您启用此选项后，所有您接收到的传真将会自动转发，直到您禁用此选项。

1 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 传真转发

2 选择“转发”或“打印并转发”，然后触摸“接受”。

3 输入您希望将传真转发到哪个号码，然后触摸“接受”。

如要禁用传真转发，请返回到“传真转发”菜单，然后选择“关”。

我如何阻止传真？

您可以阻止来自特定号码的传真。您也可以阻止垃圾传真和来自无法识别的发件人（没有来电号码的发件人）
的传真。如果您希望自动接收传真，但是希望过滤您接收的传真，此功能特别有用。

阻止来自特定号码的传真

1 从主界面中依次选择：

 > 传真设置 > 阻止传真 > 打开／关闭 > 开 > 接受

2 添加要阻止的号码。

a 依次选择：

阻止传真发件人 > 添加要阻止的号码 > 添加名称

b 输入联系名称，然后触摸“确定”。

c 触摸“添加传真号码”。

d 输入联系人的传真号码，然后触摸“接受”。

e 再次触摸“接受”。

您最多可以阻止 50 个号码。
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阻止来自无法识别的发件人的传真

从主界面中依次选择：

 > 传真设置 > 阻止传真 > 阻止无号码 > 开 > 接受

我可以找回失败的传真吗？

打印机在打印接收到的传真之前会将传真保存在打印机内存中。如果打印机在接收传真时墨水用完了或者纸张
用完了，您可以在解决错误之后继续打印传真。

但是，您无法找回由于断电而失败的传真。在这种情况下，打印机将会在下一次开机时自动打印错误报告。对
于接收的传真，错误报告可以让您知道发件人是谁以及还有多少页没有打印。对于发送的传真，错误报告可以
让您知道还有多少页没有发送。
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网络

在无线网络中安装打印机

无线网络兼容性

您的打印机包含一个 IEEE 802.11n 无线打印服务器。您的打印机可以兼容经过 Wi-Fi 认证的 IEEE 802.11
b/g/n 路由器。

可支持的网络安全性选项

打印机支持三种无线安全性选项：无安全性、WEP 和 WPA／WPA2。

无安全性

我们不推荐您在家用无线网络中根本不使用安全性。不使用安全性意味着您的无线网络范围内的所有人都可以
使用您的网络资源——包括 Internet 访问（如果您的无线网络可以连接到 Internet）。您的无线网络的范围可
能会超出您的住所的墙壁，导致在街道上或者在您的邻居家中可以访问您的网络。

WEP

WEP（有线等效加密）是最基本和最薄弱的无线安全性。WEP 安全性依靠一系列字符来实现，称为 WEP 密
钥。

无线网络中的所有设备都必须使用相同的 WEP 密钥。WEP 安全性可以用于 Ad hoc 网络和 Infrastructure 网
络。

有效的 WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。

WPA／WPA2

WPA（Wi-Fi 保护访问）和 WPA2（Wi-Fi 保护访问 2）可以提供比 WEP 更强的无线网络安全性。WPA 和
WPA2 是类似的安全性。WPA2 使用更复杂的加密方法，比 WPA 更安全。WPA 和 WPA2 都使用一系列字符
（称为 WPA 预共享密钥或密码短语）来保护无线网络，避免遭受未经授权的访问。

有效的 WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。

无线网络中的所有设备都必须使用相同的 WPA 密钥。WPA 安全性只能用于使用接入点（无线路由器）和支
持 WPA 的网卡的 Infrastructure 网络。大多数比较新的无线网络设备也可以选择使用 WPA2 安全性。

注意：如果您的网络使用 WPA 或 WPA2 安全性，当提示您选择您的网络所使用的安全性类型时，请选
择“WPA 个人”。
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打印网络设置页

网络设置页列出了您的打印机的配置设置，包括打印机的 IP 地址和 MAC 地址。

1 装入普通纸。

2 从主界面中依次选择：

 > 网络设置 > 打印设置页

在无线网络中安装打印机所需的信息

如要安装打印机以实现无线打印，您需要知道：

• 您的无线网络的名称，也称为 SSID（服务设置识别码）

• 是否使用了加密措施保护您的网络安全

• 安全密钥（WEP 密钥或 WPA/WPA2 密钥）

如要查找网络 WEP 密钥或 WPA/WPA2 密钥，请查看您的接入点（无线路由器）设置并查看安全性信息。

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字、标点符号和可以在键盘上找到的字符。WPA 密钥中的
ASCII 字符需要区分大小写。

如果您的无线网络没有使用安全措施，则您不会有安全密钥。

注意：如果您不知道您的计算机所连接的网络的 SSID，请运行计算机网络适配器的无线应用程序并查找网络
名称。如果您无法找到您的网络的 SSID 或安全信息，请参阅随同接入点一起提供的帮助文档，或者与您的系
统支持人员联系。

在无线网络中安装打印机

在您在无线网络中安装打印机之前，请确认：

• 您的无线网络已经正确安装且可以正常工作。

• 您要使用的计算机连接在您希望安装打印机的同一个无线网络中。

Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后“欢迎”界面仍然没有出现，请手动运行光盘：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 D:\setup.exe，其中 D是您的 CD 或 DVD 驱动器的盘符。

3 按照“欢迎”界面中的指导安装打印机。
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Macintosh（英文版）用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍然没有出现，请单击计算机桌面上的光盘图标。

3 双击 Install。

4 按照安装对话框中的指导安装打印机。

在其他的计算机上安装打印机

当打印机在无线网络中安装完毕后，网络中的任何计算机都可以通过无线访问此打印机。但是，您必须在所有
需要访问打印机的计算机上安装打印机驱动程序。如要安装驱动程序，您需要在每一台计算机上运行设置软
件，但是您不需要重新配置打印机。

Windows 用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后“欢迎”界面仍然没有出现，请手动运行光盘：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 D:\setup.exe，其中 D是您的 CD 或 DVD 驱动器的盘符。

3 按照计算机屏幕上的指导在新的计算机上安装已配置的打印机。

Macintosh（英文版）用户

1 关闭所有打开的软件应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍然没有出现，请单击计算机桌面上的光盘图标。

3 双击 Install。

4 选择 My printer is already set up. I am installing it on a new computer。

5 单击 Continue，然后按照计算机屏幕上的指导在新的计算机上安装已配置的打印机。

WiFi 指示符的颜色说明

Wi-Fi 指示符只能从打印机主屏幕上查看。如果没有出现主屏幕，请执行下列操作：

1 如果需要，打开打印机电源。确认它没有处于省电模式。

2 从打印机控制面板，触摸 。

Wi-Fi 指示符 打印机的网络状态

• 打印机未被连接到无线网络。

• 打印机没有经过配置，无法在无线网络中使用。

• 打印机被配置为到计算机的 Ad hoc 连接，但计算机当前已被关闭电源。
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Wi-Fi 指示符 打印机的网络状态

• 打印机不在访问点（无线路由器）的范围内。

• 打印机正在尝试与访问点通信，但是访问点可能已关闭电源或者无法正常工作。

• 访问点已经关闭电源并重新打开，并且打印机正在尝试建立与网络的通信。

• 打印机的无线设置可能不再有效。

检查打印机使用的 SSID、WEP 密钥或 WPA 密钥、安全类型和 IP 地址仍然是正确的。

• 打印机已被连接到无线网络并可以使用。

• 打印机已经通过 Ad hoc 连接到计算机。

特殊的无线安装指导

以下的指导适用于北美洲以外且使用无线宽带 box 的用户。以下是一些 box 的例子：LiveBox、AliceBox、
N9UF Box、FreeBox 和 Club Internet。

在您开始安装之前

• 请确认您的 box 具备无线功能，并且可以在无线网络中使用。有关配置 box 以便在无线网络中使用的更多
帮助信息，请参阅随同您的 box 一起提供的说明文档。

• 请确认您的 box 的电源已打开，并且您的计算机已打开并连接在您的无线网络中。

向您的无线网络中添加打印机

1 使用提供的安装指导在无线网络中安装您的打印机。

当提示您选择网络时，请停止操作。

2 如果您的 box 后面有一个关联／注册按钮，请在选择网络之前按此按钮。

注意：按关联／注册按钮之后，您有 5 分钟时间完成打印机的安装。

3 返回到计算机屏幕。

从显示的无线网络列表中选择您的网络，然后单击“继续”。

如果您的无线网络没有显示在列表中：

a 连接到其他的无线网络。

Windows 用户

单击“未列出的网络”。

Macintosh（英文版）用户

从列表中选择 Other Wireless Network，然后单击 Continue。

b 输入有关您的无线网络的详细资料。

注意：您可以从 box 的底部、随同 box 一起提供的帮助文档或者 box 的网页获得 WEP、WPA 或
WPA2 密钥。如果您已经改变了您的无线网络的密钥，请使用您创建的密钥。

4 按照计算机屏幕上的指导完成安装。

网络

100



指定静态 IP 地址

在大多数的无线网络中，打印机将会通过 DHCP 自动分配一个 IP 地址。

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。

3 打开网络浏览器，然后在地址栏中输入打印机的 IP 地址。按 Enter 键。

注意：如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开打印机网页。

4 单击“配置 > TCP/IP > 设置静态 IP 地址”。

5 在“地址”字段中输入您希望为打印机指定的 IP 地址，然后单击“提交”。

如要确认，请在网页浏览器的地址栏中输入静态 IP 地址，然后按 Enter 键。

如要获取更多的信息，请与您的系统支持人员联系。

安装后改变无线设置

如要改变打印机的无线设置（例如配置的网络和安全密钥），请根据您的操作系统选择操作：

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

4 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

高级无线设置

创建 Ad hoc 无线网络

在下列情况时，您可以设置 Ad hoc 网络：

• 没有访问点或无线路由器

• 没有无线网络（但是有用于计算机的无线网络适配器）

• 要在打印机和带无线网络适配器的计算机之间设置单独的网络
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注意：

• 在您开始之前，请确认您的无线网络适配器被正确连接到您的计算机并且工作正常。

• 设置无线网络的推荐方法是使用访问点（无线路由器）。这种网络设置被称为 Infrastructure 网络。

• 如果您的计算机有 MyWi-Fi 或  Wi-Fi Direct，那么您可以创建到无线打印机的直接连接。如需更多信息，
请参阅随计算机附带的文档。

• 打印机每次只能在一个无线网络上通信。在 Ad hoc 无线网络中配置打印机可以避免打印机在任何其他的
无线网络（Ad hoc 或 Infrastructure）中工作。

在 Windows Vista 或更高版本的操作系统中

1 单击  > 控制面板 > 网络和 Internet > 网络和共享中心。

2 单击设置连接或网络 > 设置无线 Ad-hoc（计算机到计算机）网络 > 下一步。

3 按照有关设置无线 Ad hoc 网络的指导进行操作。作为设置的一部分：

a 为计算机和打印机之间的网络创建网络名称或 SSID。

b 记录网络的名称。请确认您准确地记录了它，包括任何大写字母。

c 转到“安全类型”列表，选择 WPA2-Personal 或 WEP，然后创建 WPA 密钥或 WEP 密钥。

WPA 密钥必须是：

• 8 到 63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的符号。WPA 密钥中的
ASCII 字符需要区分大小写。

或者

• 64 个十六进制字符。十六进制字符包括 A-F、a-f 和 0-9。

WEP 密钥必须是：

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的符号。

或者

• 10 个或 26 个十六进制字符。十六进制字符包括 A-F、a-f 和 0-9。

d 记录网络的密码。请确认您准确地记录了它，包括任何大写字母。

Windows Vista 将为您启用 Ad hoc 网络。它将出现在“可用网络”下面的“连接到网络”对话中，表示计
算机被配置为 Ad hoc 网络。

4 关闭 Windows 控制面板和所有的剩余窗口。

5 插入安装软件 CD，然后按照无线安装指导进行操作。

注意：在设置软件发出指示之前，请不要连接安装或网络电缆。

6 当显示可用网络时，提供您创建的网络名称和安全信息。安装程序将配置打印机来和计算机一起使用。

7 将网络名称和安全信息的副本保存在安全的地方，以备将来使用。

注意：Windows Vista 计算机重新启动之后，您可能需要重新将它连接到 Ad hoc 网络。

在 Windows XP 中

1 单击开始 > 控制面板 > 网络和 Internet 连接 > 网络连接。

2 用鼠标右键单击您的无线网络连接的图标。

3 单击启用，如果它出现在弹出菜单中。

注意：如果出现“禁用”，说明您的无线连接已经启用了。
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4 用鼠标右键单击无线网络连接图标。

5 单击属性 > 无线网络 选项卡。

注意：如果“无线网络”选项卡没有出现，那么您的计算机有控制无线设置的第三方软件。您必须使用该
软件来设置 Ad hoc 无线网络。如需更多信息，请参阅第三方软件文档。

6 选择用 Windows 配置我的无线网络设置复选框。

7 在“首选网络”下面删除任何现有的网络。

选择一个网络，然后单击删除来从列表中删除网络。

8 单击添加来创建 Ad hoc 网络。

9 在“网络名（SSID）”框中，键入您要提供给无线网络的名称。

10 记录您选择的网络名称，以便您可以在运行无线设置的时候使用它。请确认您准确地记录了它，包括任何
大写字母。

11 如果“网络验证”出现在列表中，请选择开放式。

12 在“数据加密”列表中，选择 WEP。

13 如果需要，清除“自动为我提供此密钥”复选框。

14 在“网络密钥”框中，键入 WEP 密钥。

15 记录您选择的 WEP 密钥，以便您可以在运行无线设置的时候使用它。请确认您准确地记录了它，包括任
何大写字母。

16 在“确认网络密钥”框中，键入相同的 WEP 密钥。

17 选择这是一个计算机到计算机（特定的）网络；没有使用无线访问点。

18 单击确定两次来关闭两个打开的窗口。

19 计算机可能要花费几分钟时间来识别新设置。要检查网络状态：

a 用鼠标右键单击无线网络连接图标。

b 选择查看可用的无线网络。

• 如果网络被列出，但是计算机没有连接，请选择 Ad hoc 网络，然后单击连接。

• 如果网络没有出现，请稍等片刻，然后单击刷新网络列表。

20 插入安装软件 CD，然后按照无线安装指导进行操作。

注意：在设置软件发出指示之前，请不要连接安装或网络电缆。

21 当显示可用网络时，提供您创建的网络名称和安全信息。安装程序将配置打印机来和计算机一起使用。

22 将网络名称和安全信息的副本保存在安全的地方，以备将来使用。

在 Windows 2000 中
• 请参考随无线网络适配器附带的文档以获取有关在 Windows 2000 上配置 Ad hoc 网络的信息。

对于 Macintosh 用户

1 访问 AirPort 设置：
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在 Mac OS X 10.5 或更高的版本中

从 Apple 菜单，导览至：

系统预置 > 网络 > AirPort

在 Mac OS X 10.4 版本或更早的操作系统中

从 Finder，导览至：

应用程序 > Internet 连接 > AirPort

2 从“网络名称”或“网络”菜单，单击创建网络。

3 为 Ad hoc 网络创建一个名称，然后单击好。

注意：将网络名称和密码保存在安全的地方，以备将来使用。

向现有的 Ad hoc 无线网络中添加打印机

注意：打印机一次只能在一个无线网络中进行通讯。在 Ad hoc 无线网络中配置打印机会将打印机从所有其他
配置过的无线网络（Ad hoc 或 Infrastructure）中删除。

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

4 按照计算机屏幕上的指导进行操作。

注意：Windows Vista 计算机重新启动之后，您可能需要重新将它连接到 Ad hoc 网络中。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

使用 WPS 配置打印机以便无线使用（仅限于 Windows）
使用 Wi-Fi Protected Setup(WPS)可以轻松地将计算机或打印机添加到您的无线网络中，因为它可以自动为您
检测并配置 SSID 和 WPA 密钥。

1 请确认您的接入点（无线路由器）支持 WPS。

2 插入安装软件光盘，然后按照计算机屏幕上的指导进行操作。
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注意：

• 如果您要使用 WPS 识别码方式添加您的打印机，当要求您输入您的识别码时，请确认输入所有的 8 位数
字。

• 如要使用 WPS 配置打印机以便无线使用，您的无线网络中的所有设备都必须支持 WPS。如果您的网络
中有不支持 WPS 的设备，则您必须在出现提示时输入 SSID 和安全性信息。

在 USB 和无线连接之间转换（仅限于 Windows）
您可以根据您的需要改变访问您的打印机的方法。以下的步骤假定您已经按照一种连接类型配置了您的打印
机，并且已经在计算机上安装了打印机驱动程序。如果您在配置过程中遇到了困难，请参阅与该连接类型相关
的问题解答主题。

转换到无线连接

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

4 按照计算机屏幕上的指导进行操作。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。

转换到本地(USB)连接

1 使用 USB 电缆连接计算机和打印机。

2 稍等片刻，等待 Windows 找到驱动程序并完成安装打印机。

注意：您可以继续通过无线连接使用打印机。

在 USB 和无线连接之间转换（仅限于 Macintosh 英文版）

您可以根据您的需要改变访问您的打印机的方法。以下的步骤假定您已经按照一种连接类型配置了您的打印
机。如果您在配置过程中遇到了困难，请参阅与该连接类型相关的问题解答主题。

转换到无线连接

1 关闭所有打开的应用程序。

2 插入安装软件光盘。

如果 1 分钟之后安装对话框仍然没有出现，请单击计算机桌面上的光盘图标。

3 双击 Lexmark Extras > Lexmark Setup Assistant。

4 按照计算机屏幕上的指导配置打印机以便无线使用。

注意：在无线配置过程中，您不需要断开连接打印机和计算机的 USB 电缆。
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转换到本地(USB)连接

1 将 USB 电缆的一端连接在打印机后面的 USB 接口上。将 USB 电缆的另一端连接在计算机的 USB 接口
上。

2 添加打印机：

Mac OS X version 10.5 或更高的版本：

a 从 Apple 菜单中依次选择：

System Preferences > Print & Fax

b 单击+。

c 单击 Default 选项卡 > 选择您的打印机 > Add。

Mac OS X version 10.4 或更早的版本：

a 在 Finder 桌面上单击 Utilities。

b 双击 Printer Setup Utility 或 Print Center。

c 在 Printer List 对话框中选择您希望使用的打印机，然后单击 Add。

d 从 Printer Browser 中选择您的打印机，然后单击 Add。

3 另一个打印队列将会创建。如果您不希望改回通过无线连接访问打印机，请删除无线队列。

在 Windows 环境下共享一台打印机

1 准备好要共享打印机的计算机：

a 在所有需要进行打印的计算机上启用“文件和打印机共享”，使得这些计算机可以出现在“网上邻
居”中。请参阅 Windows 文档获取有关启用“文件和打印机共享”的指导。

b 在所有需要进行打印的计算机上安装打印机软件。

2 标识打印机：

a 在与打印机相连的计算机上，按照以下的步骤进行操作：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

b 右键单击您的打印机图标。

c 单击“共享”或“打印机属性”。

d 在“共享”选项卡中选择“共享这台打印机”或“共享为”。

e 输入一个不同于其他打印机的名称，然后单击“确定”。

3 在远程计算机上定位打印机：

注意：远程计算机是指没有直接连接打印机的计算机。

a 按照以下的步骤进行操作：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

b 右键单击您的打印机图标。
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c 单击“属性”或“打印机属性”。

d 单击“端口 > 添加端口 > Local Port > 新端口”。

e 输入符合通用命名标准(UNC)的端口名称，包括服务器名称和您在第 106 页中的步骤 2 中指定的打印
机名称。端口名称应该为以下格式：\\服务器\打印机。

f 单击“确定”。

g 在“打印机端口”对话框中单击“关闭”。

h 请确认在“端口”选项卡中选中了新添加的端口，然后单击“应用”。

i 单击“确定”。

在 Macintosh（英文版）环境下共享打印机

1 在 Finder 桌面上单击 Help > Mac Help。

2 在 Search 字段中输入 sharing the printer on a network，然后按 return 键。

3 从以下选项中只选择一项：

• 与 Mac OS X 用户共享您的打印机 — 允许网络中其他使用 Mac OS X version 10.4 或更高版本的
Macintosh 计算机使用连接在您的 Macintosh 计算机上的打印机。

• 与 Windows 用户共享您的打印机 — 允许网络中的 Windows 计算机使用连接在您的 Macintosh 计算
机上的打印机。

4 按照计算机屏幕上的指导进行操作。

注意：Windows 用户可以参阅 Windows 帮助文档获取有关添加网络打印机并连接到 Macintosh 计算机的信
息。

网络常见问答

什么是 Wi-Fi Protected Setup？
Wi-Fi Protected Setup(WPS)是一种简单且安全的配置，可以帮助您建立无线家用网络和启用网络安全性，不
需要提前了解有关 Wi-Fi 技术的知识。您不再需要为网络设备配置网络名称(SSID)和 WEP 或 WPA 密钥。

注意： WPS 只支持通过接入点（无线路由器）进行通讯的网络。

打印机支持以下方法连接到无线网络：

• 个人识别码(PIN) — 将打印机上的识别码输入到接入点的无线设置中。

• 按钮配置(PBC) — 在指定的一段时间内分别按打印机和接入点上的按钮。

查找以下的识别标记可以检查您的接入点是否兼容 WPS：

您可以在您的接入点的侧面、后面或顶部找到这些 WPS 徽标。
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如要获取更多有关读取无线设置和确定您的无线接入点的 WPS 兼容性的信息，请参阅随同接入点一起提供的
帮助文档，或者与您的系统支持人员联系。

哪里可以找到我的 WEP 密钥或 WPA 密钥？
• 与您的系统支持人员联系。

– 安装您的网络的人通常保存着 WEP 密钥或 WPA 密钥。

– 如果您的无线网络是由您的 Internet 服务供应商(ISP)安装的，您可以从他们提供的文档中查找相关的
信息。

• 参阅随同您的接入点（无线路由器）一起提供的帮助文档。

如果您的接入点使用默认设置，您可以在帮助文档中找到相关的信息。

• 在接入点上查看安全性设置。

1 打开网页浏览器，然后在地址栏中输入接入点的 IP 地址。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 密钥或 WPA 密钥与接入点的密码不同。密码可以允许您访问接入点的设置。WEP 密钥
或 WPA 密钥可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA 密钥。

什么是 SSID？

服务设置识别码 (SSID)是用于识别无线网络的一个名称。网络中的所有设备都必须知道无线网络的 SSID，否
则它们将不能互相通讯。通常，无线网络广播其 SSID 以允许区域中的无线设备连接到网络。出于安全原因，
有的时候不会广播 SSID。

如果您的无线网络的 SSID 没有广播，则无线网络不能被自动检测到并且不会出现在可用的无线网络列表中。
在这种情况下，您必须手动输入网络信息。

SSID 最多可以包含 32 个字母或数字字符。

哪里可以找到我的 SSID？
• 查看接入点（无线路由器）的设置。

大多数接入点带有内置的网络服务器，可以使用网络浏览器访问。

• 检查您的计算机是否为您的无线网络适配器安装了相应的程序。

很多网络适配器提供了软件应用程序，可以允许您查看您的计算机的无线设置，包括您的 SSID。

如果使用这些方法不能找到您的 SSID，请与您的系统支持人员联系。

什么是网络？

网络是指一组通过电缆或无线连接在一起并互相通讯的设备，例如计算机、打印机、以太网集线器、接入点和
路由器。一个网络可以是有线的、无线的、或者同时包含有线和无线设备。
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如何找到我的网络所使用的安全类型？
• 与您的系统支持人员联系。

安装您的网络的人通常保存着您的无线信息。

• 参阅随同您的接入点（无线路由器）一起提供的帮助文档。

• 检查您用于访问您的无线网络的密码所用的字符。

如果您没有使用密码，请选择“无安全性”。

字符 安全类型

10 个或 26 个十六进制字符

或者

5 个或 13 个 ASCII 字符

WEP

64 个十六进制字符

或者

8-63 个 ASCII 字符

WPA 或 WPA2

注意：

– 十六进制字符包括 A–F、a–f 和 0–9。

– ASCII 字符包括字母、数字和可以在键盘上找到的字符。

• 在接入点上查看安全性设置。

1 打开网页浏览器，然后在地址栏中输入接入点的 IP 地址。

注意：

– 如要获取接入点的 IP 地址，请参阅随同接入点一起提供的帮助文档，或者与您的系统支持人员联
系。

– 如果您使用了代理服务器，请暂时禁用代理服务器，以便正确打开网页。

2 当出现提示时，请输入接入点的用户名和密码。

注意：WEP 密钥或 WPA 密钥与接入点的密码不同。密码可以允许您访问接入点的设置。WEP 密钥
或 WPA 密钥可以允许打印机和计算机加入到您的无线网络中。

3 查找 WEP 密钥或 WPA 密钥。

家用网络如何配置？

台式电脑、便携式笔记本电脑和打印机如要在网络中互相通讯，它们必须连接电缆和／或内置或安装无线网络
适配器。

您可以使用多种不同的方法安装网络。以下是四种普通范例。

注意：下面图中的打印机代表内置了内部打印服务器的打印机，可以在网络中进行通讯。

无线网络范例

方法 1：网络中同时包含有线和无线连接，可以连接到 Internet
• 所有计算机和打印机都通过具有以太网和无线功能的路由器连接在网络中。

• 一些计算机和打印机通过无线连接在路由器上，其他计算机和打印机通过有线连接。
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• 网络通过 DSL 或电缆调制解调器连接到 Internet。

方法 2：无线网络，可以连接到 Internet
• 所有计算机和打印机都通过无线接入点或无线路由器连接在网络中。

• 无线接入点通过 DSL 或电缆调制解调器将网络连接到 Internet。

方法 3：无线网络，不可以连接到 Internet
• 计算机和打印机通过无线接入点连接在网络中。

• 网络不能连接到 Internet。
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方法 4：计算机通过无线连接到打印机，不可以连接到 Internet
• 计算机直接连接到打印机，没有通过无线路由器。

• 这种配置方法称作 Ad hoc 网络。

• 网络不能连接到 Internet。

注意：大多数计算机一次只能连接到一个无线网络。如果您通过无线连接访问 Internet，当您连接到 Ad hoc
网络时，您将无法访问 Internet。

为什么我需要安装电缆？

当在您的无线网络上设置打印机时，打印机将需要使用安装电缆暂时连接到计算机。使用此暂时连接来设置打
印机的无线设置。

我如何连接安装电缆？

安装电缆连接在计算机的 USB 接口和打印机后面的正方形接口中。此连接可以允许您为网络安装或本地连接
安装配置打印机。

1 将较大、矩形的一端连接在您的计算机的任意 USB 接口中。USB 接口可能位于计算机的前面或后面，可
能是水平的或垂直的。

网络

111



2 将较小、较方的一端连接在打印机的后面。

3 按照计算机屏幕上的指导继续操作。

Infrastructure 和 Ad hoc 网络之间有什么区别？

无线网络可以按照以下两种模式运行：Infrastructure 模式或 Ad hoc 模式

在 Infrastructure 模式下，无线网络中的所有设备都通过接入点（无线路由器）互相通讯。

在 Ad hoc 模式下，带有无线网络适配器的计算机和带有无线打印服务器的打印机直接进行通讯。

Infrastructure Ad hoc

特征

通讯 通过接入点 直接在设备之间

安全性 更多的安全选项 WEP 或无安全性

范围 取决于接入点的范围和数量 受限于网络中单个设备的范围

速度 通常较快 通常较慢

所有设备的需求

每个设备都有唯一的 IP 地址 是 是

模式设置为 Infrastructure 模式 Ad hoc 模式

相同的 SSID 是，包括接入点 是

相同的频道 是，包括接入点 是

我们推荐您使用安装软件光盘按照 Infrastructure 模式安装网络。Infrastructure 模式可以提供：

• 网络安全性较高

• 可靠性较高

• 性能较快

• 安装较简易
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查找信号强度

信号强度可以告诉您计算机或打印机从无线网络接收的无线信号有多强。较差的信号质量可能会在配置过程中
影响连接性。

检查计算机连接性

1 从您的计算机系统任务栏中单击管理您的无线网络适配器的软件所对应的无线图标。

2 检查信号质量。

检查打印机连接性

• 从打印机打印一张网络设置页。

在“无线”区域中查找“质量”。

• 从打印机操作面板上查看信号强度。

依次选择：

 > 网络设置 > 无线网络

指示信号质量的信号条显示在网络名称旁边。

如要提高信号质量，请去除干扰源和／或将无线设备移动到距离接入点（无线路由器）比较近的地方。

我能够如何改善无线信号强度？

无线打印机无法在网络上通信的一个常见原因是无线信号质量很差。如果信号太弱、太失真或被物体阻挡，它
将不能在访问点和打印机之间传递信息。如需确定打印机是否从访问点接收到强信号，请打印网络设置
页。“质量”字段指出打印机正在接收的无线信号的相对强度。但是，可能会有间歇性的信号强度衰减，并且
虽然信号质量显示为高，但它可能在某些情况下衰减。

如果您认为访问点（无线路由器）和打印机之间的信号强度有问题，请尝试下列办法中的一个或多个：

注意：

• 下面的解决办法适用于 Infrastructure 网络。如果您使用 Ad hoc 网络，请在解决办法建议调整访问点时调
整计算机。

• Ad hoc 网络的范围比 Infrastructure 网络小得多。如果打印机和计算机之间的通信有问题，请尝试移动打
印机使之更靠近计算机。

移动打印机使之更靠近访问点

如果打印机离访问点太远，它将不能与网络上的其他设备通信。对于大多数室内无线网络，访问点和打印机
之间的最大距离大约为 100 英尺（30 米）。根据网络布局和访问点的限制，此距离可以更长或更短。

移除访问点和打印机之间的障碍物

来自访问点的无线信号将通过大多数物体。大部分墙壁、地板、家具和其他物体将不会阻碍无线信号。但
是，有些材料密度太大，无法让信号通过，如包含金属和混凝土的物体。布置打印机和访问点，使信号不会
被此类物体阻碍。
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移除干扰源

其他类型的无线电频率可能会导致网络上的无线信号的问题，造成似乎来来回回的打印问题。

• 关闭可能的干扰来源。

• 当通过无线网络打印时，请避免使用微波炉、无绳电话（但除便携式电话）、婴儿监视器，几乎所有的
厨房设备，无线监视装置或含有电机的装置。

• 如果有另一个无线网络在附近运转，请更改访问点上的无线通道。

• 请勿将访问点放在打印机或其他电子设备上。此类设备也会干扰无线信号。

布置网络以减少信号吸收

即使无线信号能够通过物体，它也会稍有减弱。如果它通过太多物体，它会显著减弱。当无线信号通过物体
时，所有物体都会吸收部分无线信号，并且某些类型的物体吸收足够多而导致通信问题。将访问点尽可能放
在室内高点，以避免信号吸收。

我如何确认我的计算机和打印机连接在同一个无线网络中？

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，打
印机的 SSID 必须与计算机的 SSID 一致。

Windows 用户

1 获取计算机所连接的网络的 SSID：

a 在您的网页浏览器的地址栏中输入您的接入点（无线路由器）的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。查看“无线网络连接”区域：

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

b 当出现提示时，请输入您的用户名和密码。

c 单击“确定”。

d 在“无线设置”区域中查找 SSID。

e 记录下 SSID。

注意：请确认您准确地记录了所有的内容，包括大写字母。

2 获取打印机所连接的网络的 SSID：

a 从打印机打印一张网络设置页。

b 在“无线”区域中查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行无线设置应用程序，在计算机所使用的无线网络中安装打印机。
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使用 AirPort 基站的 Macintosh（英文版）用户

Mac OS X version 10.5 或更高的版本：

1 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

计算机所连接的网络的 SSID 将会显示在 Network Name 菜单中。

2 记录下 SSID。

Mac OS X version 10.4 或更早的版本：

1 从 Finder 中依次选择：

Applications > Internet Connect > AirPort

计算机所连接的网络的 SSID 将会显示在 Network 菜单中。

2 记录下 SSID。

使用接入点的 Macintosh（英文版）用户

1 在您的网页浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
Router（路由器）项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“无线设置”区域中查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥／WPA 密钥（如果显示的话）。

注意：

• 请确认您准确地记录了网络信息，包括大写字母。

• 将 SSID 和 WEP 密钥／WPA 密钥保存在安全的地方，以备将来使用。

我可以同时通过 USB 连接和网络连接使用我的打印机吗？

是，打印机支持同时使用 USB 连接和网络连接。打印机可以按照以下方法进行配置：

• 本地连接（使用 USB 电缆连接在计算机上）

• 无线网络

• 同时使用无线网络和本地连接

什么是 MAC 地址？

媒体访问控制(MAC)地址是与网络设备的硬件相关联的一个 48 位标识符。MAC 地址也称为物理地址，因为它
与设备的硬件有关，而与软件无关。MAC 地址使用十六进制数字显示，格式为：01-23-45-67-89-AB。
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虽然可以改变网络设备的 MAC 地址，但是通常不这样做。因此，MAC 地址被认为是固定不变的。IP 地址很
容易改变，因此 MAC 地址是识别网络中特定设备的更可靠的方法。

带有安全功能的路由器可以过滤网络中的 MAC 地址。此功能可以只允许指定的设备访问网络，由它们的 MAC
地址识别，也可以阻止来自不必要的设备的访问。如果您的网络使用了 MAC 地址过滤，请确认将打印机的
MAC 地址添加到允许设备列表中。

我如何查找 MAC 地址？

网络设备都有一个唯一的硬件识别码，用于和网络中的其他设备区分开。这称为 MAC（媒体访问控制）地
址。其他设备有时使用一种称为统一管理地址(UAA)的 MAC 地址。

当您在网络中安装打印机时，请确认您选择了带有正确 MAC 地址的打印机。

MAC 地址标签位于打印机的里面。

内部打印服务器的 MAC 地址是一系列字母和数字。

注意：

• 您可以在接入点（无线路由器）上设置一个 MAC 地址列表，只允许 MAC 地址相符的设备使用网络。这
称为 MAC 过滤。如果您在您的接入点上启用了 MAC 过滤功能，并且希望将一台打印机添加到网络中，
打印机的 MAC 地址必须包含在 MAC 地址列表中。

• 如果您使用 AirPort 基站，MAC 地址可能称为 AirPort ID，MAC 地址过滤可以通过 MAC 地址访问控制来
实现。

什么是 IP 地址？

IP 地址是 IP 网络中的设备（例如无线打印机、计算机或无线接入点）所使用的一个唯一的号码，用于互相定
位和通讯。只有当 IP 网络中的设备有唯一且有效的 IP 地址时，设备之间才可以互相通讯。唯一的 IP 地址表
示在同一个网络中不会有两个设备有相同的 IP 地址。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.100.110。

网络

116



什么是 TCP/IP？
网络可以正常工作是因为计算机、打印机和其他设备可以通过电缆或者使用无线信号互相发送数据。一组称为
协议的数据传输规则可以使这种数据传输成为可能。协议可以被看作是一种语言，并且和语言类似，它有一定
的规则以允许参与者互相通讯。

不同类型的网络使用不同的协议，但是传输控制协议/网际协议(TCP/IP)是最常用的。TCP/IP 用于在互联网和
大多数公司和家庭网络中发送数据。

由于计算机不能理解文字，只能依靠数字进行通讯，因此 TCP/IP 要求网络中所有使用 TCP/IP 进行通讯的设
备必须有一个 IP 地址。IP 地址实际上是数字格式的唯一的计算机名称，用于在网络中传输数据。IP 地址可以
允许 TCP/IP 确保网络中的各种设备正确请求和接收数据。

我如何查找 IP 地址？

Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.0.100。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac > More Info

2 在 Contents 区域中单击 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

查找打印机的 IP 地址

• 从打印机打印一张网络设置页。

在 TCP/IP 区域中查找“地址”。

• 查看打印机设置。

1 在打印机操作面板上依次选择：

 > 网络设置 > TCP/IP

2 查找“IP地址”。

IP 地址是如何指定的？

IP 地址可能由网络使用动态主机分配协议(DHCP)自动指定。当打印机在计算机上安装完毕后，计算机将会把
所有的打印作业按照此地址通过网络发送到打印机。

如果 IP 地址没有自动指定，在无线设置过程中，当您从可用的列表中选择您的打印机之后会要求您手动输入
地址和其他的网络信息。
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什么是密钥索引？

一个接入点（无线路由器）最多可以配置 4 个 WEP 密钥。但是，每一次在网络中只使用一个密钥。密钥带有
一个编号，密钥的编号就是密钥索引。当接入点上配置了多个 WEP 密钥时，无线网络中的所有设备都必须使
用相同的密钥索引。

在您的打印机上选择您在接入点上使用的同一个密钥索引。
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使用 SmartSolutions

什么是 SmartSolutions？
SmartSolutions 是一套解决方案，您可以在 SmartSolutions 网站上（http://smartsolutions.lexmark.com）
创建、定制并下载到您的打印机上。它可以帮助您创建一次触摸自定义解决方案，以简化重复性的复印、扫描
和打印任务。SmartSolutions 也可以帮助您在打印机操作面板上浏览 RSS 传送、Google 日历、新闻标题和
网上相册。

如要使用您创建或定制的解决方案，请在打印机操作面板上触摸“SmartSolutions”，然后选择解决方案的
图标或名称。

以下是一些可能可以使用的解决方案；请确认访问 SmartSolutions 网站获取更新的列表。

预载入解决方案

使用 您可以

ID 卡复印 在一张纸上复印 ID 卡的两面。

照片重印 创建照片重印。

告诉我更多 了解更多有关 SmartSolutions 以及您如何创建和下载您的自定义解决方案的信息。

自定义解决方案

解决方案 说明

A5 复印

Legal 复印

适合页面复印

从自动文档传送器复印 A5 或 Legal 尺寸的文档，或者使用“适合页面
复印”解决方案自动调整您的复印结果的大小，使它适合整个页面。

名片扫描

（仅限于 Windows）

最多可以同时扫描 8 张名片，并且和您当前的联系人管理应用程序同
步，以便读取每一张扫描的名片的信息。

查找打印墨盒 浏览您可以购买打印墨盒的本地商店信息，您可以选择打印或通过电子
邮件发送打印墨盒和零售商信息并打印一张零售商位置地图。

可定制复印

黑白复印

加深复印

使用黑白、深色调或使用自定义设置复印文档或照片。

双面复印 通过将两页文档复印在一张纸的两面使您的纸张消耗减半。

经济复印 使用对环境有正面影响的设置复印文档或照片。

Google 日历* 浏览您的 Google 日历，您可以选择打印每天的日程或事件详细信息。

MobileMe 照片*

照片浏览器*

Photobucket Viewer*

Picasa Photo Viewer*

浏览网站中的照片（例如 MobileMe、Photobucket 和 Picasa），您可
以选择打印所选的照片，或者通过电子邮件发送所选照片的链接。

* 您可以选择这些解决方案中的一个作为您的打印机的屏幕保护界面。
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解决方案 说明

打印文件

（仅限于 Windows）

预览和复印

使用打印机打印或预览以前在解决方案中心里选择的保存在您的计算机
上或外部存储设备中的文档文件。

RSS 标题*

Apple 热点新闻*

MSNBC 标题*

浏览新闻标题、文章摘要和其他传送内容，您可以选择通过电子邮件将
完整的文章发送给您，或者在计算机上打开文章进行浏览。

扫描至电子邮件 使用通讯簿中预先定义的名称或联系人直接从打印机通过电子邮件发送
扫描的文档。

扫描到 Evernote 扫描文档到您的 Evernote 账号，一个适用于您的照片、文档、想法和观
念的在线组织。

扫描至传真 使用通讯簿中预先定义的名称或联系人直接从打印机传真文档。

扫描照片

扫描至文件

使用预先定义的设置扫描文件或照片并保存在之前选择的计算机文件夹
中。

扫描至 PDF

（仅限于 Windows 和 Macintosh 英文版）

扫描文档并以 PDF 格式保存在您的计算机上。

Stamps.com 运输 购买和打印 US Postal Service 国内运输标签，您可以选择信封类型、您
的包裹重量和交货方法。

* 您可以选择这些解决方案中的一个作为您的打印机的屏幕保护界面。

范例：

• 如果您是一位公司所有者或主管，需要经常打印工作日程表，您可以创建一个“打印文件”解决方案。指
定您的日程表文件的位置，然后将解决方案命名为“打印日程表”。下一次您需要打印当前的日程表时，
您只需从打印机操作面板的“SmartSolutions”菜单中选择“打印日程表”。打印机将会自动找到并打印
文件。

• 如果您经常使用相同的设置扫描文档并传真给您的律师，您可以创建一个“扫描至传真”解决方案，并将
它命名为“传真给律师”。下一次您希望传真文档时，您只需装入文档原件，然后从打印机操作面板上
的“SmartSolutions”菜单中选择“传真给律师”。打印机将会自动使用您预先选择的设置，选择您的律
师作为传真收件人，然后发送传真。

注意：您需要将您的打印机添加到解决方案中心里，然后才可以开始创建或定制解决方案。

创建和定制打印机解决方案
在您开始操作之前，请确认：

• 您的打印机和计算机通过以太网或无线网络连接在 Internet 中。

• 您的打印机的电源已打开。

1 访问 SmartSolutions 网站：

使用打印机软件
a 打开打印机程序文件夹：
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Windows 用户
1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

Macintosh（英文版）用户
1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Web Links。

b 单击 Visit Lexmark SmartSolutions。

使用网页浏览器
a 打开网页浏览器。

b 在地址栏中输入 smartsolutions.lexmark.com，然后按 Enter 键。

2 在 SmartSolutions 网站上登录或创建一个账号。

3 添加您的打印机。

4 使用网站创建、定制解决方案并下载到您的打印机上。

如要获取更多的信息，请参阅网站中的 SmartSolutions 用户手册。
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维护打印机

维护打印墨盒
除了以下您可以完成的任务以外，如果您的打印机连接在电源插座上，每周将会执行一次自动维护操作。打印
机将会暂时退出节约能源模式，或者临时打开电源（如果电源已关闭）。

查看墨水量

使用打印机操作面板

在主界面中触摸 。

墨水量图像将会出现在显示屏上。

使用打印机软件

Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “维护”选项卡 > 查看墨水量

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

System Preferences > Print & Fax > 选择您的打印机

2 单击 Options & Supplies 或 Print Queue。

3 单击 Supply Levels。

校正打印头

如果您打印的图像中的字符或线条出现锯齿状或波浪状，您可能需要校正打印头。

使用打印机操作面板

1 装入普通纸。

2 从主界面中依次选择：

 > 更多选项 > 校正打印机

打印机将会打印出一张校正测试页。

注意：请不要移开校正测试页，直到打印完成。
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使用打印机软件（仅限于 Windows）

1 装入普通纸。

2 单击  或“开始”。

3 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

4 依次选择：

打印机主页 > 选择您的打印机 > “维护”选项卡 > 校正打印墨盒

5 按照计算机屏幕上的指导进行操作。

如果您是为了提高打印质量而校正打印墨盒，请重新打印您的文档。如果打印质量没有提高，请清洗打印墨盒
喷头。

清洗打印头喷头

打印质量差有时候是由打印头喷头堵塞引起的。清洗打印头喷头可以提高您的打印质量。

注意：

• 清洗打印头喷头将会使用墨水，因此请只在必要的时候进行清洗。

• 深度清洗将会使用更多的墨水，因此请首先尝试“清洗打印头”选项，以便节省墨水。

• 如果墨水量太低了，您必须先更换打印墨盒，然后才可以清洗打印头喷头。

使用打印机操作面板

从主界面中依次选择：

 > 更多选项 > 清洗打印头或深度清洗打印头

打印机将会打印出一张清洗测试页。

使用打印机软件（仅限于 Windows）

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “维护”选项卡 > 清洗打印墨盒

4 按照计算机屏幕上的指导进行操作。

清洗打印机的外壳
1 请确认打印机的电源已关闭，并且已从电源插座上断开。

当心—电击危险：当清洗打印机的外壳时，为了避免电击危险，请在操作之前从电源插座上断开电源
线，并断开打印机上的所有电缆。

2 从打印机内取出所有的纸张。

3 用水将一块干净且不掉毛的软布润湿。

警告—可能的损坏：请不要使用普通家用的清洁剂或去污剂，因为它们可能会损坏打印机的表面涂层。

维护打印机
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4 请只清洗打印机的外面，并确认擦掉出纸托盘上的墨迹。

警告—可能的损坏：使用湿布清洗打印机的内部可能会损坏您的打印机。

5 在开始新的打印作业之前，请确认打印机完全干燥。

擦洗扫描仪玻璃
1 用水将一块干净且不掉毛的软布润湿。

2 轻轻地擦洗扫描仪玻璃。

注意：在您将文档放置在扫描仪玻璃上之前，请确认文档上的墨水或修正液已经完全干燥。

清洗触摸屏
随同您的打印机一起提供了一块触摸屏清洁布，可以用于清除触摸屏上的指纹和污迹。

1 请确认打印机的电源已关闭，并且已从电源插座上断开。

当心—电击危险：当清洗触摸屏时，为了避免电击危险，请在操作之前从电源插座上断开电源线，并
断开打印机上的所有电缆。

2 使用随同您的打印机一起提供的触摸屏清洁布或者其他干净、干燥且不掉毛的布擦拭触摸屏。

警告—可能的损坏：请不要使用液体、普通家用清洁剂或去污剂，因为它们可能会损坏触摸屏。

维护打印机
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问题解答

在您解决问题之前
使用这些注意事项可以解决大多数打印机问题：

• 确保电源线的一端连接在打印机上，另一端连接在正确接地的电源插座上。

• 确保打印机的电源已打开。

• 确保打印机牢固地连接在主计算机、打印服务器或其他网络接入点上。

• 检查打印机是否有错误信息，并解决错误。

• 检查是否有卡纸信息，并清除卡纸。

• 检查打印墨盒，如有必要，请安装新的打印墨盒。

• 关闭打印机的电源，等待大约 10 秒钟，然后重新打开打印机。

注意：确保打印机没有处于省电模式。按住 按钮 3 秒钟将会关闭打印机。

• 使用“服务中心”查找并解决问题（仅限于 Windows）。

使用服务中心解决打印机问题
服务中心为您提供了逐步的问题解答帮助，并包含有关打印机维护任务和客户支持的链接。

如要打开服务中心，您可以使用以下的方法：

方法 1 方法 2

如果错误信息对话框中包含“如要获取其他的帮
助，请使用服务中心”链接，请单击此链接。

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机
程序文件夹。

3 依次选择：

打印机主页 > “支持”选项卡 > 服务中心

如果问题解答没有解决您的问题
访问我们的国际互联网站 http://support.lexmark.com 查找以下内容：

• 包含有关您的打印机的最新信息和问题解答信息的知识库文章

• 在线技术支持

• 电话技术支持的联系号码

安装问题解答
• 第126 页“显示屏上的文字是错误的语言”

• 第126 页“打印头错误”

• 第127 页“软件不能安装”

• 第129 页“打印作业不打印或者缺页”

问题解答
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• 第131 页“打印机打印出空白页”

• 第131 页“打印机忙或者没有反应”

• 第132 页“无法从打印队列中删除文档”

• 第132 页“无法通过 USB 进行打印”

显示屏上的文字是错误的语言

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的方法：

使用打印机菜单改变语言

1 从主界面中依次选择：

 > 设备设置 > 语言

2 选择语言，然后触摸“接受”。

3 触摸“是”确认此设置。

打印头错误

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的方法：

取出并重新安装打印头

1 打开打印机的前盖，然后打开打印头窗口盖。

2 向前拉保护盖，然后取出打印头。

问题解答

126



3 使用一块干净且不掉毛的布擦洗打印头触点。

警告—可能的损坏：请不要触摸打印头喷头。

4 重新装入打印头，然后向后推保护盖，直到固定住。

5 关闭打印头窗口盖，然后关闭前盖。

注意：如果取出并重新安装打印头不能解决错误，请联系用户支持。

软件不能安装

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没
有出现在打印机选项中，您可以尝试反安装并重新安装软件。

在您重新安装软件之前，请完成以下操作：

请确认您的计算机满足最小系统需求

在安装软件之前暂时关闭 WINDOWS 安全程序

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。
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重新连接打印机电源

1 关闭打印机的电源。

注意：请确认打印机没有处于省电模式。按住  按钮 3 秒钟将会关闭打印机。

2 从电源插座上断开电源线，然后从电源适配器上断开电源线。

3 翻转打印机并露出打印机的底部，然后滑动电源适配器盖板。

注意：请确认关闭了打印机的扫描仪顶盖和前盖。

4 按电源适配器锁定按钮。

问题解答
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5 从打印机上取下电源适配器，然后重新安装，直到固定住。

6 重新插入电源适配器盖板。

7 将电源线重新连接在电源适配器上，然后将另一端连接在电源插座上。

8 打开打印机的电源。

打印作业不打印或者缺页

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印墨盒安装正确

1 打开打印机的电源，然后打开打印机的前盖。

2 请确认打印墨盒安装正确。

打印墨盒应该牢固地固定在打印头上相应颜色的槽中。

3 关闭前盖。

在您发送打印作业之前，请在“打印”对话框中选择您的打印机

注意：此方法只适用于 Macintosh（英文版）用户。

1 打开文档，从应用程序中单击 File > Print。

2 从 Printer 弹出菜单中选择您的打印机，然后单击 Print。

如果您的打印机没有出现在 Printer 列表中，请选择 Add Printer。从 Default 选项卡的打印机列表中选
择您的打印机，然后单击 Add。
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如果您的打印机没有出现在列表中，请尝试以下的方法：

• 对于 USB 连接的打印机，请断开并重新连接 USB 电缆。

• 对于无线连接的打印机，请参阅“无线问题解答”章节。

请确认打印作业没有被暂停

请确认您的打印机被设置为默认打印机

重新连接打印机电源

1 关闭打印机的电源。

注意：请确认打印机没有处于省电模式。按住  按钮 3 秒钟将会关闭打印机。

2 从电源适配器上断开电源线。

3 等待 1 分钟，然后将电源线重新连接在电源适配器上。

4 打开打印机的电源。

断开并重新连接您的打印机上的 USB 电缆

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

问题解答
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3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

反安装并重新安装打印机软件

打印机打印出空白页

空白页可能是由不正确地安装打印墨盒所引起的。

重新安装打印墨盒并深度清洗和校正打印头

1 重新安装打印墨盒。请参阅第 14 页“更换打印墨盒”获取更多的信息。

如果打印墨盒看起来不太合适，请确认打印头安装正确，然后重新尝试安装打印墨盒。

2 装入普通纸。

3 从主界面中依次选择：

 > 更多选项 > 深度清洗打印头

打印机将会打印出一张清洗测试页。

4 依次选择：

 > 更多选项 > 校正打印机

打印机将会打印出一张校正测试页。

注意：请不要移开校正测试页，直到打印完成。

打印机忙或者没有反应

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认打印机没有处于省电模式

如果电源指示灯缓慢闪烁，说明打印机处于省电模式。请按  按钮启动打印机。

如果打印机没有退出省电模式，请重新启动电源：

1 从电源插座上断开电源线，然后等待 10 秒钟。

2 将电源线重新连接在电源插座上，然后打开打印机的电源。

如果此问题仍然存在，请访问我们的网站，尝试升级您的打印机软件或固件。

问题解答

131



重新连接打印机电源

1 关闭打印机的电源。

注意：请确认打印机没有处于省电模式。按住按钮 3 秒钟将会关闭打印机。

2 从电源适配器上断开电源线。

3 等待 1 分钟，然后将电源线重新连接在电源适配器上。

4 打开打印机的电源。

无法从打印队列中删除文档

如果您的作业滞留在打印队列中无法删除，导致其他的作业不能打印，计算机和打印机可能无法进行通讯。

重新启动计算机并重新尝试

断开并重新连接您的打印机上的 USB 电缆

无法通过 USB 进行打印

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。
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3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

请确认 WINDOWS 中的 USB 端口已启用

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 devmgmt.msc。

3 按 Enter 键，或者单击“确定”。

设备管理器将会出现。

4 单击“通用串行总线控制器”旁边的加号(+)。

如果您看到 USB Host Controller 和 USB Root Hub 列在其中，说明 USB 端口已经正确启用。

请参阅计算机的相关文档获取更多的信息。

反安装并重新安装打印机软件

卡纸和进纸错误问题解答
• 第133 页“打印机内发生卡纸”

• 第135 页“双面打印部件内发生卡纸”

• 第136 页“纸张或特殊介质进纸错误”

打印机内发生卡纸

注意：打印机内部的部件非常敏感。当清除卡纸时请避免不必要地触摸这些部件。

1 关闭打印机的电源，然后从电源插座上断开电源线。

注意：请确认打印机没有处于省电模式。按住  按钮 3 秒钟将会关闭打印机。

2 检查打印机的以下部件是否发生了卡纸：

• 纸张支架

问题解答
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如有必要，当清除小介质卡纸时请取下纸张支架。

• 出纸托盘

• 打印头保护门

如要检查打印头保护门，请首先打开前盖。

3 牢固地抓住纸张，然后轻轻地拉出。

注意：拉出纸张时请小心不要撕破纸张。
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4 如有必要，请重新安装纸张支架，或者关闭打印头保护门，然后关闭前盖。

5 按  按钮重新打开打印机。

双面打印部件内发生卡纸

注意：打印机内部的部件非常敏感。当清除卡纸时请避免不必要地触摸这些部件。

1 按下锁定按钮并拉出双面打印部件。

当心—可能的伤害：双面打印部件后面的区域带有突出的棱角（纸张通道的一部分）。为了避免受
伤，当您为了清除卡纸而接触此区域时，请特别小心。

2 牢固地抓住纸张，然后轻轻地拉出。

注意：拉出纸张时请小心不要撕破纸张。

问题解答
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3 重新装入双面打印部件。

4 触摸“确定”。

纸张或特殊介质进纸错误

如果纸张或特殊介质进纸不正常、扭曲、同时进多页纸或者粘在一起，以下是可能的解决方法。请尝试其中的
一种或多种方法：

检查纸张条件

请只使用新的且没有皱褶的纸张。

检查纸张装入
• 请在打印机内装入较少数量的纸张。

• 装入纸张时请确认可打印的一面朝上。（如果您不确定哪一面可打印，请参阅随同纸张一起的指导。）

• 请参阅针对您的纸张和特殊介质的详细装纸指导。

随时移开打印机送出的打印页

调节进纸导轨以适合装入的纸张

打印问题解答
• 第136 页“打印页边缘处的打印质量非常差”

• 第137 页“打印的图像中出现条纹或线条”

• 第138 页“打印速度慢”

• 第138 页“当打印时计算机速度变慢”

打印页边缘处的打印质量非常差

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：
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检查最小打印设置

除非您使用无边界功能，否则请使用以下的最小打印边距设置：

• 左边距和右边距：

– Letter 尺寸的纸张：6.35 毫米（0.25 英寸）

– 除 Letter 以外的所有其他纸张：3.37 毫米（0.133 英寸）

• 上边距：1.7 毫米（0.067 英寸）

• 下边距：12.7 毫米（0.5 英寸）

选择无边界打印功能

Windows 用户

1 打开照片，从应用程序中单击“文件 > 打印”。

2 单击“属性”、“首选项”、“选项”或“设置”。

3 依次选择：

“打印设置”选项卡 > “纸张选项”区域 > 选中“无边界”

Macintosh（英文版）用户

1 打开照片，从应用程序中单击 File > Page Setup。

2 从 Format for 弹出菜单中选择您的打印机。

3 从 Paper Size 弹出菜单中选择名称中带有“(Borderless)”的纸张尺寸。

例如，如果您装入了 4 x 6 照片卡，请选择 US 4 x 6 in (Borderless)。

4 单击 OK。

5 从菜单栏中单击 File > Print。

6 从 Printer 弹出菜单中选择您的打印机。

7 从打印选项弹出菜单中选择 Quality & Media。

8 从 Paper Type 弹出菜单中选择纸张类型。

9 从 Print Quality 弹出菜单中选择 Best 或 Photo。

10 单击 Print。

打印的图像中出现条纹或线条

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

查看墨水量

更换墨水量偏低或空的打印墨盒。

在打印机软件中选择较高的打印质量

问题解答
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请确认打印墨盒安装正确

校正打印头

清洗或深度清洗打印头喷头

注意：如果这些方法不能去除打印的图像中的条纹或线条，请联系技术支持。

打印速度慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

在打印机软件中选择较低的打印质量

手动选择您使用的纸张类型

反安装并重新安装打印机软件

提高计算机处理速度
• 请关闭所有不用的应用程序。

• 尽量减小文档中照片和图像的数量和尺寸。

为计算机增加内存

考虑升级内存(RAM)。

当打印时计算机速度变慢

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

检查打印机和计算机之间的 USB 连接

如果您的计算机通过 USB 电缆连接在打印机上，请尝试使用不同的 USB 电缆。

刷新您的网络连接

1 如果您的计算机连接在以太网或无线网络中，请关闭接入点（无线路由器）的电源，然后重新打开。

2 等待 1 分钟，让打印机和计算机重新建立连接。

请关闭所有不用的应用程序

在您的计算机上临时关闭不用的应用程序或结束占用太多内存的进程。

检查您的计算机性能

您可能需要改变您的计算机如何管理资源和进程。

问题解答
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如要获取更多有关提高计算机性能的帮助信息，请参阅您的操作系统的帮助文档。

复印和扫描问题解答
• 第139 页“打印机不能复印或扫描或者没有反应”

• 第139 页“扫描仪部件没有关闭”

• 第139 页“复印或扫描的质量非常差”

• 第140 页“文档或照片只复印或扫描了一部分”

• 第140 页“扫描不成功”

• 第141 页“扫描任务花费很长的时间或者导致死机”

• 第141 页“无法通过网络扫描至计算机”

打印机不能复印或扫描或者没有反应

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

将您的打印机设置为默认打印机

反安装并重新安装打印机软件

扫描仪部件没有关闭

1 打开扫描仪顶盖。

2 取出所有导致扫描仪部件打开的堵塞物。

3 关闭扫描仪顶盖。

复印或扫描的质量非常差

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

擦洗扫描仪玻璃

调整扫描质量

浏览有关复印和扫描的提示以提高打印质量

使用更清晰的文档或图像原件

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于正确的角落

问题解答
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文档或照片只复印或扫描了一部分

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

请确认文档或照片正面朝下放置在扫描仪玻璃上，并且位于放置角落

选择您装入的纸张尺寸

请确认“原件尺寸”设置与您要扫描的文档尺寸一致

扫描不成功

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏，请换用新电缆。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁标有 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

重新启动计算机

通过“编辑设备列表”对话框添加网络打印机

如果您要从网络打印机进行扫描，请使用“编辑设备列表”对话框添加该打印机。有关更多信息，请查
看“编辑设备列表帮助”：

1 打开“扫描中心”应用程序后，从“设备”弹出菜单中选择浏览设备。

2 在显示的“编辑设备列表”对话框中单击 。

请确保在“SCAN CENTER”的“GENERAL”选项卡中选中了“ENABLE NETWORK

SCAN TO COMPUTER”（仅限于 MACINTOSH）

注意：

• 仅 Mac OS X version 10.6 提供该选项。

• 如果您打开了多个应用程序，那么请确保“Scan Center”应用程序处于活动状态。否则，系统不会显
示正确的菜单栏。

从菜单栏中依次选择：

Scan Center > Preferences > General 选项卡

问题解答
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扫描任务花费很长的时间或者导致死机

如果“在您解决问题之前”注意事项没有解决问题，请尝试以下的一种或多种方法：

关闭其他不用的应用程序

重新启动计算机

无法通过网络扫描至计算机

如果“在您解决问题之前”注意事项无法帮助您解决问题，请尝试以下的一种或多种方法：

请确保打印机和目的地计算机连接到同一网络

请确保目的地计算机上装有打印机软件

请确保在“SCAN CENTER”的“GENERAL”选项卡中选中了“ENABLE NETWORK

SCAN TO COMPUTER”（仅限于 MACINTOSH）

注意：

• 仅 Mac OS X version 10.6 提供该选项。

• 如果您打开了多个应用程序，那么请确保“Scan Center”应用程序处于活动状态。否则，系统不会显
示正确的菜单栏。

从菜单栏中依次选择：

Scan Center > Preferences > General 选项卡

电子邮件问题解答
• 第141 页“无法发送电子邮件”

• 第142 页“无法附加文件”

无法发送电子邮件

检查您的电子邮件配置设置

请确认您正确地完成了电子邮件设置，并且成功地配置了 SMTP 服务器。

检查您的网络连接

请确认打印机连接在以太网络或无线网络中。您的网络必须连接在 Internet 中，以便打印机可以与 SMTP
服务器进行通讯。

问题解答
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检查您的代理服务器配置

您的代理服务器配置应该允许 SMTP 服务器连接。有关您的代理服务器或 SMTP 设置的帮助信息，请与您
的系统支持人员联系。

请确认输入了有效的收件人电子邮件地址

请确认收件人的邮箱没有满

这种情况可能会导致电子邮件被退回到您的收件箱。

无法附加文件

请选择支持的文件类型（JPEG 或 PDF）

请确认文件大小不是太大

传真问题解答
• 第142 页“传真问题解答注意事项”

• 第143 页“无法发送传真”

• 第144 页“无法接收传真”

• 第145 页“无法运行传真软件”

• 第146 页“打印机操作面板上的传真错误信息”

有关常用术语和任务的详细说明，请参阅：

• 第 72 页“设置打印机进行传真”

• 第 90 页“传真常见问答”

传真问题解答注意事项

如果您在发送和接收传真时遇到了问题，请首先检查连接：

1 将一部模拟电话机连接在您用于连接打印机的墙壁电话线插座、DSL 过滤器、VoIP 设备或电缆调制解调
器上，然后检查电话线上的拨号音。请确认您将电话机连接在同一个插口上。

如果您没有听到拨号音，请与您的线路供应商联系。

2 当打印机连接在电话线上时，将一部模拟电话机连接在打印机后面的  插口上，然后检查拨号音。

如果您没有听到拨号音，请检查以下的注意事项，检查每一项之后再次收听拨号音。

如果您听到了拨号音，但是发送和接收传真仍然有问题，请参阅本章中的其他主题。

连接注意事项

• 请确认打印机和线路上的其他设备（如果有的话）都已经按照您的安装方法正确安装和配置。

• 请确认电缆连接在正确的插口上。

• 请确认电缆连接牢固。

问题解答
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请检查以下硬件（如果使用）的电缆连接：

电源适配器 电话答录机 电缆调制解调器 分线器

电话机 VoIP 适配器 DSL 过滤器 RJ-11 适配器

• 如果打印机连接在数字用户线路(DSL)上，请确认您为打印机使用了一个 DSL 过滤器。

• 如果打印机连接在 VoIP 适配器或电缆调制解调器上，请确认打印机连接在第一个电话插口上。

• 如果您使用了分线器，请确认您使用的是电话分线器。请不要使用线路分线器。

无法发送传真

如果“传真问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

请确认在打印机上输入您的使用者信息

如果您在初始设置过程中没有输入您的使用者信息，请输入您的传真名称和传真号码。此信息将会添加到您
发送的所有传真中，表明您是发件人。一些国家或地区需要您提供传真号码和传真名称才可以发送传真，并
且一些传真机会阻止匿名传真。

降低传真调制解调器的传输速度

打印机的调制解调器传输数据的速度可以达到 33,600 bps。这是打印机可以发送和接收传真的最大速度。
但是，您不需要将调制解调器设置为最快的传输速度。接收传真机的调制解调器的速度必须等于或大于您发
送传真的速度。否则，接收方将不能接收您的传真。

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 最大发送速度

2 选择发送速度，然后触摸“接受”。

设置打印机在拨号之前扫描文档原件

如果您设置打印机在拨号之后扫描文档原件，打印机不会自动重拨。

如果您设置打印机在拨号之前扫描，当传真失败时您不必重新扫描文档。扫描的文档保存在打印机内存中。
打印机可以读取出来，然后自动重拨号码。

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 扫描

2 触摸“在拨号之前”，然后触摸“接受”。

启用错误修正

如果线路上有太多的噪音，传真的文档中可能会出现错误和污点。此功能可以让打印机重新发送损坏的数据
块并修正错误。当传真中的错误太多时，接收的传真机可能会拒收此传真。

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 错误修正

2 触摸“开”，然后触摸“接受”。

问题解答
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启用自动传真转换

如果接收传真机不支持彩色传真，此选项可以自动将准备发送的彩色传真转换为黑白传真。它也可以自动降
低传真的分辨率，使其满足接收传真机可以支持的分辨率。

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 自动传真转换

2 检查“自动传真转换”是否设置为“开”。

如果没有设置为“开”，请触摸“开”，然后触摸“接受”。

请确认“拨号前缀”设置正确

拨号前缀是一个数字或一系列数字，您必须先按此数字，然后才可以拨打实际的传真号码或电话号码。如果
打印机位于办公室中或者连接在专用分组交换机上，您需要按一个特定的数字，然后才可以拨打外线。

请确认您在打印机上输入的拨号前缀是适用于您的网络的正确前缀。

1 从主界面中依次选择：

 > 传真设置 > 拨号和发送 > 拨号前缀

2 检查前缀。

如果前缀不正确，请输入正确的前缀，然后触摸“接受”。

无法接收传真

如果“传真问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

请确认您已经为您的安装方法配置了正确的设置

如果打印机和其他设备共用电话线，请确认设置了以下内容：

•“自动应答”设置为“开”。

• 和其他设备相比，打印机在较多数目的铃响之后应答来电。

• 打印机在正确的特色铃声时应答来电（如果您申请了特色铃声服务）。

请确认打印机连接在模拟插口上

打印机是一种模拟设备。如果您使用专用分组交换机(PBX)系统，请确认打印机连接在 PBX 的模拟插口
上。您可能需要一个可以将数字信号转换成模拟信号的数字线路转换器。

请确认释放打印机内存

打印机在打印接收到的传真之前会将传真保存在打印机内存中。如果打印机在接收传真时墨水用完了或者纸
张用完了，打印机可以保存传真，以便您以后再打印。但是，如果打印机的内存满了，打印机可能无法接收
更多的传真。当打印机的内存已满时，触摸屏上将会出现错误信息。请解决错误以释放打印机内存空间。

问题解答
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请确认“传真转发”已禁用

1 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 传真转发

2 触摸“关”，然后触摸“接受”。

增大铃声音量

如果您设置打印机手动接收传真（自动应答关），请增大铃声音量。

请确认您有正确的手动应答码

如果您设置打印机手动接收传真（自动应答关），当有传真来电时，您需要输入正确的代码以便打印机可以
接收传真。

1 从主界面中依次选择：

 > 传真设置 > 铃声和应答 > 手动应答码

2 记录下触摸屏上显示的手动应答码。

注意：默认代码为*9*，但是为了提高安全性，您可以将它改变为只有您知道的数字。

无法运行传真软件

打印机必须连接在电话线、DSL、VoIP 或电缆服务上，然后您才可以在传真软件中配置传真设置。

请确认传真软件已安装

对于 Windows 用户来说，传真解决方案软件是可选的，只有当您在安装过程中的“安装其他的软件”界面
中选择了此软件时才会和打印机软件一起安装。如果您没有安装传真软件，“打印机主页”中的“传真”选
项卡将会提示您访问我们的网站，您可以下载此软件。

请确认打印机连接在电话线上

您需要通过标准墙壁电话线插座(RJ-11)、DSL 过滤器、VoIP 适配器或电缆调制解调器将打印机连接在您的
电话线上，然后您才可以打开传真软件并配置传真设置。

请确认打印机连接在计算机上

请确认打印机没有处于节约能源模式

问题解答
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打印机操作面板上的传真错误信息

错误信息： 问题： 可能的解决方法：

远程传真错误 接收传真机无法接收传真。接收方
的错误可能由多个因素引起。

• 重新发送传真。可能是连接的质量出现
了问题。

• 降低您的传真调制解调器的传输速度。

• 注册您的使用者信息。一些国家或地区
需要您提供传真号码和传真名称才可以
发送传真，并且一些传真机会阻止匿名
传真。请确认您正确地输入了您的传真
号码和传真名称。此信息将会添加到您
发送的所有传真中，表明您是发件人。

不支持的传真模式 接收传真机不支持彩色传真或者您
要发送的文档的扫描分辨率。

• 启用自动传真转换。打印机可以自动将
彩色传真转换为黑白传真，并较低文档
的扫描分辨率。

• 降低传真质量。

• 在 Letter 或 A4 尺寸的纸张上重新定制
您的文档。

不支持的长度 接收传真机不支持您要发送的文档
的长度。

在 Letter 或 A4 尺寸的纸张上重新定制您
的文档。

不支持的宽度 接收传真机不支持您要发送的文档
的宽度。

在 Letter 或 A4 尺寸的纸张上重新定制您
的文档。

不支持的压缩 接收传真机的传真调制解调器不支
持数据压缩。传真调制解调器压缩
数据可以加快传输速度，但是接收
传真调制解调器需要有相同的压缩
编码。

• 降低传真调制解调器的传输速度，然后
重新发送传真。

• 启用自动传真转换。

不支持的分辨率 接收传真机不支持您要发送的文档
的扫描分辨率。

• 降低传真质量。

• 启用自动传真转换。

不可恢复的传真错误 传真调制解调器出现严重的错误。 关闭打印机的电源，然后重新打开并重新
发送传真。

传真调制解调器错误 打印机的传真调制解调器可能正
忙，或者传真调制解调器可能在传
输过程中出现了问题。

关闭打印机的电源，然后重新打开并重新
发送传真。

电话线连接在机器后面错误的插座
上

电话线被连接在打印机后面错误的
插口上。

将电话线连接在打印机后面的  插口上。

检测到数字线路 打印机连接在数字线路上。 打印机是一种模拟设备，必须连接在模拟
线路上。如要将打印机连接在数字线路
上，您必须使用数字线路转换器或过滤器。

请参阅“设置打印机进行传真”一章获取
更多的信息。

连接失败

电话线路错误

电话线没有连接

打印机无法检测到拨号音。 请参阅“传真问题解答注意事项”。
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错误信息： 问题： 可能的解决方法：

电话线路忙 您的电话线路或者接收传真机的电
话线路正忙。如果打印机和其他设
备（电话机、电话答录机）共用线
路，这种情况特别容易发生。

• 设置打印机重拨。

• 增加重拨尝试之间的时间间隔。

• 尝试拨打您希望发送传真的电话号码，
确认对方工作正常。

• 如果电话线路正被其他的设备占用着，
请等待其他的设备完成操作，然后再尝
试发送传真。

• 在稍后的时间定时重新发送传真。

• 设置打印机在拨号之前扫描。扫描的文
档保存在打印机内存中。打印机可以读
取出来，然后自动重拨号码。

无应答 接收传真机可能禁用了“自动应
答”。

• 检查号码，然后重新发送传真。

• 设置打印机重拨。

注意：根据您所在的国家或地区，重拨
尝试次数可能会受到限制，您在您的打
印机上设置的重拨设置将不起作用。

• 在稍后的时间定时重新发送传真。

没有来电号码

来电已中断

由于传真来电没有发件人信息，您
的打印机中断了来电。您可能选择
了阻止没有来电号码的传真，或者
您所在的国家或地区不允许接收没
有来电号码的传真。

禁用“阻止无号码”。

如要解决传真软件中的错误信息，请单击“帮助”浏览传真软件的帮助信息。

存储卡问题解答
• 第147 页“存储卡问题解答注意事项”

• 第148 页“插入存储卡后没有任何反应”

• 第148 页“无法从存储卡或闪存驱动器中进行打印”

• 第148 页“无法通过无线网络从存储卡传送照片”

存储卡问题解答注意事项

在您解决问题之前，使用以下的注意事项可以解决大多数存储卡问题：

• 请确认您使用的存储卡是打印机所支持的类型。

• 请确认存储卡没有损坏。

• 请确认存储卡中包含支持的文件类型。
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插入存储卡后没有任何反应

如果“存储卡问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

重新插入存储卡

存储卡可能插入太慢。请取出并快速地重新插入存储卡。

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

检查网络连接

如果打印机和计算机都连接在网络中，请确认正确的主机和设备正在通讯。请在计算机上选择打印机或者在
打印机上选择计算机。

无法从存储卡或闪存驱动器中进行打印

如果“存储卡问题解答注意事项”没有解决问题，请尝试以下的一种或多种方法：

检查 USB 连接

1 检查 USB 电缆是否有明显的损坏。如果电缆损坏了，请使用一根新的。

2 将 USB 电缆上较方的一端牢固地插入打印机后面的 USB 接口中。

3 将 USB 电缆上扁平的一端牢固地插入计算机的 USB 接口中。

USB 接口旁边标记有 USB 符号 。

注意：如果问题仍然没有解决，请尝试使用计算机的其他 USB 接口。您可能连接在一个有故障的接口上。

检查网络连接

如果打印机和计算机都连接在网络中，请确认正确的主机和设备正在通讯。请在计算机上选择打印机或者在
打印机上选择计算机。

无法通过无线网络从存储卡传送照片

如果“存储卡问题解答注意事项”无法解决问题，请尝试以下的一种或多种方法：

请确保打印机和目的地计算机都已打开且已就绪
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请确保在“NETWORK CARD READER”的“PREFERENCES”对话框中选中
了“ENABLE READING FROM A MEMORY DEVICE OVER THE NETWORK FROM YOUR

PRINTER”（仅限于 MACINTOSH）

注意：

• 仅 Mac OS X version 10.6 提供该选项。

• 如果您打开了多个应用程序，那么请确保“Network Card Reader”应用程序处于活动状态。否则，系
统不会显示正确的菜单栏。

从菜单栏中依次选择：

Network Card Reader > Preferences

从打印机上的列表中选择正确的计算机名称

请确保已连接无线网络，且无线网络处于活动状态

如果无线网络无法正常使用，那么请使用 USB 电缆将打印机连接到计算机。

无线问题解答
• 第149 页“无线问题解答注意事项”

• 第150 页“将无线设置恢复为出厂默认设置”

• 第150 页“无法通过无线网络进行打印”

• 第153 页“'继续'按钮不可用”

• 第155 页“无法打印并且计算机上安装了防火墙”

• 第155 页“Wi-Fi 指示灯是绿色的，但是打印机不打印（仅限于 Windows）”

• 第156 页“在安装过程中，Wi-Fi 指示灯显示连接受限制”

• 第160 页“Wi-Fi 指示灯仍然显示连接受限制”

• 第161 页“没有安装无线打印服务器”

• 第161 页“当进行无线打印时出现'无法通讯'信息”

• 第163 页“当连接到虚拟个人网络(VPN)时与打印机的通讯中断了”

• 第163 页“解决间歇无线通讯问题”

无线问题解答注意事项

在开始无线打印机的问题解答之前，请确认以下事项：

• 打印机、计算机和接入点（无线路由器）都接通电源，并且电源已打开。

• 无线网络可以正常工作。

尝试访问您的无线网络中的其他计算机。

如果您的网络可以访问 Internet，请尝试通过无线连接到 Internet。

• 您的 SSID 是正确的。

打印一张网络设置页，检查打印机所使用的 SSID。

如果您不确定您的 SSID 是否正确，请重新进行无线设置。
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• 您的 WEP 密钥或 WPA 密钥是正确的（如果您的网络是安全加密的）。

登录接入点并检查安全设置。

安全密钥类似于密码。在同一个无线网络中，所有使用 WEP、WPA 或 WPA2 安全性的设备共用一个相同
的安全密钥。

如果您不确定您的安全信息是否正确，请重新进行无线设置。

• 打印机和计算机位于无线网络范围内。

对于大多数网络来说，打印机和计算机应该位于距离接入点（无线路由器）100 英尺（30 米）以内的地
方。

• Wi-Fi 指示灯是绿色的并且成功连接。

• 在您要使用打印机的计算机上安装了打印机驱动程序。

• 您选择了正确的打印机端口。

• 计算机和打印机连接在同一个无线网络中。

• 打印机远离可能干扰无线信号的障碍物或电子设备。

请确认打印机和接入点之间没有包含金属或混凝土的杆棒、墙壁或支柱。

很多设备可以干扰无线信号，包括婴儿监视器、发动机、无线电话、安全系统照相机、其他的无线网络和
一些蓝牙设备。

将无线设置恢复为出厂默认设置

从主界面中依次选择：

 > 网络设置 > 恢复网络设置 > 是

如要确认，请打印一张网络设置页，然后查看无线设置。

无法通过无线网络进行打印

如果您在安装过程中遇到了问题、您的打印机没有出现在打印机文件夹中、或者发送打印作业时您的打印机没
有出现在打印机选项中，您可以尝试反安装并重新安装软件。

在您重新安装软件之前，请先检查问题解答注意事项，然后尝试以下的方法：

关闭并重新打开接入点（无线路由器）

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接并解决连接问题。

从虚拟个人网络(VPN)上断开连接

当您通过 VPN 连接在其他网络中时，您将不能在您的无线网络中使用打印机。请结束您的 VPN，然后重新
尝试打印。

请确认“演示模式”已禁用

当“演示模式”启用时，一些打印机功能将无法使用。

从主界面中依次选择：

 > 演示模式 > 关 > 保存设置
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检查您的 WEP 密钥或 WPA 密钥

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WEP 密钥中的 ASCII
字符需要区分大小写。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA 密钥中的 ASCII 字
符需要区分大小写。

注意：如果您不知道此信息，请参阅随同无线网络一起提供的帮助文档，或者与安装您的无线网络的人员联
系。

检查您的接入点上是否有关联／注册按钮

在欧洲、中东和非洲，当您向您的无线网络中添加打印机时，无线宽带 box（例如 LiveBox、AliceBox、
N9UF Box、FreeBox 或 Club Internet）可能会要求您按关联／注册按钮。

如果您使用这些 box 并需要更多的信息，请参阅随同您的 box 一起提供的帮助文档，或者与您的 Internet
服务供应商(ISP)联系。

移动您的无线接入点，使之远离其他电子设备

一些电子设备（例如微波或其他用具、无线电话、婴儿监视器和安全系统照相机）可能会产生临时的干扰。
请确认您的接入点没有放置在距离这些设备很近的地方。

将计算机和／或打印机移动到距离接入点比较近的地方

您的无线网络的范围取决于很多因素，包括您的接入点和网络适配器的能力。如果您在打印时遇到问题，请
尝试调整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

检查无线信号质量

打印网络设置页并检查信号质量。如果列出的信号质量是好或者很好，说明导致此问题的是其他因素。

检查您的高级安全设置
• 如果您要使用 MAC（媒体访问控制）地址过滤功能来限制其他人对您的无线网络的访问，您必须将打印
机的 MAC 地址添加到可以连接到接入点的地址列表中。

• 如果您要设置接入点只分配有限数量的 IP 地址，您必须先改变此设置，然后才能添加打印机。

注意：如果您不了解如何进行这些改变，请参阅随同接入点一起提供的帮助文档，或者与安装您的无线网络
的人员联系。

请确认您的计算机连接在您的接入点上
• 打开您的网络浏览器并访问任意网站，确定您是否可以访问 Internet。

• 如果您的无线网络中有其他的计算机或资源，请检查并确认您是否可以从您的计算机上访问它们。
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请确认您的计算机和打印机连接在同一个无线网络中

如果打印机和计算机不在同一个无线网络中，您将不能进行无线打印。如果计算机已经连接在无线网络中，
打印机的 SSID 必须与计算机的 SSID 一致。

Windows 用户

1 获取计算机所连接的网络的 SSID。

a 在您的浏览器的地址栏中输入您的接入点的 IP 地址。

如果您不知道接入点的 IP 地址：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。查看“无线网络连接”区域：

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

b 当出现提示时，请输入接入点的用户名和密码。

c 单击“确定”。

d 在“无线设置”区域中查找 SSID。

e 记录下 SSID。

注意：请确认您准确地记录了所有的内容，包括大写字母。

2 获取打印机所连接的网络的 SSID：

a 从打印机打印一张网络设置页。

b 在“无线”区域中查找 SSID。

3 比较计算机和打印机的 SSID。

如果 SSID 相同，说明计算机和打印机连接在同一个无线网络中。

如果 SSID 不相同，请重新运行无线设置应用程序，在计算机所使用的无线网络中安装打印机。

使用 AirPort 基站的 Macintosh（英文版）用户

Mac OS X version 10.5 或更高的版本：

1 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

计算机所连接的网络的 SSID 将会显示在 Network Name 菜单中。

2 记录下 SSID。

Mac OS X version 10.4 或更早的版本：

1 从 Finder 中依次选择：

Applications > Internet Connect > AirPort

计算机所连接的网络的 SSID 将会显示在 Network 菜单中。

2 记录下 SSID。
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使用接入点的 Macintosh（英文版）用户

1 在您的网络浏览器的地址栏中输入接入点的 IP 地址，然后继续进行步骤 2。

如果您不知道接入点的 IP 地址，请按照以下的步骤进行操作：

a 从 Apple 菜单中依次选择：

System Preferences > Network > AirPort

b 单击 Advanced 或 Configure。

c 单击 TCP/IP。
Router（路由器）项目通常即为接入点。

2 当出现提示时，请输入您的用户名和密码，然后单击 OK。

3 在“无线设置”区域中查找 SSID。

4 记录下 SSID、安全类型和 WEP 密钥／WPA 密钥（如果显示的话）。

注意：

• 请确认您准确地记录了网络信息，包括大写字母。

• 将 SSID 和 WEP 密钥／WPA 密钥保存在安全的地方，以备将来使用。

请确认您的操作系统适用于通过 AIRPORT 的无线打印

打印机只支持在 Mac OS X 10.5 或更高版本（英文版）中通过 AirPort 基站进行无线打印。

“继续”按钮不可用

请按出现顺序尝试下列解决办法，直到“继续”按钮变为活动状态并可点击：

检查 USB 电缆是否已被牢固地插入计算机和打印机上的 USB 端口中

USB 端口标记有 .

确认打印机已插上并打开电源

检查  按钮是否已经点亮。如果您刚打开打印机电源，您可能需要断开 USB 电缆并重新连接。

确认计算机上的 USB 端口正在工作

通过连接其他设备来测试 USB 端口。如果您能够成功使用连接到该端口的其他设备，说明端口正在工作。

如果计算机上的 USB 端口不工作，请尝试使用计算机上的其他 USB 端口。

确认 USB 电缆正在工作

尝试使用其他 USB 电缆。如果您使用的电缆长度超过 10 英尺，请尝试使用较短的电缆。

确认您使用的是适用于您打印机型号的 CD
比较 CD 上和打印机上的打印机型号。号码应该完全匹配或者在相同的序列中。
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如果您有任何疑问，请在我们的 Web 站点上查找打印机软件的更新版本。如需更多信息，请参阅用户手册
中的“安装打印机软件”。

重新连接电源

1 关闭打印机电源。

注意：确认打印机没有处于“省电模式”。按住  3 秒钟以关闭打印机电源。

2 将电源线从电源拔开。

3 等待一分钟后，将电源线重新连接到电源。

4 打开打印机电源。

请再次尝试运行安装程序

1 关闭安装程序。

2 移除 CD，然后重新启动计算机。

3 插入安装软件 CD，然后重新运行安装程序。

注意：

• 当您看到“已安装的软件” 界面时，请确认您选择的是安装新打印机.

• 如果您已设置了打印机，则请选择 更改连接 以跳过硬件设置向导。
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检查您的计算机是否能够识别 USB 端口上的 USB 活动

打开“设备管理器”，查看在 USB 设备连接到 USB 端口时是否有活动：

1 单击 ，或单击开始 ，然后单击运行.

2 在“开始搜索”或“运行”框中，键入 devmgmt.msc.

3 按下 Enter 键，或单击确定.

4 将 USB 电缆或其他设备连接到 USB 端口时，请注意观察“设备管理器”窗口。当“设备管理器”识别
出 USB 连接时，窗口会刷新。

• 如果“设备管理器”上有活动，但之前的解决方案都不起作用，请联系“客户支持”。

• 如果“设备管理器”上没有活动，说明计算机及其 USB 支持有问题。计算机必须识别 USB 连接才
能进行安装。

无法打印并且计算机上安装了防火墙

第三方（非 Microsoft）的防火墙可能会干扰无线打印。如果打印机和计算机都配置正确，并且无线网络可以
正常工作，但是打印机不能进行无线打印，可能是防火墙的问题。如果计算机上安装了防火墙（除 Windows
防火墙以外），请尝试以下的一种或多种方法：

• 使用制造商提供的最新的升级包升级防火墙。请参阅随同您的防火墙一起提供的帮助文档了解如何操作。

• 当您安装打印机或者尝试打印时，如果程序向防火墙请求访问，请确认您允许这些程序运行。

• 临时禁用防火墙，然后在计算机上安装无线打印机。当您完成无线安装后，重新启用防火墙。

Wi-Fi 指示灯是绿色的，但是打印机不打印（仅限于 Windows）

注意：请确认 Wi-Fi 指示灯只显示 。如果 Wi-Fi 指示灯是绿色的，但是显示连接受限制，这表示打印机没
有成功地连接在您的无线网络中。

如果您已经完成了无线打印配置，并且所有的设置都是正确的，但是打印机不打印，请尝试以下的一种或多种
方法：

等待无线安装完成

请不要尝试打印、取出安装软件光盘、或者断开安装电缆，直到您看到“无线设置成功”界面。

启用打印机

请确认打印机已启用：

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

4 右键单击新的打印机图标，从弹出菜单中单击“使用联机打印机”。

5 关闭“打印机”或“打印机和传真”窗口，然后重新尝试打印。
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选择无线打印机

您可能需要在您的计算机上选择无线打印机才可以无线使用打印机。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

4 右键单击带有匹配的名称和型号，并且后面带有“（网络）”字样的打印机图标。

5 从弹出菜单中单击“使用联机打印机”。

6 关闭“打印机”或“打印机和传真”窗口，然后重新尝试打印。

选择无线端口

如果您以前按照本地连接的打印机安装了您的打印机，您可能需要选择无线打印机才可以无线使用打印机。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

4 右键单击打印机图标，然后从弹出菜单中单击“属性”或“打印机属性”。

5 单击“端口”选项卡。

6 找到当前的端口。当前的端口前面有一个选中标记。

7 如果当前端口的“描述”区域中表明它是一个 USB 端口，请从列表中选择“描述”区域是“打印机端
口”的端口。请检查“打印机”区域中的打印机型号，确认您选择了正确的打印机端口。

8 单击“确定”，然后重新尝试打印。

在安装过程中，Wi-Fi 指示灯显示连接受限制

当 Wi-Fi 指示灯显示  时，表示打印机已经过无线网络设置，但是无法连接到配置打印机的网络。打印机
可能因为干扰、距离接入点（无线路由器）太远或者需要改变打印机设置而无法加入网络。

请尝试其中的一种或多种方法：

确认接入点的电源已打开

请检查接入点，如有必要，请打开电源。

移动您的接入点，以便干扰最小

其他设备（例如微波或其他用具、无线电话、婴儿监视器和安全系统照相机）可能会产生临时的干扰。请确
认您的接入点没有放置在距离这些设备很近的地方。

将计算机和／或打印机移动到距离接入点比较近的地方

802.11b 或 802.11g 网络中的设备之间的距离可以达到 300 英尺，而 802.11n 网络的无线网络范围可能会
加倍。您的无线网络的范围取决于很多因素，包括您的接入点和无线网络适配器的能力。如果您在打印时遇
到问题，请尝试调整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。
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您可以在网络设置页中找到网络的信号强度。

检查您的 WEP 密钥或 WPA 密钥

如果您的接入点使用 WEP 安全性，WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。

如果您的接入点使用 WPA 或 WPA2 安全性，WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA 密钥中的 ASCII 字
符需要区分大小写。

注意：如果您不知道此信息，请参阅随同无线网络一起提供的帮助文档，或者与安装您的无线网络的人员联
系。

检查 MAC 地址

如果您的网络使用了 MAC 地址过滤功能，请确认将打印机的 MAC 地址添加到 MAC 地址过滤列表中，可
以允许打印机使用网络。请参阅第 116 页“我如何查找 MAC 地址？”获取更多的信息。

使用 PING 命令测试接入点，确认网络可以正常工作

Windows 用户

1 获取接入点的 IP 地址。

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 cmd。

c 按 Enter 键，或者单击“确定”。

d 输入 ipconfig，然后按 Enter 键。

• Default Gateway（默认网关）项目通常即为接入点。

• IP 地址由 4 组数字组成，用小数点分开，例如 192.168.2.134。

2 使用 Ping 命令测试接入点：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 cmd。

c 按 Enter 键，或者单击“确定”。

d 输入 ping，一个空格，然后输入接入点的 IP 地址。例如：

ping 192.168.1.100

e 按 Enter 键。

3 检查接入点是否有回应：

• 如果接入点有回应，您将会看到几行以 Reply from（回复自）开头的文字。

可能是打印机没有连接在无线网络中。请关闭并重新启动打印机，然后重新尝试连接。

• 如果接入点没有回应，您将会看到 Request timed out（请求超时）文字。
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请尝试以下的方法：

a 单击 ，或者单击“开始”，然后单击“运行”。

b 在“开始搜索”或“运行”框中输入 ncpa.cpl。

c 按 Enter 键，或者单击“确定”。

d 从显示的列表中选择适当的连接。

e 右键单击连接，然后单击“修复”或“诊断”。

Macintosh（英文版）用户

1 请确认 AirPort 已启用：

从 Apple 菜单中依次选择：

System Preferences > Network

AirPort 状态指示灯应该是绿色的。

注意：

• 黄色表示端口可用，但是没有连接。

• 红色表示端口没有配置。

2 获取接入点的 IP 地址：

a 从 Apple 菜单中依次选择：

About This Mac > More Info

b 在 Contents 区域中单击 Network。

c 从 Active Services 列表中选择 AirPort。
底部区域中列出了 AirPort 连接的详细信息。

d 记录下 Router（路由器）项目。

Router（路由器）项目通常即为接入点。

3 使用 Ping 命令测试接入点：

a 从 Finder 中依次选择：

Utilities > Network Utility > Ping 选项卡

b 在网络地址区域中输入接入点的 IP 地址。例如：

10.168.1.101

c 单击 Ping。

4 如果接入点有回应，您将会看到几行文字，显示从接入点接收到的字节数。这表示您的计算机连接在接
入点上。

如果接入点没有回应，则不会显示任何文字。您可以使用 Network Diagnostics 帮助您解决问题。

请确认您的计算机可以和打印机进行通讯

Windows 用户

1 获取打印机的 IP 地址。

a 从打印机打印一张网络设置页。

如要获取更多的信息，请参阅用户手册。

b 在 TCP/IP 区域中查找“地址”。

问题解答

158



2 单击 ，或者单击“开始”，然后单击“运行”。

3 在“开始搜索”或“运行”框中输入 cmd。

4 按 Enter 键，或者单击“确定”。

5 输入 ping，一个空格，然后输入打印机的 IP 地址。例如：

ping 192.168.1.100

6 按 Enter 键。

7 如果打印机有回应，您将会看到几行文字，显示从打印机接收到的字节数。这可以确定您的计算机可以
和您的打印机进行通讯。

如果打印机没有回应，您将会看到 Request timed out（请求超时）文字。

• 您的计算机可能没有连接在网络中。

• 您可能需要改变您的打印机的设置。请重新运行无线设置应用程序。

Macintosh（英文版）用户

1 获取打印机的 IP 地址。

a 从打印机打印一张网络设置页。

如要获取更多的信息，请参阅用户手册。

b 在 TCP/IP 区域中查找“地址”。

2 从 Finder 中依次选择：

Utilities > Network Utility > Ping 选项卡

3 在网络地址区域中输入打印机的 IP 地址。例如：

10.168.1.101

4 单击 Ping。

5 如果打印机有回应，您将会看到几行文字，显示从打印机接收到的字节数。这表示您的计算机可以和您
的打印机进行通讯。

如果打印机没有回应，则不会显示任何文字。

• 您的计算机可能没有连接在网络中。您可以使用 Network Diagnostics 帮助您解决问题。

• 您可能需要改变您的打印机的设置。请重新运行 Wireless Setup Assistant。

重新进行无线设置

如果您的无线设置已经改变了，您必须重新进行打印机无线设置。WEP 或 WPA 密钥、频道或其他网络设
置可能被手动改变了；或者接入点可能被恢复为出厂默认设置。

重新进行无线设置也可以解决由于无线配置错误所引起的问题。

注意：

• 如果您要改变网络设置，请先在所有的网络设备上改变设置，然后再改变接入点的设置。

• 如果您已经在接入点上改变了无线网络设置，您必须在所有其他的网络设备上改变设置，然后才可以在
网络中看到这些设备。
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Windows 用户

1 单击  或“开始”。

2 单击“所有程序”或“程序”，然后从列表中选择打印机程序文件夹。

3 依次选择：

打印机主页 > 选择您的打印机 > “设置”选项卡 > 无线设置应用程序

注意：在安装过程中，可能会提示您使用安装电缆再次将打印机连接在计算机上。

4 按照计算机屏幕上的指导进行操作。

Macintosh（英文版）用户

1 从 Finder 中依次选择：

Applications > 选择您的打印机文件夹

2 双击 Wireless Setup Assistant。

3 按照计算机屏幕上的指导进行操作。

Wi-Fi 指示灯仍然显示连接受限制

当 Wi-Fi 指示灯显示  时，可能表示打印机：

• 没有在 Infrastructure 模式下进行配置

• 正在等待与其他的无线设备建立 Ad hoc 连接

• 没有连接在无线网络中

打印机可能因为干扰、距离接入点（无线路由器）太远或者需要改变打印机设置而无法加入网络。

请尝试其中的一种或多种方法：

检查网络名称

请确认您的网络没有使用和您附近的其他网络相同的名称。例如，如果您和您的邻居都使用制造商默认的网
络名称，您的打印机可能会连接到您的邻居的网络中。

如要获取更多有关设置唯一网络名称的帮助信息，请参阅您的接入点的帮助文档。

注意：如果您设置了新的网络名称，您必须将打印机和计算机的 SSID 重新设置为同一个网络名称。

检查安全密钥

如果您使用 WEP 安全性

有效的 WEP 密钥应该为：

• 10 个或 26 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 5 个或 13 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。
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如果您使用 WPA 或 WPA2 安全性

有效的 WPA 密钥应该为：

• 64 个十六进制字符。十六进制字符包括 A–F、a–f 和 0–9。

或者

• 8–63 个 ASCII 字符。ASCII 字符包括字母、数字和可以在键盘上找到的字符。WPA 密钥中的 ASCII 字
符需要区分大小写。

如果您的无线网络没有使用安全措施，则您不会有安全密钥。我们不推荐您使用这样的无线网络，因为它可
以允许入侵者未经过您的许可使用您的网络资源。

将计算机和／或打印机移动到距离接入点比较近的地方

802.11b 或 802.11g 网络中的设备之间的距离可以达到 300 英尺，而 802.11n 网络的无线网络范围可能会
加倍。您的无线网络的范围取决于很多因素，包括您的接入点和无线网络适配器的能力。如果您在打印时遇
到问题，请尝试调整计算机和打印机的位置，使它们之间的距离不超过 100 英尺。

您可以在网络设置页中找到网络的信号强度。

检查 MAC 地址

如果您的网络使用了 MAC 地址过滤功能，请确认将打印机的 MAC 地址添加到 MAC 地址过滤列表中，可
以允许打印机使用网络。

没有安装无线打印服务器

在安装过程中，您可能会看到一条信息，提示您打印机没有安装无线打印服务器。如果您不确定打印机是否可
以进行无线打印，请尝试以下的方法：

检查电源

请确认  指示灯亮着。

当进行无线打印时出现“无法通讯”信息

请尝试其中的一种或多种方法：

请确认您的计算机和打印机都有适合于网络的有效 IP 地址

如果您使用的是便携式笔记本电脑，并且启用了节约能源设置，当您尝试进行无线打印时，您可能会在笔记
本电脑的屏幕上看到“无法通讯”信息。如果笔记本电脑的硬盘驱动器处于节约能源模式，此情况将会发
生。

如果您看到了此信息，请等待几秒钟，然后重新尝试打印。笔记本电脑和打印机需要几秒钟的时间才可以恢
复正常模式并重新连接无线网络。

如果您等待了足够长的时间让笔记本电脑和打印机连接网络，但是仍然看到了此信息，可能是您的无线网络
出现了问题。

请确认笔记本电脑和打印机都接收到了 IP 地址：
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Windows 用户

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 cmd。

3 按 Enter 键，或者单击“确定”。

4 输入 ipconfig，然后按 Enter 键。

IP 地址由 4 组数字组成，用小数点分开，例如 192.168.0.100。

Macintosh（英文版）用户

1 从 Apple 菜单中依次选择：

About This Mac > More Info

2 在 Contents 区域中单击 Network。

3 如果您是通过无线网络进行连接的，请从 Active Services 列表中选择 AirPort。

Router（路由器）项目通常即为接入点。

查找打印机的 IP 地址。

• 从打印机打印一张网络设置页。

在 TCP/IP 区域中查找“地址”。

• 查看打印机设置。

1 在打印机操作面板上依次选择：

 > 网络设置 > TCP/IP

2 查找“IP地址”。

如果打印机和／或笔记本电脑没有 IP 地址，或者 IP 地址是 169.254.x.y（其中 x 和 y 是 0–255 之间的任意
两个数字）：

1 关闭没有有效 IP 地址的设备（笔记本电脑、打印机、或者全部）。

2 打开设备，然后重新检查 IP 地址。

如果笔记本电脑和／或打印机仍然没有接收到有效的 IP 地址，可能是您的无线网络出现了问题。请尝试以
下的方法：

• 请确认您的接入点（无线路由器）的电源已打开，并且可以正常工作。

• 移开所有可能阻止信号的物体。

• 临时关闭您的网络中所有不必要的无线设备，并暂停所有的密集网络活动，例如文件传输或网络游戏。
如果网络太忙，打印机有可能在允许的时间内没有接收到 IP 地址。

• 请确认您的 DHCP 服务器（也可能是您的无线路由器）可以正常工作，并且经过了配置，可以分配 IP
地址。如果您不确定如何操作，请参阅随同您的无线路由器一起提供的手册。

如果打印机和计算机都有有效的 IP 地址，并且网络工作正常，请继续进行问题解答操作。

请确认您选择了无线端口

注意：此方法只适用于 Windows 用户。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。
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3 按 Enter 键，或者单击“确定”。

4 右键单击打印机图标，然后从弹出菜单中单击“属性”或“打印机属性”。

5 单击“端口”选项卡。

6 找到当前的端口。当前的端口前面有一个选中标记。

7 如果当前端口的“描述”区域中表明它是一个 USB 端口，请从列表中选择“描述”区域是“打印机端
口”的端口。请检查“打印机”区域中的打印机型号，确认您选择了正确的打印机端口。

8 单击“确定”，然后重新尝试打印。

请确认双向通讯已启用

注意：此方法只适用于 Windows 用户。

1 单击 ，或者单击“开始”，然后单击“运行”。

2 在“开始搜索”或“运行”框中输入 control printers。

3 按 Enter 键，或者单击“确定”。

4 右键单击打印机图标，然后从弹出菜单中单击“属性”或“打印机属性”。

5 单击“端口”选项卡。

6 选中“启用双向支持”。

7 单击“应用 > 确定”，然后重新尝试打印。

当连接到虚拟个人网络(VPN)时与打印机的通讯中断了

当您连接到大多数虚拟个人网络(VPN)时，与您的本地网络中的无线打印机的连接将会中断。大多数 VPN 只
允许用户与 VPN 进行通讯，不可以同时与其他网络进行通讯。如果您希望可以同时连接到您的本地网络和
VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling（分离通道）功能。请注意，一些机构组织出于
安全或技术的原因不允许使用此功能。

解决间歇无线通讯问题

尽管您的无线网络中明显没有任何改变，您可能会注意到您的打印机工作了一小段时间，然后停止了工作。

很多不同的问题可以中断网络通讯，并且有时多个问题同时存在。请尝试其中的一种或多种方法：

当您尝试使用无线网络时，请从所有的 VPN 上断开连接

大多数虚拟个人网络(VPN)只允许计算机与 VPN 进行通讯，不可以同时与其他网络进行通讯。在计算机上
安装驱动程序或者在计算机上运行无线设置之前，请从 VPN 上断开连接。

如要检查计算机现在是否连接在 VPN 中，请打开您的 VPN Client 软件并检查您的 VPN 连接。如果您没有
安装 VPN Client 软件，请使用 Windows VPN Client 手动检查连接。

如果您希望可以同时连接到您的本地网络和 VPN，请要求 VPN 的系统支持人员允许使用 Split Tunneling
（分离通道）功能。请注意，一些机构组织出于安全或技术的原因不允许使用此功能。
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关闭接入点（无线路由器）的电源，然后重新打开

等待 1 分钟，让打印机和计算机重新建立连接。此操作有时可以刷新网络连接并解决连接问题。

消除网络拥堵

如果无线网络太忙，计算机和打印机可能很难互相通讯。导致无线网络拥堵的原因可能包括：

• 通过网络传输很大的文件

• 网络游戏

• 点对点文件交换应用程序

• 流视频

• 无线网络中同时存在太多的计算机

消除干扰源

普通家庭用品有可能会中断无线网络通讯。位于无线网络附近的无线电话（不包括手机）、微波炉、婴儿监
视器、几乎所有的厨房用具、无线监视设备以及任何包含发动机的用具都有可能会中断无线网络通讯。

请尝试打开这些可能的干扰源，看它们是否导致了问题。如果是，请将您的无线网络与这些设备分开。

改变接入点使用的频道

有时候您可以通过改变您的接入点用于广播的频道来消除来自未知来源的干扰。路由器上有 3 个独特的频
道。请参阅随同您的路由器一起提供的帮助文档确定是哪三个。其他的频道作为可选项提供，但是它们是互
相交迭的。如果路由器配置为使用默认设置，请改变频道设置，使用不同的独特频道。如果您不确定如何改
变频道，请参阅随同您的接入点一起提供的帮助文档。

使用唯一的 SSID 配置接入点

很多无线网络使用路由器制造商最初为路由器配置的 SSID。当使用相同 SSID 的多个网络在同一个区域内
共同工作时，使用默认的 SSID 可能会导致出现问题。尽管会显示正在尝试连接到正确的网络，但是打印机
或计算机可能会尝试连接到错误的网络。

如要避免出现这种类型的干扰，请在您的接入点上改变 SSID，不要使用默认值。如果您不确定如何改变
SSID，请参阅随同您的接入点一起提供的帮助文档。

注意：如果您在接入点上改变了 SSID，您必须在所有访问您的无线网络的其他设备上改变 SSID。

为网络中的所有设备指定静态 IP 地址

大多数无线网络使用无线路由器内置的 DHCP（动态主机分配协议）服务器为无线网络中的用户分配 IP 地
址。DHCP 地址在需要的时候才会分配，例如当新的设备添加到无线网络中或者当设备打开电源时。无线设
备必须向路由器发送请求，然后接收一个 IP 地址，以便可以在网络中工作。由于无线路由器除了分配地址
以外还要完成很多其他的任务，有时可能不会很快地响应并分配地址。请求的设备有时会在接收到地址之前
就放弃了。

请尝试为您的网络中的设备指定静态 IP 地址以解决此问题。

如要为打印机指定一个静态 IP 地址：

1 完成无线设置，允许打印机从网络中的 DHCP 服务器接收一个 DHCP 地址。

2 打印一张网络设置页，查看当前为打印机分配的 IP 地址。
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3 打开网络浏览器，然后在地址栏中输入打印机的 IP 地址。按 Enter 键。

4 单击“配置 > TCP/IP > 设置静态 IP 地址”。

5 在“地址”字段中输入您希望为打印机指定的 IP 地址，然后单击“提交”。

在网络浏览器的地址栏中输入静态 IP 地址并查看打印机网页是否可以打开，以确认 IP 地址是否已更新。如
要获取更多有关指定静态 IP 地址的帮助信息，请参阅随同您的路由器和操作系统一起提供的帮助文档。

查看接入点的已知问题

一些无线路由器带有明确的缺陷，已经得到了制造商的验证和确认。请访问路由器制造商的公司网站。从制
造商了解固件升级信息和其他的建议。如果您不确定如何访问制造商网站，请参阅随同您的无线路由器一起
提供的帮助文档。

检查无线网络适配器升级

如果您从一台特别的计算机打印时遇到了问题，请查看计算机中的无线网络适配器卡的制造商网站。网站上
可能有升级的驱动程序，可以解决问题。

将所有的网络设备改变为相同的类型

虽然在同一个无线网络中可以成功地同时包含 802.11b、802.11g 和 802.11n 设备，但是较快的设备有时会
阻止较慢的设备进行通讯。

请尝试只打开相同类型的网络设备，看网络通讯是否有所改善。如果此方法可以解决问题，您可能需要使用
较新的无线网络适配器升级您的较旧的设备。

购买一个新的路由器

如果您的路由器已经使用了很多年，它可能无法与您的网络中较新的无线设备完全兼容。请考虑购买一个可
以完全兼容 802.11 IEEE 规范的较新的路由器。
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通告

产品信息

产品名称：

Lexmark S800 Series

机器类型：

4310

型号：

VW1, VW2, VW3

版本通告

2010 年 9 月

以下文字如果与当地法律法规有所冲突，可能并不适用于那些地区：LEXMARK INTERNATIONAL, INC.以其
现状提供此手册，并没有任何保证（不论明示的或暗示的），包括，但不限于以其特定目的进行销售及适用的
暗示保证。某些司法管辖区并不准许在某些交易中排除明示的或暗示的保证；因此，这份声明可能并不适用于
你方。

本手册中可能会有技术上的不准确或印刷错误。鉴于此，本手册中的内容会阶段性地更新；这些改动将会体现
在以后的版本中。产品或程序有可能会随时改动，如有改动，恕不另行通知。

本手册中提到的有关产品、程序或服务等并不意味着生产厂商打算将这些产品、程序或服务向所有的国家提
供，也不意味着只能使用此产品、程序或服务。任何功能一样的产品、程序或服务，只要不侵犯现有的知识产
权，都可以用来替换使用。与其他的产品、程序或服务（除厂商明确标明外）共同操作并进行评估与验证是用
户的责任。

如要获取 Lexmark 技术支持，请访问网站 support.lexmark.com。

如要获取有关耗材和下载的信息，请访问网站 www.lexmark.com。

如果您不能访问 Internet，您可以通过邮件与 Lexmark 联系：

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2010 Lexmark International, Inc.

All rights reserved. 保留所有权利。

商标

Lexmark 和带有钻石图案的 Lexmark 标记都是 Lexmark International, Inc.在美国和／或其他国家注册的商标。

Mac 和 Mac 徽标都是 Apple Inc.在美国和／或其他国家注册的商标。
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其他商标分别属于各自所属者所有。

模块化组件通告

此产品可能包含以下模块化组件：

Lexmark 管理机型／型号 LEX-M03-001；FCC ID：IYLM03001；Industry Canada IC：2376A-M03001

Lexmark 管理机型／型号 LEX-M01-003；FCC ID：IYLM01003；Industry Canada IC：2376A-M01003

Lexmark 管理机型／型号 LEX-M11-003；FCC ID：IYLM11003；Industry Canada IC：2376A-M11003

许可注意事项

下列文档可以从安装软件 CD 查看。

目录 文件

CD:\LEGAL FW_License.pdf

mDNS.tar.gz

Expat.txt

Inst_lib.txt

Instgui.txt

Instgui.zip

噪声等级

以下的测量是依照 ISO 7779 进行的，并且所做的报告完全符合 ISO 9296 的标准。

注意：一些模式可能不适用于您的产品。

1 米平均声压（分贝）

打印 50 dBA

扫描 40 dBA

复印 50 dBA

准备就绪 无声

数值可能会随时变化。请参阅 www.lexmark.com 获取当前的数值。
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电子电气废料(WEEE)指令

WEEE 徽标代表欧盟国家电子产品的特定回收计划和程序。我们鼓励回收我们的产品。如果您对回收选项有
更多的问题，请访问 Lexmark 的国际互联网站 www.lexmark.com 查找您本地销售办事处的电话号码。

电池通告

此产品包含高氯酸盐材料，可能需要特殊的处理方法。请访问网站
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/获取更多的信息。

静电灵敏度注意事项

此符号表示对静电敏感的部件。请先接触打印机的金属外框，再接触这些符号附近的区域。

ENERGY STAR
在产品上或者在启动屏幕上带有 ENERGY STAR 标志的任何 Lexmark 产品已经认证在由 Lexmark 出厂时其
配置符合美国环保署（EPA）的 ENERGY STAR 要求。

温度信息

室温 15 ~ 32C（60 ~ 90F）

运输和存储温度 -40 ~ 60C（-40 ~ 140F），1 ~ 60C（34 ~ 140F）
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能源消耗

产品能源消耗

下面的表格列出了此产品在各种模式下的能源消耗特性。

注意：一些模式可能不适用于您的产品。

模式： 说明： 耗电量（瓦特）：

打印 产品正在打印电子文档。 20

复印 产品正在使用文档原件复印副本。 17

扫描 产品正在扫描文档原件。 12.71

准备就绪 产品正在等待打印作业。 11.8

节约能源 产品处于节约能源模式。 6.31

关闭 产品连接在电源插座上，但是电源开关是关闭的。0.47

上面表中所列出的能源消耗数值是基于时间的平均测量结果。某一时刻的实际能源消耗可能会比平均值高。

数值可能会随时变化。请参阅 www.lexmark.com 获取当前的数值。

省电模式

本产品被设计为使用一种称为“省电模式”的能源节省模式。“省电模式”相当于“睡眠模式”。“省电模
式”通过在长期不活动时间内减少电力消耗来节约能源。本产品在指定时间段（称为“省电模式超时”）未被
使用后自动进入“省电模式”。

本产品的出厂默认“省电模式超时”（以分钟为单位）： 60

通过使用配置菜单，可以在 1 分钟至 240 分钟之间修改“省电模式超时”。将“省电模式超时”设置为较低
的值可以减少能源消耗，但是可能会增加产品的响应时间。将“省电模式超时”设置为较高的值可以保持较快
的响应速度，但是会使用更多的能源。

关闭模式

此产品有一种关闭模式，仍然会消耗很小量的能源。如要使产品完全不消耗能源，请从电源插座上断开电源
线。

能源消耗总量

有时候计算此产品所消耗的能源总量是非常有用的。因为能源消耗声明是以 Watts（瓦特）作为单位的，因
此，如要计算实际消耗的能源总量，还应该分别乘以此产品在各种模式下所工作的时间。将各种模式下所消耗
的能源加在一起，就是此产品所消耗的能源总量。

无线产品管制通告

本章包含以下有关无线产品（包括但不限于发射机、无线网卡或感应式读卡器）的管制信息。
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无线频率辐射暴露通告

此设备的辐射输出能量远远低于美国通信委员会(FCC)和其他管制机构有关无线频率辐射暴露的限制。此设备
的天线和操作人员之间的距离必须保持至少 20 厘米（8 英寸），以满足 FCC 和其他管制机构有关无线频率辐
射暴露的要求。

LEXMARK 软件有限质保和许可协议

请在使用此产品之前仔细阅读以下内容：若使用此产品，即表示您同意接受此软件有限质保和许可协议中所有
条款和条件的约束。如果您不同意此软件有限质保和许可协议中的条款，请立刻返还未使用的产品，并要求退
还您支付的金额。如果您是为其他使用者安装此产品，您同意通知相关使用者，指出若使用此产品即表示接受
以下条款。

打印机许可协议

我同意此专利打印机的授权许可和设计只适用于有利于专利打印机寿命的原装 Lexmark 打印墨盒。我同意：
(1)在此打印机上只使用原装 Lexmark 打印墨盒（除非我可以使用由 Lexmark 制造，但是不受下面的打印墨盒
许可协议中所述的单次使用条款限制进行销售的替换打印墨盒），并且(2)将此打印机许可/协议传达给此打印
机的所有后续使用者。

打印墨盒许可协议*

我同意就随同此打印设备一起提供的专利打印墨盒遵从以下的许可／协议进行销售：包含的专利打印墨盒只允
许使用一次，并且当消耗一定数量的墨水之后就会停止工作。当需要进行更换时，不确定量的墨水将会存留在
打印墨盒内。在这次使用之后，使用此打印墨盒的许可就会中止，并且使用过的打印墨盒必须且只能返还给
Lexmark 以进行再制造、再填充或再循环。如果今后我购买了受上述条款限制的其他打印墨盒，我同样接受
该条款。如果您不接受此单次使用许可／协议中的条款，请将此产品装入初始包装内，并退还给您购买产品的
销售点。您可以在 www.lexmark.com 国际互联网站上购买不受这些条款限制的替换打印墨盒。

LEXMARK 软件许可协议

此软件许可协议（“许可协议”）是一份您（个人或单一实体）与 Lexmark International, Inc.
（“Lexmark”）之间的法律协议。如果您的 Lexmark 产品或软件程序没有受到您和 Lexmark 或其供应商签订
的其他书面软件许可协议的约束，此许可协议将会约束您使用安装在 Lexmark 产品上或者由 Lexmark 提供并
用于您的 Lexmark 产品的软件程序。术语“软件程序”是指不论是包含在您的 Lexmark 产品内还是与您的
Lexmark 产品一同配送的、或者和您的 Lexmark 产品一起使用的机器可读指导、音频／视频内容（例如图像
和录音）、以及相关的媒介、印刷品和电子文档。

1 软件有限质保声明。Lexmark 确保载有此软件程序（如有）的媒介（例如磁盘或光盘）在正常使用的情况
下，保修期内不会出现材料或工艺上的缺陷。保修期为九十(90)天，从软件程序交给首位终端用户之日开
始算起。此有限质保只适用于从 Lexmark 和经授权的 Lexmark 零售商或经销商处购买的新型软件程序媒
介。如果 Lexmark 确定媒介不符合此有限质保，Lexmark 将更换该软件程序。

2 免责和质保限制。除非此软件许可协议中明确规定且在适用法律许可的最大程度内，Lexmark 及其供应商
以其现状提供软件程序，并免除所有其他明示的或暗示的保证和条件，包括但不限于有关软件程序的所有
权、非侵权性、适销性、可用于特殊用途和不含病毒。如果 Lexmark 不能按照法律免除适销性或可用于特
殊用途的暗示保证组成部分，Lexmark 将这种质保的期限限定为 90 天的明示软件有限质保。此许可协议
应该结合特定的不时有效的法律法规来理解，该等法律法规规定了不能排除暗示的保证或条件、或修改的
加诸于 Lexmark 的义务。如果适用于该法律法规的条款，在 Lexmark 的能力范围内，Lexmark 将以以下
方式之一就违反此法律法规承担有限责任：提供该软件程序的更换拷贝或者退还您为该软件程序所支付的
金额。
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软件程序中可能包含连接到与 Lexmark 没有关联的第三方所主控和操作的其他软件应用程序和/或互联网
页的互联网链接。您承认并同意 Lexmark 对于这种软件应用程序和/或互联网页的主控、执行、操作、维
护或内容不负任何责任。

3 赔偿限制。在适用法律许可的最大限度内，Lexmark 在本软件许可协议下的任何和所有责任明确限定为您
为软件程序所支付的金额或 5 美元（或等值的当地货币），以较高数额为准。您在本软件许可协议下针对
任何争议向 Lexmark 提出的唯一的赔偿要求为请求获得以上金额之一，Lexmark 在支付此金额后即解除和
免除对您的所有后续义务和责任。

在任何情形下，Lexmark、其供应商、子公司或零售商均不对任何特殊的、偶然的、间接的、警戒性的、
惩罚性的或结果性的损失（包括但不限于利润或收入损失、储蓄损失、数据或记录的中断使用、损失、误
差或损坏、第三方索赔、不动产或有形资产损失、因软件程序的使用或不能使用引起的或者与软件程序的
使用或者不能使用相关的或者与此软件许可协议任何条款相关的隐私损失）负任何责任，无论索赔为何种
性质，包括但不限于违反保证条款或合同、侵权（包括疏忽或严格赔偿责任），即使 Lexmark、其供应
商、关联机构或零售商已经被告知发生该等损失或者您基于第三方索赔所提出的索赔的可能性，除非该等
赔偿免除在法律上是无效的。即使上述的赔偿没有达到其主要目的，这些限制仍然适用。

4 美国各州法律。此软件有限质保赋予了您特定的法律权利。在不同的州，您可能还享有其他不同的权利。
一些州不允许限制暗示保证的有效期间或排除对偶然的或间接损害的限制，因此，上述限制可能对您不适
用。

5 授权许可。在您遵守此许可协议中的所有条款和条件的前提下，Lexmark 授予您以下的权利：

a 使用。您可以使用此软件程序的一(1)份拷贝。“使用”是指存储、载入、安装、运行或显示软件程
序。如果 Lexmark 许可您多人同时使用此软件程序，您必须将授权使用者的人数限制为您与 Lexmark
签订的协议中所指定的数目。您不可以为了在多台计算机上使用软件程序而分割其组件。在以任何方式
使用软件程序（全部或部分）的时候，您同意该使用方式不会导致覆盖、修改、清除、模糊、改变或削
弱通常因运行此软件程序或者作为运行此软件程序结果之一而出现在计算机显示屏上的商标、商号、商
业外观或知识产权通告。

b 复制。您只能出于备份、存档或安装的目的制作一(1)份此软件程序的拷贝，并且该拷贝必须包括该软
件程序中原有的所有的所有权通告。您不可以将软件程序复制到任何公共或散布到网络中。

c 保留权利。此软件程序（包括所有字体）的版权归 Lexmark International, Inc.和／或其供应商所有。
Lexmark 保留所有未在此许可协议中明确授予您的权利。

d 免费软件。尽管此许可协议中的条款和条件有规定，用于组成第三方依据公共许可协议提供的软件
（“免费软件”）的全部或部分软件程序将许可您使用，并且受到这种免费软件随附的软件许可协议的
条款和条件的约束，无论下载软件时使用的是不连续协议、拆封许可或电子许可条款。您使用免费软件
将完全受到这种许可协议的条款和条件的约束。

6 转让。您可以将此软件程序转让给其他的终端用户。任何转让必须包括所有的软件组件、媒介、印刷品和
此许可协议，并且您不可以保留软件程序或其组件的任何拷贝。转让不可以是间接转让，例如寄售方式。
在转让之前，接收软件程序的最终用户必须同意此许可协议中的所有条款。软件程序转让之时您的许可将
自动终止。除在此许可协议中许可的范围内，否则您不可以出租、分许可或转让软件程序，并且任何这种
尝试都是无效的。

7 升级。如要使用标识为升级版本的软件程序，您之前须获得经过 Lexmark 标识为具备升级资格的原软件程
序的使用许可。升级之后，您可能不再使用为您提供升级资格的原软件程序。

8 反向工程的限制。除非适用法律明确允许的为了交互操作、改正错误和安全测试之目的，否则您不得更
改、解密、反操作、反汇编、反编译或以其它方式翻译软件程序，如果您有这样的法定权利，您应书面通
知 Lexmark 您打算进行的反操作、反汇编或反编译。除非系合法使用软件程序所必需，否则您不得解密软
件程序，

9 其他的软件。此许可协议同样适用于 Lexmark 为原有软件程序提供的升级和补充，除非 Lexmark 随同升
级或补充提供了其他的说明。

10 终止。此许可协议一直有效，除非终止或拒绝。您可以随时以销毁所有的软件程序拷贝以及所有的修改、
文档和任何形式的合并部分的形式或者此协议规定的其他形式拒绝或终止此许可协议。如果您没有遵守此
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许可协议中的条款，Lexmark 可在通知您后终止您的许可。在这种情形下，您同意销毁所有的软件程序拷
贝以及所有的修改、文档和任何形式的合并部分。

11 税款。您同意支付所有的税款，包括但不限于由此许可协议或您使用软件程序所引起的任何商品、服务和
个人财产税款。

12 诉讼限制。在相关适用法律允许的情况下，对于因本许可协议引起的任何诉讼，自诉由发生两年之后，任
何一方都不得提出任何形式的诉讼。

13 适用的法律。此许可协议受美国肯塔基州的法律管辖限制。其他任何管辖区内的法律法规都不适用。联合
国国际货物销售合同公约不适用。

14 美国政府有限权利。此软件程序是完全使用私人资金开发的。美国政府使用此软件程序的权利在此许可协
议中阐明，并且受到 DFARS 252.227-7014 和类似的 FAR 规定（或者任何相当的政府机构规章或合同条
款）所限制。

15 同意使用数据。您同意 Lexmark、其关联机构和代理可以收集和使用您提供与按照您的请求进行的有关软
件程序的支持服务的信息。Lexmark 同意不以任何可以识别出您本人身份的方式使用此信息，但系为提供
该等支持服务所必需的除外。

16 出口限制。您不得 (a) 违背任何适用的出口法律法规而获取、运输、转让或再出口（直接或间接）软件程
序或者任何其直接产品。或者 (b) 允许软件程序用于任何被出口法律法规所禁止的目的，包括但不限于核
能、化学或生物武器的扩散。

17 同意电子合同。您和 Lexmark 同意使用此电子形式的许可协议。这意味着当您单击本页中的“同
意”或“是”按钮或者使用此产品时，您承认接受了此许可协议中的条款和条件，并且表明您愿意与
Lexmark“签订”一份合同。

18 订约的资格和权限。您声明自己达到了签订许可协议所在地的成人合法年龄，并且，如果适用，您的雇主
或委托人正式授权您签订此合同。

19 完整的协议。此许可协议（包括随同软件程序一起提供的针对此许可协议的任何补充或修订）是您和
Lexmark 之间有关软件程序的一份完整的协议。除非另外说明，这些条款和条件将替代所有以前的或者同
时期的有关软件程序或与此许可协议涵盖的任何其他相关问题的口头或书面的通讯、提议和陈述（这样的
外部条款与此许可协议中的条款和任何您与 Lexmark 签订的有关使用软件程序的其他书面协议不冲突的除
外）。如果任何 Lexmark 政策或支持服务计划与此许可协议中的条款冲突，应以此许可协议中的条款为
准。

* XX90 Series 中的产品（包括但不限于 Z2390、Z2490、X2690、X3690 和 X4690 等型号）不受打印墨盒许
可协议限制。此打印墨盒许可协议不适用于 XX75 Series 产品（包括但不限于 X4975 和 X7675 型号）的打印
机包装箱内包含的打印墨盒。但是，它适用于遵从这些条款和条件进行销售的替换打印墨盒。您可以在
www.lexmark.com 国际互联网站上购买不受这些条款限制的替换打印墨盒。

MICROSOFT CORPORATION NOTICES

This product is based on Microsoft Print Schema technology.You may find the terms and conditions upon
which Microsoft is licensing such intellectual property at http://go.microsoft.com/fwlink/?LinkId=83288.

ADOBE SYSTEMS INCORPORATED NOTICE

Contains Flash®, Flash® Lite™ and/or Reader® technology by Adobe Systems Incorporated

This Product contains Adobe® Flash® player software under license from Adobe Systems Incorporated,
Copyright © 1995-2007 Adobe Macromedia Software LLC.All rights reserved.Adobe, Reader and Flash are
trademarks of Adobe Systems Incorporated.
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打印机，设置为默认  49
打印机不打印 
无线  155

打印机不能复印或扫描或者没有反
应  139
打印机不能无线打印  155
打印机操作面板 
按钮和图标  17
清洗  124
位置  10

打印机打印出空白页  131
打印机的外壳 
清洗  123

打印机解决方案  119

打印机没有反应  131
打印机内存 
传真  96

打印机内发生卡纸  133
打印机软件 
安装  27
反安装  26

打印机设置  85
打印机设置向导  85
打印机问题，基本解决方法  125
打印介质 
标签纸  30
贺卡  30

打印模式 
改变  51

打印墨盒 
订购  13
更换  14
使用原装 Lexmark  13

打印墨盒窗口 
位置  11

打印确认页  94
打印顺序 
改变  35

打印速度慢  138
打印头 
校正  122

打印头窗口盖 
位置  11

打印头错误  126
打印头喷头 
清洗  123

打印问题解答 
打印的图像中出现条纹或线
条  137

打印速度慢  138
打印页边缘处的打印质量非常
差  136

当打印时计算机速度变慢  138
无法从打印队列中删除文
档  132

打印页边缘处的打印质量非常
差  136
打印状态窗口 
隐藏或改变外观  50

打印作业 
继续  52
取消  52
暂停  51

当打印时计算机速度变慢  138
电话簿 
设置  86

索引

174



电话簿，电子邮件 
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电话答录机 
设置  72
最佳传真设置  93

电话分线器  77
电缆 

USB  111
安装  111

电源 
位置  11

电源插口 
位置  11

电源适配器盖板 
位置  12

电子邮件 
附加照片或文档  71
取消  71
扫描的文档  64
扫描文档或照片  70
设置  67
提示  69
通讯簿  68

电子邮件设置 
配置  67

电子邮件问题解答 
无法发送电子邮件  141
无法附加文件  142

订购纸张和其他耗材  15
定时传真 
发送  93

定制打印机解决方案  120
多个 WEP 密钥  118

E
Electronic emission notices（电
磁兼容声明）  167, 170
EXT（电话分机）插口 
位置  11

F
FCC notices  170
FreeBox  100
发件人信息 
注册  83

发送报告，传真  94
发送传真，提示  87
发送电子邮件 
附加照片或文档  71
扫描文档或照片  70

发送定时传真  93
发送历史记录报告  94
发送终端识别(TTI) 
设置  83

法国 
特殊的无线安装指导  100

反安装打印机软件  26
放大图像  56
放置角落 
位置  10

分线器，选择  91
复印  54

ID 卡  55
放大图像  56
复制图像  57
将多页文档打印到一张纸上  57
进行复印  54
每张纸上打印多页  57
使复印结果较浅或者较深  56
双面文档  55
缩小图像  56
提示  54
调整质量  56
在纸张的双面  58
照片  55
逐份打印  57

复印和扫描问题解答 
打印机不能复印或扫描或者没有
反应  139

扫描不成功  140
扫描的质量非常差  139
扫描任务花费很长的时间或者导
致死机  141

文档或照片只扫描了一部
分  140

无法通过网络扫描至计算
机  141

复印问题解答 
扫描仪部分没有关闭  139

复印质量，调整  56
复印作业 
取消  59

复制图像  57

G
改变打印模式  51
改变打印顺序  35
改变节约能源时限  21
改变默认打印模式  50
改变页面顺序  35

干扰 
无线网络  113

告诉我更多  119
更换打印墨盒  14
共享打印  107

H
合并打印  57
贺卡  30
黑白扫描  66
横幅纸  29
厚介质 
放置在扫描仪玻璃上  32

互联网链接 
使用  24

恢复 
将内部无线打印服务器恢复为出
厂默认设置  150

恢复出厂默认设置  21
回收  7

Lexmark 产品  16
电子电气废料(WEEE)指令  168

I
ID 卡 
复印  55

ID 卡复印  119
Infrastructure 网络  112
IP 地址  116, 117
配置  101

IP 地址，指定  117
IP 语音(VoIP) 
传真设置  77

J
计算机上的防火墙  155
技术支持  125
继续 
打印作业  52

“继续”按钮不能工作  153
“继续”按钮是灰色的  153
“继续”按钮无法使用  153
检查拨号音  92
检查无反应的打印机  125
交互式解决方案  119
校正打印头  122
接收传真 
手动  90
提示  89
自动  89
自动应答设置  89, 90
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接收历史记录报告  94
节约能源 
使用经济模式  21

节约能源、墨水和纸张  7
节约能源时限 
改变  21

节约纸张 
使用经济模式  21

解决方案  119
定制  120

经济模式 
使用  21

K
卡纸和进纸错误问题解答 
打印机内发生卡纸  133
双面打印部件内发生卡纸  135
纸张或特殊介质进纸错误  136

快速拨号 
设置  86

L
LINE（线路）插口 
位置  11

LiveBox  100
垃圾传真 
阻止  95

来电显示 
设置  83

来电显示模式 
设置  84

连接 
配置  115

联系人列表 
设置  86

联系人列表，电子邮件 
创建  68
设置  68

铃声音量 
调整  92

浏览菜单 
使用触摸屏  20

M
Macintosh（英文版） 

USB  105
无线  105
在无线网络中安装打印机  98

Macintosh（英文版）打印机软件 
使用  24

MAC 地址  115
查找  116

MAC 地址过滤  115
没有无线网络  101
密码  109
密钥索引  118
免提传真  94
明信片  30
墨盒，墨水 
订购  13
使用原装 Lexmark  13

墨水 
节约  7

墨水量 
查看  122

默认打印机，设置  49
默认打印模式 
改变  50

默认值 
恢复出厂默认设置  21

N
N9UF Box  100
内部无线打印服务器 
恢复出厂默认设置  150

能源 
节约  7

P
PDF 
从扫描结果创建  65

PictBridge 和 USB 接口 
位置  10

PictBridge 兼容数码相机 
连接  47

配置 
IP 地址  101
传真设置  85
电子邮件设置  67

普通纸  29

Q
其他的计算机 
安装无线打印机  99

前盖 
位置  10

清洗打印机操作面板  124
清洗打印机的外壳  123
清洗打印头喷头  123
取消 
打印作业  52

电子邮件  71
复印作业  59
扫描作业  66

确认页，传真  94
群组拨号 
设置  86

群组传真，发送 
立刻  88

R
RJ-11 适配器  79
热转印纸  31
软件 

Service Center（服务中
心）  125

软件，可选 
查找，安装  25

软件不能安装  127
软件升级 
检查  26
启用  26

S
Service Center（服务中
心）  125
SmartSolutions  119
定制  120
添加打印机  120

SMTP 服务器 
配置  67

SSID（服务设置识别码） 
Ad hoc  101
查找  114, 108
无线网络  108

扫描 
从扫描结果创建 PDF  65
黑白  66
扫描文档并编辑其中的文本  63
扫描文档并发送电子邮件  64
扫描照片并进行编辑  62
识别码  66
使用触摸屏  60
提高质量  65
提示  60
至存储卡  61
至计算机  60
至闪存驱动器  61
至网络  60

扫描不成功  140
扫描的质量非常差  139
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扫描任务花费很长的时间或者导致
死机  141
扫描仪玻璃 
擦洗  124
位置  10

扫描仪部分没有关闭  139
扫描仪顶盖 
位置  10

扫描仪夹子 
位置  10

扫描作业 
取消  66

闪存驱动器 
插入  44
打印文档  37
扫描至  61
使用样张页打印照片  48

设备 
无线网络  113

设置 
自动应答  91

设置打印机 
传真  90
电子邮件  67
在无线网络中（Macintosh 英文
版）  98

在无线网络中（Windows）  98
设置电子邮件  67
设置双面打印干燥时间  39
升级打印机软件  26
失败的传真 
找回  96

使用 
Macintosh（英文版）打印机软
件  24

互联网链接  24
使用“高速”模式打印  51
使用存储卡错误  147
使用者信息，传真 
设置  83, 84

数码相机 
连接  47

数字电话服务 
传真设置  78

数字用户线路(DSL) 
传真设置  76

双面打印 
传真  95
打印，手动  40
打印，自动  38
复印，手动  58
复印，自动  58

延长干燥时间  38
双面打印部件 
位置  11

双面打印部件内发生卡纸  135
双面打印干燥时间 
选择特定设置  39

双面锁定按钮 
位置  11

双向通讯 
启用  161

缩小图像  56
索引卡  30

T
TCP/IP  117
特色铃声  92
提高扫描质量  65
提示 
打印  34
电子邮件  69
发送传真  87
复印  54
接收传真  89
扫描  60

调整拨号和铃声音量  92
调整扬声器音量  92
通告  166, 167, 168, 169, 170
通讯簿 
设置  84, 86

通讯簿，电子邮件 
设置  68

透明胶片  31
图标 
打印机操作面板  17
主界面  18

U
USB  105, 115

Macintosh（英文版）  105
电缆  111

USB 接口 
位置  12

USB 连接 
同时使用网络连接  115

V
VoIP 适配器  77
VPN（虚拟个人网络） 
与打印机的连接中断  163

W
WEP  97

Ad hoc  101
WEP 密钥 
查找  108
密钥索引  118

Wi-Fi Protected Setup  104
使用  107

Wi-Fi Protected Setup 徽标 
识别  107

Wi-Fi 指示灯 
图标说明  99

Wi-Fi 指示灯是绿色的 
打印机不打印  155

Wi-Fi 指示灯显示连接受限
制  156, 160
Windows 
在无线网络中安装打印机  98

Windows 软件 
Abbyy Sprint OCR  22
EzPrint  22
Fax Solutions（传真解决方案）
软件  22

Service Center（服务中
心）  22

Toolbar（工具栏）  22
Tools for Office（Office 工
具）  22

Wireless Setup Utility（无线设置
应用程序）  22

打印机设置应用程序  22
打印机主页  22
打印首选项  22

WPA  97
WPA2  97
WPA 密钥 
查找  108

WPS  104
网络 

IP 地址  117
查找打印机的 IP 地址  117
查找计算机的 IP 地址  117
查找计算机的 IP 地址
（Macintosh 英文版）  117
与 Macintosh 计算机共享打印
机  107

与 Windows 计算机共享打印
机  107

网络打印机 
安装  117

网络概述  108
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网络连接 
同时使用 USB 连接  115

网络密钥  109
网络设置页 
打印  98

网站 
查找  8

文档 
打印  34
放置在扫描仪玻璃上  31
附加到电子邮件  71
扫描照片并进行编辑  63
扫描至电子邮件  70
使用操作面板传真  88
使用触摸屏扫描  60
使用计算机传真  88

文档或照片只扫描了一部分  140
文件类型 
支持的  45

问题解答 
Service Center（服务中
心）  125

传真注意事项  142
检查无反应的打印机  125
解决基本打印机问题  125
联系技术支持  125
无线网络  149

问题解答，安装 
打印机打印出空白页  131
打印机没有反应  131
打印头错误  126
软件不能安装  127
无法通过 USB 进行打印  132
显示屏上的文字是错误的语
言  126

页面不能打印  129
问题解答，传真 
错误信息，打印机操作面
板  146

无法发送传真  143
无法接收传真  144
无法运行传真软件  145

问题解答，存储卡 
插入存储卡后没有任何反
应  148

无法从闪存驱动器中打印  148
注意事项  147

问题解答，打印 
打印的图像中出现条纹或线
条  137

打印速度慢  138

打印页边缘处的打印质量非常
差  136

当打印时计算机速度变慢  138
无法从打印队列中删除文
档  132

问题解答，电子邮件 
无法发送电子邮件  141
无法附加文件  142

问题解答，复印 
扫描仪部分没有关闭  139

问题解答，复印和扫描 
打印机不能复印或扫描或者没有
反应  139

扫描不成功  140
扫描的质量非常差  139
扫描任务花费很长的时间或者导
致死机  141

文档或照片只扫描了一部
分  140

无法通过网络扫描至计算
机  141

问题解答，卡纸和进纸错误 
打印机内发生卡纸  133
双面打印部件内发生卡纸  135
纸张或特殊介质进纸错误  136

问题解答，无线 
Wi-Fi 指示灯显示连接受限
制  156, 160

安装后改变无线设置
（Macintosh 英文版）  101
安装后改变无线设置
（Windows）  101
解决通讯问题  163
无法通过无线网络从存储卡传送
照片  148

无法通过无线网络进行打
印  150

无法从打印队列中删除文档  132
无法从闪存驱动器中打印  148
无法发送传真  143
无法发送电子邮件  141
无法附加文件  142
无法接收传真  144
无法通过 USB 进行打印  132
无法通过网络扫描至计算机  141
无法通过无线网络从存储卡传送照
片  148
无法通过无线网络进行打印  150
无法通讯 
信息  161

无法运行传真软件  145

无线  105, 115
Macintosh（英文版）  105
打印机不打印  155
问题解答  155, 163

无线安装 
需要的信息  98

无线打印服务器 
没有安装  161

无线设置 
安装后改变（Macintosh 英文
版）  101

无线网络 
SSID（服务设置识别码）  108
安全性  97
安全性信息  109
安装打印机（Macintosh 英文
版）  98

安装打印机（Windows）  98
安装打印机所需的信息  98
干扰  113
解决通讯问题  163
普通家用配置  109
使用 Macintosh（英文版）创建

Ad hoc 网络  101
使用 Windows 创建 Ad hoc 网
络  101

问题解答  149
无线网络的类型  112
向现有的 Ad hoc 网络中添加打印
机  104

信号强度  113
无线网络兼容性  97
无线问题解答 

Wi-Fi 指示灯显示连接受限
制  156, 160

安装后改变无线设置
（Macintosh 英文版）  101
安装后改变无线设置
（Windows）  101
打印机和计算机在不同的网络
中  114

打印机在无线网络中间歇工
作  163

无法通过无线网络从存储卡传送
照片  148

无法通过无线网络进行打
印  150

无线信号 
强度  113

无线信号吸收  113
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X
显示屏上的文字是错误的语
言  126
线路过滤器  76
小介质 
放置在扫描仪玻璃上  32

协议  117
信封  30
打印  41
装入纸张  41

信息 
查找  8

信息解决方案  119
虚拟个人网络  163
选择分线器，传真  91
选择无线端口  161

Y
延长双面打印干燥时间  39
扬声器音量 
调整  92

样张页 
使用  48

页面不能打印  129
页面顺序 
改变  35

以太网  115
音量，调整 
铃声和拨号音  92
扬声器  92

英国 
特殊的无线安装指导  100

用户支持标签 
位置  11

语言 
改变  126

语音邮件 
设置  72

语音邮件，传真设置  93

Z
在 Windows 环境下共享打印
机  106
在无线网络中安装打印机所需的信
息  98
暂停 
打印作业  51

噪声等级  167
找回失败的传真  96
照片 
附加到电子邮件  71

复印照片  55
剪裁  46
去除红眼效果  46
扫描照片并进行编辑  62
扫描至电子邮件  70
使用彩色效果  46
使用触摸屏编辑  46
使用打印机操作面板打印  45
使用样张页打印  48
使用移动设备打印  49
调整深浅  46
无边界复印  56
旋转  46
自动增强  46

照片重印  119
照片／光面纸  30
照片卡  30
支持的操作系统  22
支持的存储卡和文件类型  45
纸张 
节约  7

纸张和介质 
横幅纸  29
明信片  30
普通纸  29
热转印纸  31
索引卡  30
透明胶片  31
信封  30
照片／光面纸  30
照片卡  30
重磅亚光纸  29

纸张和其他耗材 
订购  15

纸张或特殊介质进纸错误  136
纸张默认设置 
保存  33

纸张支架 
位置  10

指定 IP 地址  117
重磅亚光纸  29
逐份打印  57
主界面 
图标  18

注意事项 
传真问题解答  142
存储卡问题解答  147
在您解决问题之前  125

转发传真  95
装入纸张  28
将厚介质放置在扫描仪玻璃
上  32

将文档原件放置在扫描仪玻璃
上  31

将小介质放置在扫描仪玻璃
上  32

信封  41
自定义尺寸的纸张 
打印  43

自动传真转换 
设置  84

自动应答 
何时启用  91

阻止传真  95
设置  84

最大发送速度 
设置  84

最小系统需求  22
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